Polygon Editing Tool

Instruction Manual

KONICA MINOLTA
Safety Symbols

The following symbols are used in this manual to prevent accidents which may occur as result of incorrect use of the instrument.

⚠️ Denotes a sentence regarding safety warning or note.
Read the sentence carefully to ensure safe and correct use.

🚫 Denotes a prohibited operation.
The operation must never been performed.

❗ Denotes an instruction.
The instruction must be strictly adhered to.

Official names for application mentioned in this manual

<table>
<thead>
<tr>
<th>Name given in this manual</th>
<th>Official name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows</td>
<td>Microsoft® Windows®</td>
</tr>
<tr>
<td>Windows NT</td>
<td>Microsoft® Windows NT® Operating System</td>
</tr>
<tr>
<td>Windows 2000</td>
<td>Microsoft® Windows® 2000 Professional Operating System</td>
</tr>
<tr>
<td>Windows XP</td>
<td>Microsoft® Windows® XP Professional Operating System</td>
</tr>
</tbody>
</table>

Trademarks

• Microsoft and Windows are registered trademarks of the Microsoft Corporation in the United States and other countries.
• Other product names and company names used herein are trademarks or registered trademarks of their respective owners.

Notes on this Manual

• The VI-910, VI-900, VI-700, VI-300 are model names for Europe and VIVID 910, VIVID 900, VIVID 700, VIVID 300 are model names for other countries. The VIVID (VI) series digitizer includes VIVID 910 (VI-910), VIVID 900 (VI-900), VIVID 700 (VI-700) and VIVID 300 (VI-300).
• Copying or reproduction of all or any part of the contents of this manual without KONICA MINOLTA SENSING’s permission is strictly prohibited.
• The contents of this manual are subject to change without prior notice.
• Every effort has been made in the preparation of this manual to ensure the accuracy of its contents. However, should you have any questions or find any errors, please contact a KONICA MINOLTA SENSING authorized service facility.
• KONICA MINOLTA SENSING will not accept any responsibility for consequences arising from the use of the instrument.
• The name MINOLTA or MINOLTA CO., LTD and its associated logo used in this manual (or on the product or any included materials) has been superseded by the new name KONICA MINOLTA or KONICA MINOLTA SENSING, INC.
Safety Precautions

When using this software, the following points must be strictly observed to ensure correct and safe use. After you have read this manual, keep it in a safe place so that it can be referred to easily whenever it is needed.

<table>
<thead>
<tr>
<th>WARNING</th>
<th>Failure to adhere to the following points may result in death or serious injury.</th>
</tr>
</thead>
<tbody>
<tr>
<td>!</td>
<td>To ensure correct and safe use of this software, please read the instruction manuals of the VIVID (VI) series digitizer and personal computer in addition to this manual before operating. Incorrect operation of the software may result in fire or electric shock.</td>
</tr>
</tbody>
</table>

Software Restrictions

- Copying or reproduction of all or any part of the contents of this software and manual without KONICA MINOLTA SENSING’s permission is strictly prohibited.
- The specifications of the software are subject to change without prior notice.
- KONICA MINOLTA SENSING will not take any responsibility for damage caused as result of use of this software.

Notes On Use

- When inserting a CD-ROM into the CD-ROM drive, make sure that it is placed straight in the right direction, and inserted gently.
- Keep the CD-ROM clean. If it becomes dirty, a reading or writing error may result.
- Pay attention to rapid temperature changes and dew condensation.
- Keep the CD-ROM away from direct sunlight or heaters.
- Do not let the CD-ROM drop or be exposed to strong shocks.
- Keep the CD-ROM away from water, alcohol, thinner etc.

Notes On Storage

- Do not store the CD-ROM in a hot area, for instance, in direct sunlight or near heaters.
Contents

Safety Precautions........................................................................................................................................................................... 1
Software Restrictions ......................................................................................................................................................................... 1
Notes On Use ................................................................................................................................................................................. 1
Notes On Storage ........................................................................................................................................................................... 1
Conventions for Command Reference (Chapter 2). ....................................................................................................................... 5

Chapter 1 Foreword

Required Environment ........................................................................................................................................................................ 8
Installation ..................................................................................................................................................................................... 9
Connecting the Protect Key and Installing its Driver .................................................................................................................. 9
Installing the ASPI Driver ......................................................................................................................................................... 10
Installing the Polygon Editing Tool ......................................................................................................................................... 11
Starting and Quitting the Software ........................................................................................................................................... 13
Starting the Software ............................................................................................................................................................... 13
Quitting the Software .............................................................................................................................................................. 13
Main Window ............................................................................................................................................................................. 14
Toolbar Icons ........................................................................................................................................................................... 15
Controlling the digitizer ............................................................................................................................................................ 16
Uninstallation .............................................................................................................................................................................. 17
Uninstalling the Polygon Editing Tool ...................................................................................................................................... 17
Uninstalling the Protect Key Driver ...................................................................................................................................... 18
Disconnecting the Protect Key ............................................................................................................................................... 19

Chapter 2 Command Reference

• File Menu
  File – New ................................................................. Creating New Scene Data ................................................................. 23
  File – Open ........................................................................................ Opening Saved Data ......................................................... 24
  File – Save – Elements ......................................................... Saving Element Data ......................................................... 26
  File – Save – Scene .......................................................... Saving Scene Data .......................................................... 27
  File – Save as – Elements .................................................. Saving Element Data under a Different Name .................. 28
  File – Save as – Scene ....................................................... Saving Scene Data under a Different Name ....................... 29
  File – Import – Elements ................................................... Importing Scanned Data .................................................. 30
  File – Import – Digitizer – One Scan (When VIVID 300 is Selected) Performing One Scan with the VIVID 300 ......... 32
  File – Import – Digitizer – Step Scan (When VIVID 300 is Selected) Performing Step Scan with the VIVID 300 .......... 35
  File – Import – Digitizer – One Scan (When VIVID 700 is Selected) Performing One Scan with the VIVID 700 .......... 40
  File – Import – Digitizer – Step Scan (When VIVID 700 is Selected) Performing Step Scan with the VIVID 700 .......... 43
  File – Import – Digitizer – PC Card (When VIVID 700 is Selected) Importing Data from the Memory Card of VIVID 700..... 48
  File – Import – Digitizer – One Scan (When VIVID 900/910 is Selected) Performing One Scan with the VIVID 900/910 ..... 54
  File – Import – Digitizer – Step Scan (When VIVID 900/910 is Selected) Performing Step Scan with the VIVID 900/910 ..... 59
  File – Import – Digitizer – Easy Align Importing Data from the Memory Card of VIVID 900/910 .................. 76
  File – Export – Elements ................................................. Aligning Multiple Scans ......................................................... 82
  File – Export – Images .................................................. Exporting Element Data as Various Formats ......................... 90
  File – Export – Images .................................................. Exporting Image Data as Various Formats ......................... 94
  File – Remove Elements ................................................ Removing the Selected Element(s) ........................................ 95
  File – Preferences ........................................................ Displaying Information for Setting Conditions ..................... 96
  File – Select Digitizer .................................................. Selecting a Digitizer ......................................................... 99
  File – Exit .......................... Exiting the Polygon Editing Tool ................................................................. 100

• View Menu
  View – Orbit .......................... Rotating the Camera ................................................................. 102
  View – Zoom ......... Enlarging/Reducing the Displayed Item ......................................................... 103
  View – Full Frame All .......................... Displaying Data Fully in all Windows ......................................................... 104
Chapter 2 “Command Reference” (from page 21) gives an explanation of the function and operating procedure of each command in the menu order.

The shortcut key and the icon (displayed on the tool bar) are also shown in the command title. We recommend that you make extensive use of shortcut keys when running this software. Note that while software keys indicated in the command reference are effective by default, you are free to add new shortcuts and to customize the existing ones.

For information about using and customizing shortcut keys, see page 201.
Chapter 1

Foreword
## Required Environment

The following hardware environment is required to run this software.

<table>
<thead>
<tr>
<th>Hardware</th>
<th>PC/AT compatible with a printer port (D-sub 25-pin)</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>Pentium III or higher recommended (only Intel)</td>
</tr>
<tr>
<td>Main memory</td>
<td>512MB or more (1024MB or more recommended)</td>
</tr>
<tr>
<td>HDD</td>
<td>A minimum of 10MB free space is required to install this software.</td>
</tr>
<tr>
<td>OS</td>
<td>Windows NT4.0 (with SP6) or higher/ Windows 2000 (with SP2) or higher/ Windows XP</td>
</tr>
<tr>
<td>Graphic</td>
<td>A graphic board that enables 16-bit color display with a resolution of 1024 by 768 pixels or higher is required.</td>
</tr>
<tr>
<td>SCSI interface</td>
<td>Adaptec SCSI interface board and ASPI layer (ver. 4.70 or higher) must be installed.</td>
</tr>
<tr>
<td>Other</td>
<td>A CD-ROM drive is required to install the software.</td>
</tr>
</tbody>
</table>
Installation

To use this software, the software program and its protect key driver must be installed.

The installation procedure is also given in the “README_E.txt” file in the “Polygon Editing Tool” directory of the software’s CD-ROM.

Connecting the Protect Key and Installing its Driver

Before installing the software, connect the protect key and install its driver as explained below.

[Connecting Procedure]

1. Turn OFF the computer.

2. Connect the protect key to the computer’s printer port.
   - Memo
     If a printer or other device has already been connected to the printer port, first connect the protect key to the printer port and then connect the printer cable (or other device) to the protect key.

3. Fasten the protect key with its two screws firmly. Next, install the protect key driver as explained below.

[Operating Procedure]

1. Start Windows and insert the software CD-ROM into the CD-ROM drive.

2. From Explorer, execute the “hdd32.exe” file stored in the CD-ROM. The driver setup program will start.

3. Follow the instructions displayed on the screen to complete installation. The protect key driver will be installed.
1. Start up Windows, and set the Polygon Editing Tool CD-ROM into the computer’s CD-ROM drive.

2. Using Explorer, access the CD-ROM drive and double-click on “aspi_v***.exe”.
   - The “aspi_v***.exe” file stores the driver and installation software in self-compressed form. Double-clicking on “aspi_v***.exe” causes the file to automatically decompress into multiple files.

3. Proceed to install the driver as described below.
   - About the details of installation, refer to the decompressed “Readme.txt” file.

   - The driver install program starts up.
   - If you use Windows XP, select [Run] from the [Start] menu, and then run the decompressed “INSTALL.BAT” file added “XP32” parameter as following dialog. The install program starts to install.

5. Follow the instructions on the screen to complete the installation.
   - The install program installs the ASPI driver.
Installing the Polygon Editing Tool

After you have connected the protect key to the computer and installed its driver, install the Polygon Editing Tool program as explained below.

[Operating Procedure]

1. Start Windows and insert the software CD-ROM into the CD-ROM drive.

2. From Explorer, execute the “setup.exe” file stored in the CD-ROM.
   
   The setup program will start.
   
   **Note**
   A dialog asking whether you agree with the program agreement will appear. Read it thoroughly and select whether you agree or not.
   
   If you agree, proceed to step 3.
   
   If you do not agree, the software cannot be installed. Click the [Cancel] button to cancel installation.

3. Click the [NEXT] button.
   
   **Memo**
   If you want to install the software in another directory, click the [Browse…] button and select the desired directory.
   
   If you do not specify another directory, the software will be installed in “C:\Program Files\KONICA MINOLTA\Polygon Editing Tool ver.1.***”.

4. Click the [NEXT] button.
   
   A dialog box that allows selection of the installation type will appear.
5 **Select the desired installation type and click the [NEXT] button.**

*Settings*

- **Typical**: Standard installation. Requires approximately 8MB of free space on the hard disk.
- **Compact**: Minimum installation. Requires approximately 7MB of free space on the hard disk.
- **Custom**: Allows selection of the software components to be installed. The required free space on the hard disk varies with the selected components.

6 **Follow the instructions displayed on the screen to complete installation.**

The Polygon Editing Tool will be installed.

When installation is completed successfully, the following files will be created in the directory where the software has been installed.

- **KONICA MINOLTA**
  - Polygon Editing Tool ver.1.**
    - **Bin**
      - PET.exe
    - **Plug in**
      - AddTexture.dll
  - **Model**

**Memo**

The files that will be created will change according to the selected installation type.
Starting and Quitting the Software

Starting the Software

[Operating Procedure]

1. From the [Start] menu, select [Program] – [KONICA MINOLTA], and then click [Polygon Editing Tool Ver.1.**].

   The Polygon Editing Tool will start.

   • If a scene file with the name “startup.scn” currently exists in the directory named “Polygon Editing Tool Ver.1.**/Model”, the program will automatically load this file as it starts up.

Quitting the Software

[Operating Procedure]


   The software will be exited.
Main Window

1. Title bar ............. Displays the file name of the currently displayed image data.
2. Menu bar ............... Used to select various functions of this software.
3. Tool bar ............... Displays the icons of the frequently used commands. Clicking an icon will execute the corresponding command.
4. Element list ............ Displays the names of all the elements currently opened by this software. Highlighted elements mean that they have been selected by an operation (e.g. by a menu). To select/unselect an element, just click its name.
   If you place a checkmark next to an element name, the element will appear in the element window. To toggle the display of all selected elements on or off, press the space bar or the [Ctrl] key.
5. Window title ............ Indicates the orientation of the image shown in the window. It is possible to open two or more windows having the same orientation. In the Isometric or Perspective window, the image can be rotated in different directions using the [Orbit], [Camera Settings] commands of the [View] menu.
6. Element window ... Displays the elements whose corresponding checkboxes are checked (i.e. a check mark is displayed).
7. Status bar .............. Displays the function of each button of the mouse according to the currently selected command. (The functions vary with the currently selected command.)
# Toolbar Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Command</th>
<th>Description</th>
<th>Reference Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="File – Open" /></td>
<td>File – Open</td>
<td>Open an element file or scene file.</td>
<td>24</td>
</tr>
<tr>
<td><img src="image" alt="File – Save – Elements" /></td>
<td>File – Save – Elements</td>
<td>Saves element data.</td>
<td>26</td>
</tr>
<tr>
<td><img src="image" alt="File – Import – Digitizer – One Scan" /></td>
<td>File – Import – Digitizer – One Scan</td>
<td>Reads in the data from a 1-shot scan by the digitizer.</td>
<td>32, 40, 54</td>
</tr>
<tr>
<td><img src="image" alt="File – Import – Digitizer – Step Scan" /></td>
<td>File – Import – Digitizer – Step Scan</td>
<td>Reads in the data from a step-shot scan by the digitizer.</td>
<td>35, 43, 59</td>
</tr>
<tr>
<td><img src="image" alt="File – Import – Digitizer – Easy Align" /></td>
<td>File – Import – Digitizer – Easy Align</td>
<td>Aligns multiple scans taken by the digitizer.</td>
<td>82</td>
</tr>
<tr>
<td><img src="image" alt="Edit – Delete – Elements" /></td>
<td>Edit – Delete – Elements</td>
<td>Deletes an element(s) from the element list.</td>
<td>129</td>
</tr>
<tr>
<td><img src="image" alt="View – Orbit" /></td>
<td>View – Orbit</td>
<td>Rotates the camera.</td>
<td>102</td>
</tr>
<tr>
<td><img src="image" alt="View – Zoom" /></td>
<td>View – Zoom</td>
<td>Enlarges/reduces the window.</td>
<td>103</td>
</tr>
<tr>
<td><img src="image" alt="View – Full Frame All" /></td>
<td>View – Full Frame All</td>
<td>Fully frames the element in the window.</td>
<td>104</td>
</tr>
<tr>
<td><img src="image" alt="View – Area Zoom" /></td>
<td>View – Area Zoom</td>
<td>Enlarges/reduces the selected area.</td>
<td>107</td>
</tr>
<tr>
<td><img src="image" alt="Wireframe (Window – Property)" /></td>
<td>Wireframe (Window – Property)</td>
<td>Displays the wireframe.</td>
<td>190</td>
</tr>
<tr>
<td><img src="image" alt="Shading (Window – Property)" /></td>
<td>Shading (Window – Property)</td>
<td>Displays the image in shading mode.</td>
<td>190</td>
</tr>
<tr>
<td><img src="image" alt="Texture (Window – Property)" /></td>
<td>Texture (Window – Property)</td>
<td>Texture-maps the image.</td>
<td>190</td>
</tr>
<tr>
<td><img src="image" alt="Select – Rectangle" /></td>
<td>Select – Rectangle</td>
<td>Selecting points within the specified rectangle area.</td>
<td>116</td>
</tr>
<tr>
<td><img src="image" alt="Select – Bezier" /></td>
<td>Select – Bezier</td>
<td>Selecting points within the specified Bezier curve.</td>
<td>117</td>
</tr>
<tr>
<td><img src="image" alt="Select – Unselect by Element" /></td>
<td>Select – Unselect by Element</td>
<td>Unselects all the points inside the element.</td>
<td>125</td>
</tr>
<tr>
<td><img src="image" alt="Select – Toggle Points" /></td>
<td>Select – Toggle Points</td>
<td>Reverses the selection state of the points.</td>
<td>123</td>
</tr>
<tr>
<td><img src="image" alt="Select – Boundary – Elements" /></td>
<td>Select – Boundary – Elements</td>
<td>Select the points on the boundary of the element.</td>
<td>119</td>
</tr>
<tr>
<td><img src="image" alt="Build – Registration – Initial – Manual" /></td>
<td>Build – Registration – Initial – Manual</td>
<td>Performs initial registration of the specified corresponding points of elements.</td>
<td>143</td>
</tr>
<tr>
<td><img src="image" alt="Build – Move – Elements" /></td>
<td>Build – Move – Elements</td>
<td>Moves the currently selected elements.</td>
<td>151</td>
</tr>
<tr>
<td><img src="image" alt="Build – Rotate – Elements" /></td>
<td>Build – Rotate – Elements</td>
<td>Rotates the elements.</td>
<td>159</td>
</tr>
<tr>
<td><img src="image" alt="Build – Merge" /></td>
<td>Build – Merge</td>
<td>Merges elements to form one element.</td>
<td>161</td>
</tr>
<tr>
<td><img src="image" alt="Build – Fill Holes – Auto" /></td>
<td>Build – Fill Holes – Auto</td>
<td>Fills holes in the element automatically.</td>
<td>163</td>
</tr>
<tr>
<td><img src="image" alt="Build – Fill Holes – Manual" /></td>
<td>Build – Fill Holes – Manual</td>
<td>Creates polygon data for the specified points to fill holes in the element.</td>
<td>162</td>
</tr>
<tr>
<td><img src="image" alt="Build – Smooth – Points" /></td>
<td>Build – Smooth – Points</td>
<td>Smoothens the boundary of the specified points.</td>
<td>166</td>
</tr>
</tbody>
</table>
Controlling the digitizer

To control the VIVID (VI) series digitizer from the Polygon Editing Tool using the [File] – [Import] – [Digitizer] command, make sure that the computer is connected to the VIVID (VI) series digitizer and relational devices correctly.

Ref. For the method of connecting the computer to the digitizer and relational devices, refer to each instruction manual.

[Operating Procedure]

1. Set the power switch of the instrument to ON (“I”).

   ![Diagram of power switch]

2. When the MENU window appears in the viewfinder of the instrument, turn ON the computer to start Windows.

   Ref. For details of the File – Select Digitizer command, refer to page 99.

   Note
   • The instrument must be turned ON before the computer.
   • To control the VIVID, make sure the VIVID that is connected using the File – Select Digitizer command is selected.
Uninstallation

Uninstalling the Polygon Editing Tool

To uninstall the software, use the standard uninstall program of Windows.

**Note**
The software will be deleted one folder at a time. If you have a file(s) you want to keep, copy it to another folder before starting uninstallation.

[Operating Procedure]

1. From the [Start] menu, select [Setting] and then click [Control Panel].
   The [Control Panel] window will appear.

2. Double-click the “Add/Remove” icon, select “Polygon Editing Tool” from the list that appears, and then click the [Add/Remove] button.
   The uninstall program will start.

3. Follow the instructions displayed on the screen to complete uninstallation.
Uninstallation

Uninstalling the Protect Key Driver

To uninstall the protect key driver, use the standard uninstall program of Windows.

Memo
Uninstallation can be carried out irrespective of whether the protect key is left inserted or removed.

[Operating Procedure]

1. From the [Start] menu, select [Setting] and then click [Control Panel].
   The [Control Panel] window will appear.

2. Double-click the “Add/Remove” icon, select “HASP Device Driver” from the list that appears, and then click the [Change/Remove] button.
   The uninstall program will start.

3. Follow the instructions displayed on the screen to complete uninstallation.
   The protect key driver will be uninstalled.

Memo
After the protect key driver has been uninstalled, restart the computer.
Disconnecting the Protect Key

[Disconnecting Procedure]

1. Turn OFF the computer.

2. Loosen the protect key’s two screws.

   **Memo**
   
   If a printer cable or other cable has been connected to the protect key, first remove that cable and then loosen the screws.

3. Remove the protect key from the printer port.
Uninstallation
Chapter 2

Command Reference
File Menu

New .......................................................................................................23
Open ......................................................................................................24
Save – Elements ....................................................................................26
Save – Scene ..........................................................................................27
Save as – Elements ...............................................................................28
Save as – Scene ....................................................................................29
Import – Elements ................................................................................30
Import – Digitizer – One Scan
  • When VIVID 300 is Selected .........................................................32
  • When VIVID 700 is Selected ..............................................................40
  • When VIVID 900/910 is Selected .....................................................54
Import – Digitizer – Step Scan
  • When VIVID 300 is Selected ..............................................................35
  • When VIVID 700 is Selected ..............................................................43
  • When VIVID 900/910 is Selected .....................................................59
Import – Digitizer – PC Card
  • When VIVID 700 is Selected ..............................................................48
  • When VIVID 900/910 is Selected .....................................................76
Export – Elements ................................................................................90
Export – Images ....................................................................................94
Remove Elements ................................................................................95
Preferences ..........................................................................................96
Select Digitizer ...................................................................................99
Exit ..................................................................................................... 100
Creating New Scene Data

This command is used to delete the current scene and open a new scene.

[Operating Procedure]

   The current scene will be deleted and a new blank scene will be generated.
   • If modifications have been made to an element after it has been imported or saved, the “Some elements are modified. Do you want to save them?” message dialog box will appear.
   • To save the element data, click the [Yes] button.
   • Clicking the [No] button will display the new scene without saving the element data.

Reference: For details of how to save elements, refer to the File – Save – Elements command (page 26).
File – Open

Opening Saved Data

This command is used to load an element file or scene file that has been saved using the File – Save – Elements command etc.

[Operating Procedure]

1 Click [Open] on the [File] menu.
The [File-Open] dialog box will appear.
   • The dialog box shows a list of files. If all the files cannot be displayed on one page, a scroll bar will be displayed.

2 Select the file you want to load.
   If you select an element file with an attached image and you have also checked the Preview box, the display area will show a preview image.
   • To display files of a certain format only, select the desired format from the “File of type” pull-down menu.

Memo
In the case of element files, it is possible to select two or more files by clicking them while holding down the [Shift] or [Ctrl] key. If two or more files are selected, the preview image can be switched from one file to another using the [BACKWARD] and [FORWARD] buttons.

Note
• It is not possible to select files of different formats.
• In the case of scene files, only one file can be opened.
• It is not possible to open scene files which have been saved using the Utility Software VI-S1.

3 Click the [Open] button.
The data of the selected file(s) will be loaded and displayed in the view window.

When an element file is loaded:
• The loaded data will be ready to be displayed in all windows. It will be displayed in the active window and the windows for which all the elements are set to be displayed.
• When the data is loaded for the first time after the software is started, it will be fully framed in all the windows including those that are hidden.
• The names of the loaded elements will also appear in the element list, indicating that the elements have been selected (highlighted).
When a scene file is loaded:

- The element list will show the names of the elements contained in the scene, and the view information of each element will be loaded.
- The state in effect when a scene file was saved can be restored. However, it cannot always be restored completely, for example, if elements in the file have been set not to be displayed.

- If an element has already been loaded, the Warning dialog box shown on the right will appear.

  1. Click the [OK] button.

  All the elements that have already been loaded will be deleted, and the data of the scene file will be displayed.

**Memo**

A clock icon will be displayed during loading.

<table>
<thead>
<tr>
<th>Parameters for [File-Open] Dialog Box</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Look in</td>
<td>Displays the currently selected folder name.</td>
</tr>
<tr>
<td>File name</td>
<td>Displays the currently selected file name.</td>
</tr>
<tr>
<td>File of type</td>
<td>Displays the type of the currently selected file.</td>
</tr>
<tr>
<td>Preview</td>
<td>If you check the Preview box, the [File - Open] dialog box will display preview images of those element files that have attached images.</td>
</tr>
</tbody>
</table>
File – Save – Elements  

[Ctrl] + [S]

Saving Element Data

This command is used to save the data selected in the element list. The data will be saved under the current element file name.

[Operating Procedure]

1. **Select the element(s) to be saved.**
   
   **Memo**
   
   It is possible to select two or more elements by clicking them while holding down the [Shift] or [Ctrl] key.

2. **From the [File] menu, select [Save] and then click [Elements].**
   
   The selected element data will be saved under the current file name.

   - If the selected elements are newly created elements or those that are loaded in another file format, the same dialog box as the one that appears when the File – Save as – Elements command is selected will appear, displaying the element names in the order they are selected.
     
     1. If you want to change the file name, change it and click the [Save] button.
        
        - The first element will be saved, and a dialog box for the next element will appear.
        
        - If you click the [Cancel] button, the next element and subsequent elements will not be saved.

   **Ref.** For details of the File – Save as – Elements command, refer to page 28.
File – Save – Scene

Saving Scene Data

This command is used to save the current scene data under the current scene file name.

[Operating Procedure]

1. From the [File] menu, select [Save] and then click [Scene].
   The elements comprising the scene and its view information will be saved under the current scene file name.

   • If the scene is one that has been newly created, the same dialog box as the one that appears when the File – Save as – Scene command is selected will appear.
      ① Enter the desired file name, and click the [Save] button.
      The scene will be saved.

   Memo For details of the File – Save as – Scene command, refer to page 29.

Memo
If no elements are present, only the view information will be saved.
**File – Save as – Elements**

**Saving Element Data under a Different Name**

This command is used to save the data selected in the element list under a different file name.

**[Operating Procedure]**

1. **Select the element to be saved.**
   *Memo*
   It is possible to select two or more elements by clicking them while holding down the [Shift] or [Ctrl] key.

2. **From the [File] menu, select [Save as] and then click [Elements].**
   The [File-Save as-Elements] dialog box will appear.
   *• If two or more elements have been selected, their names will be displayed in the order they are displayed in the element list.*

3. **If you want to change the file name, enter a new file name.**
   *Note*
   The file name must consist of alphanumeric characters only.
   Changing the file name will not cause the element names to change.

4. **Click the [Save] button.**
   The first element will be saved, and a dialog box for the next element will appear.
   *• When all the elements are saved, the dialog box will close.*
   *• If you click the [Cancel] button, the next element and subsequent elements will not be saved.*
   *Memo*
   By selecting “Element files Ver.1.x” from the “Save as type” pull-down menu, the elements can be saved under the format of the Utility Software VI-S1.
   *Note*
   If the elements are saved under the format of the Utility Software VI-S1, data attached to the images may be lost.

<table>
<thead>
<tr>
<th>Parameters for [File-Save As-Elements] Dialog Box</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save in</td>
</tr>
<tr>
<td>File name</td>
</tr>
<tr>
<td>Save as type</td>
</tr>
</tbody>
</table>
Saving Scene Data under a Different Name

This command is used to save the current scene data under a different file name.

[Operating Procedure]

1. From the [File] menu, select [Save as] and then click [Scene].
   The [File-Save as-Scene] dialog box will appear.

2. Enter the desired file name, and click the [Save] button.
   The scene comprising the elements and its view information will be saved.

   **Memo**
   - If no elements are present, only the view information will be saved.
   - If you want the scene file to start up automatically the next time you run the program, save it into the “Polygon Editing Tool Ver.1.8.0/Model” directory and give it the name “startup.scn”. When the program starts it will check for this file, and if the file exists it will automatically load it.

   **Note**
   - *The scene data can not be loaded using the Utility Software VI-S1.*
   - *The file name must consist of alphanumeric characters only.*

<table>
<thead>
<tr>
<th>Parameters for [File-Save As-Scene] Dialog Box</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save in</td>
<td>Displays the currently selected folder name.</td>
</tr>
<tr>
<td>File name</td>
<td>Displays the currently selected file name.</td>
</tr>
<tr>
<td>Save as type</td>
<td>Displays the type of the currently selected file.</td>
</tr>
</tbody>
</table>
File – Import – Elements

Importing Scanned Data

This command is used to import the raw scan data that was saved when the object was scanned by the VIVID (VI) series digitizer.

[Operating Procedure]

1. From the [File] menu, select [Import] and then click [Elements].
   - The dialog box shows a list of files. If all the files cannot be displayed on one page, a scroll bar will be displayed.

2. From the “File of type” pull-down menu, select the format of importing data.

3. Select the file you want to import.
   If you select an element file with the attached image and you have also checked the Preview box, the display area will show a preview image.
   - If data files imported by the File (If you select data files saved by Step Scan), the [BACKWARD] and [FORWARD] buttons will be active, allowing you to display a preview image of each data.
   - It is possible to select two or more files by clicking them while holding down the [Shift] or [Ctrl] key. If two or more files are selected, the preview image can be switched from one file to another using the [BACKWARD] and [FORWARD] buttons.
   - It is not possible to select files of different formats.
   - Although it is possible to import STL format data, no guarantee will be given if it contains illegal polygons.

4. Set various parameters including reduce rate.
   - Select the desired rate from 1/1, 1/4, 1/9, 1/16 and No polygon by selecting the corresponding pull-down menu.
   - If you want to generate points to fill in holes caused by missing data, set the File Holes setting to On.
   - The Remove pull-down menu lets you select which points to remove from the imported data. You can set this to any of the following: “None”, “Boundary(B.)”, “5deg. & B.”, “10deg. & B.”, “15deg. & B.”, or “20deg. & B.”
   - If you want to filter the imported data, select the appropriate parameter from the Filter pull-down menu.
   - When importing data, if you want to perform dark correction for color data, check the [Dark Correction] checkbox.
5 Click the [Import] button.
The data will be imported and displayed in the view window. The names of the imported elements will also appear in the element list, indicating that the elements have been selected (highlighted).

- The loaded data will be ready to be displayed in all windows. It will be displayed in the active window and the windows for which all the elements are set to be displayed.
- When the data is loaded for the first time after the software is started, it will be fully framed in all the windows including those that are hidden.
- In the case of data acquired using the Digitizer – Step Scan command, each data will be subjected to registration when the file is opened, and then the resulting data will be displayed. A dialog box will also appear asking whether you want to perform fine-adjustment.

1 Click the [OK] button.

Fine-adjustment will be performed.

Memo
A progress bar will be displayed during loading.

<table>
<thead>
<tr>
<th>Parameters for [File-Import-Elements] Dialog Box</th>
</tr>
</thead>
<tbody>
<tr>
<td>Look in</td>
</tr>
<tr>
<td>File name</td>
</tr>
<tr>
<td>File of type</td>
</tr>
<tr>
<td>Reduction Rate</td>
</tr>
<tr>
<td>Fill Holes</td>
</tr>
<tr>
<td>Remove</td>
</tr>
<tr>
<td>Filter</td>
</tr>
<tr>
<td>Dark Correction</td>
</tr>
<tr>
<td>Preview</td>
</tr>
</tbody>
</table>
Performing One Scan with the VIVID 300

This command is used to cause the VIVID 300 (VI-300) to scan the object one scan at a time using the remote control function of this software.

Memo

Before performing the procedure below, make sure that the digitizer you are going to use is selected by the File – Select Digitizer command.

Ref. For details of the File – Select Digitizer command, refer to page 99.

[Operating Procedure]

1. From the [File] menu, select [Import], [Digitizer] and then [One Scan].
   The [File-Import-Digitizer-One Scan] dialog box will appear.
   - The color monitor image currently captured by the instrument will appear in the “Color” area of the dialog box. (No color image will appear if the [Auto read] checkbox is unchecked even if the [Option] checkbox is checked.)

2. Set an object in place.

3. Set optional parameters.
   Check the [Option] checkbox, and make necessary parameters.
   - To set the scan reference position (Distance) and laser intensity (Laser Intensity), perform the following procedure.
     ① Check the [Option] checkbox.
     ② Check the [Manual] checkbox.
     ③ Move the Distance bar or Laser Intensity bar to the desired position.
   - If you are not going to scan both color and range images at the same time, uncheck the [Auto read] checkbox.
4 **Click the [Scan] button.**
Scan will start, and both color and range images will be displayed.

- If the color and range images are not scanned at the same time, clicking the [Read] button will capture a color image and display it.
- To restart scan, repeat steps 2 to 3.

5 **Click the [Convert] button.**
The [File-Import-Digitizer-One Scan-Convert] dialog box will appear.

6 **Enter the desired element name, and set parameters.**

- Select the desired rate from 1/1, 1/4, 1/9, 1/16 and No polygon by selecting the corresponding pull-down menu.
- If you want to generate points to fill in holes caused by missing data, set the File Holes setting to On.
- The Remove pull-down menu lets you select which points to remove from the imported data. You can set this to any of the following: “None”, “Boundary(B.)”, “5deg. & B.”, “10deg. & B.”, “15deg. & B.”, or “20deg. & B.”
- If you want to filter the imported data, select the appropriate parameter from the Filter pull-down menu.
- To save the raw scan data (.cam) when importing data, check the [Save camera data] checkbox.

   **Note**  
   The element name must consist of up to 31 alphanumeric characters.

7 **Click the [OK] button.**
The scanned image will be displayed. The names of the imported elements will also appear in the element list, indicating that the elements have been selected (highlighted).

- The loaded data will be ready to be displayed in all windows. It will be displayed in the active window and the windows for which all the elements are set to be displayed.
- When the data is loaded for the first time after the software is started, it will be fully framed in all the windows including those that are hidden automatically.

- If the [Save camera data] checkbox was checked at step 7, the [Remote-Save] dialog box will appear
  1. Enter the desired file name.
  2. Click the [Save] button.

   **Note**  
   The file name must consist of alphanumeric characters only.
### Parameters for [File-Import-Digitizer-One Scan] (When VIVID 300 is Selected) Dialog Box

<table>
<thead>
<tr>
<th>Option</th>
<th>If this checkbox is checked, the lower section of the [Digitizer-One Scan] dialog box will be active, allowing you to set various parameters including &quot;Distance&quot;, &quot;Laser Intensity&quot; and &quot;Auto read&quot;.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manual</td>
<td>If this checkbox is checked, the &quot;Distance&quot; and &quot;Laser Intensity&quot; parameters can be set.</td>
</tr>
<tr>
<td>Distance</td>
<td>Used to set the instrument’s scan reference position.</td>
</tr>
<tr>
<td>Laser Intensity</td>
<td>Used to set the laser beam intensity of the instrument.</td>
</tr>
<tr>
<td>Auto read</td>
<td>If this checkbox is checked, a color image will be read automatically when the dialog box is opened. Even if the [Read] button is not clicked after the [Scan] button is clicked, the data will be read automatically after images are acquired, and the color image and range image will be displayed in the dialog box. If there is no check mark in the [Option] checkbox, for instance when the software is just started up, the [Auto read] checkbox will be checked automatically.</td>
</tr>
<tr>
<td>Read</td>
<td>Clicking this button while there is no check mark in the [Auto read] checkbox will read data from the instrument and display the range image and the latest color image that were acquired when the [Scan] button was clicked last time in the dialog box. This button is effective only if the [Auto read] checkbox is unchecked.</td>
</tr>
<tr>
<td>Focus Lock</td>
<td>Sets the focus lock. The [Manual] checkbox will be checked automatically, and the current position and Laser Intensity will be displayed.</td>
</tr>
<tr>
<td>Convert</td>
<td>Causes the [File-Import-Digitizer-One Scan-Convert] dialog box to appear, allowing import of the camera data to this software.</td>
</tr>
</tbody>
</table>

### Parameters for [File-Import-Digitizer-One Scan-Convert] Dialog Box

<table>
<thead>
<tr>
<th>Reduction Rate</th>
<th>Selects the reduction rate to be applied when importing the data. You can select any of the following: “1/1”, “1/4”, “1/9”, “1/16”, or “No polygon”.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fill Holes</td>
<td>Selects whether the programs fill in holes when importing the data. If the setting is On, the program will automatically generate points to fill in holes left by missing data.</td>
</tr>
<tr>
<td>Remove</td>
<td>Selects which the data the program excludes when carrying out the import. Select from an of the following: “None”, “Boundary (B.)”, “5deg. &amp; B.”, “10deg. &amp; B.”, “15deg. &amp; B.”, or “20deg. &amp; B.”. None: Removal is not carried out when importing the data. Boundary(B.): The program removes boundary points. 5deg. &amp; B.,10deg. &amp; B., 15deg. &amp; B., 20deg. &amp; B.: The program removes boundary points, and also removes polygons within the specified angular range (5 °, 10 °, 15 °, or 20 °) to the view vector.</td>
</tr>
<tr>
<td>Filter</td>
<td>None: The program does not perform filtering when importing the data. Noise Filter (N.F.): When importing the data, the points that appear to be noise will be corrected according to other data.</td>
</tr>
<tr>
<td>Save camera data</td>
<td>Save the images as camera data.</td>
</tr>
</tbody>
</table>
Performing Step Scan with the VIVID 300

This command is used to take two or more shots using the optional rotating stage via the remote control function of this software. If a rotating stage has been selected by the Turntable, rotation of the stage can also be controlled. After the necessary shots are taken, scan the calibration chart. Data acquired from different angles will be subjected to registration, and the resulting data will appear.

- The calibration chart is an accessory of the rotating stage set.
- Before performing the procedure below, make sure that the digitizer you are going to use is selected by the File – Select Digitizer command.

**Note**

If the rotating stage does not operate correctly from the dialog box, turn OFF the stage, turn it ON again, and then try to operate it.

For details of the File – Select Digitizer command, refer to page 99.

[Operating Procedure]

1. From the [File] menu, select [Import], [Digitizer] and then [Step Scan].
   - The [File-Import-Digitizer-Step Scan] dialog box will appear.
   - The color monitor image currently captured by the instrument will appear in the “Color” area of the dialog box. (No color image will appear if the [Auto read] checkbox is unchecked even if the [Option] checkbox is checked.)

2. Place the object on the rotating stage.

3. Select the desired rotation step from “90”, “60” and “Other”. The rotating stage will rotate at the selected step.
   - If “Other” is selected, enter the desired rotation angle.
4 Set optional parameters.
Check the [Option] checkbox, and make necessary parameters.

- To set the scan reference position (Distance) and laser intensity (Laser Intensity), perform the following procedure.
  1. Check the [Option] checkbox.
  3. Move the Distance bar or Laser Intensity bar to the desired position.

- If you are not going to scan both color and range images at the same time, uncheck the [Auto read] checkbox.

5 Click the [Scan] button.
Scan will start, and both color and range images will be displayed.
The “Next shot?” message dialog box will also appear.

- If the color and range images are not scanned at the same time, clicking the [Read] button will capture a color image and display it.

- If the type of rotating stage has not been designated, turn the rotating stage manually to the next angle displayed in the [Next shot?] dialog box.

6 Click the [OK] button.
The next specified angle will appear in [Current Angle], and the object will be scanned for the next image.
- If a rotating stage has been selected by the Turntable, the stage will turn to the next angle and then the object will be scanned.

- To cancel scan, click the [Cancel] button instead of the [OK] button, and repeat steps 4 to 5.

7 Repeat step 6 until shots from all the desired angles are captured.
When shots from all the desired angles are captured, the “Next shot? Please set the chart.” message dialog box will appear.

- If you want to acquire a shot from a certain angle again, click the angle currently displayed in [Current Angle] with the left mouse button, then select the desired angle from the pull-down menu that appears.

Memo
If an angle (rotation step) has been selected at step 3, necessary steps (angles) to complete 360 degrees will be displayed in the pull-down menu. However, it is not necessary to scan at all the angles. You can select necessary steps (angles) only.
8 Place the calibration chart on the rotating stage.
Position the chart with the black line facing the instrument and place it on the rotating stage so that both entire side surfaces are observed in the viewfinder.

- If “Chart” is not displayed in [Current Angle], click the left mouse button and select “Chart” from the pull-down menu that appears.

Memo
The calibration chart can be scanned at any angle of the rotating stage.

9 Click the [OK] button.
The calibration chart will be scanned.

Memo
Make sure that the acquired range image looks like the good example given below. If it resembles the bad example, click the [Scan] button again to re-scan the calibration chart.

Good example

Bad example

10 Click the [Convert] button.
The [File-Import-Digitizer-Step Scan-Convert] dialog box will appear.
11 **Enter the desired element name, and set parameters.**

- Select the desired rate from 1/1, 1/4, 1/9, 1/16 and No polygon by selecting the corresponding pull-down menu.

- If you want to generate points to fill in holes caused by missing data, set the File Holes setting to On.

- The Remove pull-down menu lets you select which points to remove from the imported data. You can set this to any of the following: “None”, “Boundary(B.)”, “5deg. & B.”, “10deg. & B.”, “15deg. & B.”, or “20deg. & B.”

- If you want to filter the imported data, select the appropriate parameter from the Filter pull-down menu.

- To save the raw scan data (.cam) when importing data, check the [Save camera data] checkbox.

*Note*

The element name must consist of up to 31 characters.

12 **Click the [OK] button.**

Each scanned image will be subjected to registration and displayed, and a dialog box asking whether you want to perform fine-adjustment will appear.

The element list will also show the element name specified at step 11 plus “rotation step”. The element name is highlighted, indicating that it is currently selected.

- The loaded data will be ready to be displayed in all windows. It will be displayed in the active window and the windows for which all the elements are set to be displayed.

- When the data is loaded for the first time after the software is started, it will be fully framed in all the windows including those that are hidden automatically.

- If a rotating stage has been designated, the rotating stage will rotate back to the original position before data reading starts.

- If the [Save camera data] checkbox was checked at step 11, the [Remote-Save] dialog box will appear before the one that asks whether you want to perform fine-adjustment.

  1. Enter the desired file name.
  2. Click the [Save] button.

*Note*

The file name must consist of alphanumeric characters only.

13 **Click the [OK] button.**

Fine-adjustment of the element position will be performed and the data will be displayed again.

- If a rotating stage has been selected by the Turntable, the stage will turn to the next angle and then scan will be performed.

- If you are not going to perform fine-adjustment, click the [Cancel] button instead of the [OK] button.
Fine-adjustment can be cancelled even if it has started, by clicking the [Cancel] button in the dialog box that appears during fine-adjustment.

### Parameters for [File-Import-Digitizer-Step Scan] (When VIVID 300 is Selected) Dialog Box

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Turntable</td>
<td>Used to set the serial port and rotating stage type to be used for remote operation.</td>
</tr>
<tr>
<td>Rotation step</td>
<td>Used to select the desired angle (degree) of the rotating stage from “90”, “60” and “Other”. If “Other” is selected, enter the desired rotation step.</td>
</tr>
<tr>
<td>Current Angle</td>
<td>Used to select the desired scan step (i.e. the angle at which scan is to be performed). “0” will be selected first when the dialog box is opened. It is possible to select the desired angle by clicking the angle currently displayed in [Current Angle] and selecting the desired angle from the pull-down menu that appears. If an angle at which scan has already been performed is selected again and the [Scan] button is clicked, the previously acquired image data will be overwritten.</td>
</tr>
<tr>
<td>Scan</td>
<td>Causes the VIVID 300 (VI-300) to acquire a shot.</td>
</tr>
<tr>
<td>Option</td>
<td>If this checkbox is checked, the lower section of the [Remote-Step Scan] dialog box will be active, allowing you to set various parameters including “Distance”, “Laser Intensity” and “Auto read”.</td>
</tr>
<tr>
<td>Manual</td>
<td>If this checkbox is checked, the “Distance” and “Laser Intensity” parameters can be set.</td>
</tr>
<tr>
<td>Distance</td>
<td>Used to set the instrument’s scan reference position.</td>
</tr>
<tr>
<td>Laser Intensity</td>
<td>Used to set the laser beam intensity of the instrument.</td>
</tr>
<tr>
<td>Auto read</td>
<td>If this checkbox is checked, a color image will be read automatically when the dialog box is opened. Even if the [Read] button is not clicked after the [Scan] button is clicked, the data will be read automatically after images are acquired, and the color image and range image will be displayed in the dialog box. If there is no check mark in the [Option] check-box, for instance when the software is just started up, the [Auto read] checkbox will be checked automatically.</td>
</tr>
<tr>
<td>Read</td>
<td>Clicking this button while there is no check mark in the [Auto read] checkbox will read data from the instrument and display the range image and the latest color image that were acquired when the [Scan] button was clicked last time in the dialog box. This button is effective only if the [Auto read] checkbox is unchecked.</td>
</tr>
<tr>
<td>Focus Lock</td>
<td>Sets the focus lock. The [Manual] checkbox will be checked automatically, and the current position and Laser Intensity will be displayed.</td>
</tr>
<tr>
<td>Convert</td>
<td>Causes the [File-Import-Digitizer-Step Scan-Convert] dialog box to appear, allowing import of the camera data to this software.</td>
</tr>
</tbody>
</table>

### Parameters for [File-Import-Digitizer-Step Scan-Convert] Dialog Box

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reduction Rate</td>
<td>Selects the reduction rate to be applied when importing the data. You can select any of the following: “1/1”, “1/4”, “1/9”, “1/16”, or “No polygon”.</td>
</tr>
<tr>
<td>Fill Holes</td>
<td>Selects whether the programs fill in holes when importing the data. If the setting is On, the program will automatically generate points to fill in holes left by missing data.</td>
</tr>
<tr>
<td>Remove</td>
<td>Selects which the data the program excludes when carrying out the import. Select from an of the following: “None”, “Boundary (B.)”, “5deg. &amp; B.”, “10deg. &amp; B.”, “15deg. &amp; B.”, or “20deg. &amp; B.”. None: Removal is not carried out when importing the data. Boundary(B.): The program removes boundary points. 5deg. &amp; B.,10deg. &amp; B., 15deg. &amp; B., 20deg. &amp; B.: The program removes boundary points, and also removes polygons within the specified angular range (5°, 10°, 15°, or 20°) to the view vector.</td>
</tr>
<tr>
<td>Filter</td>
<td>None: Removal is not carried out when exporting the data. Noise Filter (N.F.): When importing the data, the points that appear to be noise will be corrected according to other data.</td>
</tr>
<tr>
<td>Save camera data</td>
<td>Save the images as camera data.</td>
</tr>
</tbody>
</table>
### File – Import – Digitizer – One Scan (When VIVID 700 is Selected)

#### Performing One Scan with the VIVID 700

This command is used to cause the VIVID 700 (VI-700) to scan the object one scan at a time using the remote control function of this software.

**Memo**

Before performing the procedure below, make sure that the digitizer you are going to use is selected by the File – Select Digitizer command.

For details of the File – Select Digitizer command, refer to page 99.

#### Operating Procedure

1. **From the [File] menu, select [Import], [Digitizer] and then [One Scan].**
   The [File-Import-Digitizer-One Scan] dialog box will appear.
   - The color monitor image currently captured by the instrument will appear in the “Color” area of the dialog box. (No color image will appear if the [Auto read] checkbox is unchecked even if the [Option] checkbox is checked.)

2. **Set an object in place.**

3. **Move the Zoom bar to set the desired view angle.**
   A new color image captured from the specified view angle will appear. (No color image will appear if the [Auto read] checkbox is unchecked.)

4. **Set optional parameters.**
   Check the [Option] checkbox, and make necessary parameters.
   - To set the scan reference position (Distance) and laser intensity (Laser Intensity), perform the following procedure.
     1. Check the [Option] checkbox.
     3. Move the Distance bar or Laser Intensity bar to the desired position.
   - If you are not going to scan both color and range images at the same time, uncheck the [Auto read] checkbox.
5 Click the [Scan] button.
Scan will start, and both color and range images will be displayed.

- If the color and range images are not scanned at the same time, clicking the [Read] button will capture a color image and display it.
- To restart scan, repeat steps 2 to 4.

6 Click the [Convert] button.
The [File-Import-Digitizer-One Scan-Convert] dialog box will appear.

7 Enter the desired element name, and set parameters.

- Select the desired rate from 1/1, 1/4, 1/9, 1/16 and No polygon by selecting the corresponding pull-down menu.
- If you want to generate points to fill in holes caused by missing data, set the File Holes setting to On.
- The Remove pull-down menu lets you select which points to remove from the imported data. You can set this to any of the following: “None”, “Boundary(B.)”, “5deg. & B.”, “10deg. & B.”, “15deg. & B.”, or “20deg. & B.”
- If you want to filter the imported data, select the appropriate parameter from the Filter pull-down menu.
- To save the raw scan data (.cam) when importing data, check the [Save camera data] checkbox.

Note
The element name must consist of up to 31 alphanumeric characters.

8 Click the [OK] button.
The scanned image will be displayed. The names of the imported elements will also appear in the element list, indicating that the elements have been selected (highlighted).

- The loaded data will be ready to be displayed in all windows. It will be displayed in the active window and the windows for which all the elements are set to be displayed.
- When the data is loaded for the first time after the software is started, it will be fully framed in all the windows including those that are hidden automatically.
**File Menu**

- If the [Save camera data] checkbox was checked at step 7, the [Remote-Save] dialog box will appear
  1. Enter the desired file name.
  2. Click the [Save] button.

*Note*
The file name must consist of alphanumeric characters only.

### Parameters for [File-Import-Digitizer-One Scan] (When VIVID 700 is Selected) Dialog Box

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Zoom</strong></td>
<td>Used to set zoom level of the VIVID 700 (VI-700) series digitizer.</td>
</tr>
<tr>
<td><strong>Scan</strong></td>
<td>Causes the VIVID 700 (VI-700) to acquire a shot.</td>
</tr>
<tr>
<td><strong>Option</strong></td>
<td>If this checkbox is checked, the lower section of the [Digitizer-One Scan] dialog box will be active, allowing you to set various parameters including &quot;Distance&quot;, &quot;Laser Intensity&quot; and &quot;Auto read&quot;.</td>
</tr>
<tr>
<td><strong>Manual</strong></td>
<td>If this checkbox is checked, the &quot;Distance&quot; and &quot;Laser Intensity&quot; parameters can be set.</td>
</tr>
<tr>
<td><strong>Distance</strong></td>
<td>Used to set the instrument’s scan reference position.</td>
</tr>
<tr>
<td><strong>Laser Intensity</strong></td>
<td>Used to set the laser beam intensity of the instrument.</td>
</tr>
<tr>
<td><strong>Auto read</strong></td>
<td>If this checkbox is checked, a color image will be read automatically when the dialog box is opened. Even if the [Read] button is not clicked after the [Scan] button is clicked, the data will be read automatically after images are acquired, and the color image and range image will be displayed in the dialog box. If there is no check mark in the [Option] checkbox, for instance when the software is just started up, the [Auto read] checkbox will be checked automatically.</td>
</tr>
<tr>
<td><strong>Read</strong></td>
<td>Clicking this button while there is no check mark in the [Auto read] checkbox will read data from the instrument and display the range image and the latest color image that were acquired when the [Scan] button was clicked last time in the dialog box. This button is effective only if the [Auto read] checkbox is unchecked.</td>
</tr>
<tr>
<td><strong>Focus Lock</strong></td>
<td>Sets the focus lock. The [Manual] checkbox will be checked automatically, and the current position and Laser Intensity will be displayed.</td>
</tr>
<tr>
<td><strong>Convert</strong></td>
<td>Causes the [File-Import-Digitizer-One Scan-Convert] dialog box to appear, allowing import of the camera data to this software.</td>
</tr>
</tbody>
</table>

### Parameters for [File-Import-Digitizer-One Scan-Convert] Dialog Box

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Reduction Rate</strong></td>
<td>Selects the reduction rate to be applied when importing the data. You can select any of the following: “1/1”, “1/4”, “1/9”, “1/16”, or “No polygon”.</td>
</tr>
<tr>
<td><strong>Fill Holes</strong></td>
<td>Selects whether the programs fill in holes when importing the data. If the setting is On, the program will automatically generate points to fill in holes left by missing data.</td>
</tr>
<tr>
<td><strong>Remove</strong></td>
<td>Selects which the data the program excludes when carrying out the import. Select from an of the following: “None”, “Boundary (B.)”, “5deg. &amp; B.”, “10deg. &amp; B.”, “15deg. &amp; B.”, or “20deg. &amp; B.”. None: Removal is not carried out when importing the data. Boundary (B.): The program removes boundary points. 5deg. &amp; B., 10deg. &amp; B., 15deg. &amp; B., 20deg. &amp; B.: The program removes boundary points, and also removes polygons within the specified angular range (5°, 10°, 15°, or 20°) to the view vector.</td>
</tr>
<tr>
<td><strong>Filter</strong></td>
<td>None: Removal is not carried out when exporting the data. Noise Filter (N.F.): When importing the data, the points that appear to be noise will be corrected according to other data.</td>
</tr>
<tr>
<td><strong>Save camera data</strong></td>
<td>Save the images as camera data.</td>
</tr>
</tbody>
</table>
Performing Step Scan with the VIVID 700

This command is used to take two or more shots using the optional rotating stage via the remote control function of this software. If a rotating stage has been selected by the rotating table, rotation of the stage can also be controlled.

After the necessary shots are taken, scan the calibration chart. Data acquired from different angles will be subjected to registration, and the resulting data will appear.

**Memo**
- The calibration chart is an accessory of the rotating stage set.
- Before performing the procedure below, make sure that the digitizer you are going to use is selected by the File – Select Digitizer command.

**Note**
*If the rotating stage does not operate correctly from the dialog box, turn OFF the stage, turn it ON again, and then try to operate it.*

For details of the File – Select Digitizer command, refer to page 99.

## [Operating Procedure]

1. **From the [File] menu, select [Import], [Digitizer] and then [Step Scan].**
   - The [File-Import-Digitizer-Step Scan] dialog box will appear.
     - The color monitor image currently captured by the instrument will appear in the “Color” area of the dialog box. (No color image will appear if the [Auto read] checkbox is unchecked even if the [Option] checkbox is checked.)

2. **Place the object on the rotating stage.**

3. **Select the desired rotation step from “90”, “60” and “Other”. The rotating stage will rotate at the selected step.**
   - If “Other” is selected, enter the desired rotation angle.

4. **Move the Zoom bar to set the desired view angle.**
   - A new color image captured from the specified view angle will appear. (No color image will appear if the [Auto read] checkbox is unchecked.)
5 **Set optional parameters.**
Check the [Option] checkbox, and make necessary parameters.

- To set the scan reference position (Distance) and laser intensity (Laser Intensity), perform the following procedure.
  1. Check the [Option] checkbox.
  3. Move the Distance bar or Laser Intensity bar to the desired position.

- If you are not going to scan both color and range images at the same time, uncheck the [Auto read] checkbox.

6 **Click the [Scan] button.**
Scan will start, and both color and range images will be displayed. The “Next shot?” message dialog box will also appear.

- If the color and range images are not scanned at the same time, clicking the [Read] button will capture a color image and display it.

- If the type of rotating stage has not been designated, turn the rotating stage manually to the next angle displayed in the [Next shot?] dialog box.

7 **Click the [OK] button.**
The next specified angle will appear in [Current Angle], and the object will be scanned for the next image.

- If a rotating stage has been selected by the Turntable, the stage will turn to the next angle and then the object will be scanned.

- To cancel scan, click the [Cancel] button instead of the [OK] button, and repeat steps 4 to 6.

8 **Repeat step 7 until shots from all the desired angles are captured.**
When shots from all the desired angles are captured, the “Next shot? Please set the chart.” message dialog box will appear.

- If you want to acquire a shot from a certain angle again, click the angle currently displayed in [Current Angle] with the left mouse button, then select the desired angle from the pull-down menu that appears.

**Memo**
If an angle (rotation step) has been selected at step 3, necessary steps (angles) to complete 360 degrees will be displayed in the pull-down menu. However, it is not necessary to scan at all the angles. You can select necessary steps (angles) only.
9 Place the calibration chart on the rotating stage.
Position the chart with the black line facing the instrument and place it on the rotating stage so that both entire side surfaces are observed in the viewfinder.

- If “Chart” is not displayed in [Current Angle], click the left mouse button and select “Chart” from the pull-down menu that appears.

Memo
The calibration chart can be scanned at any angle of the rotating stage.

10 Click the [OK] button.
The calibration chart will be scanned.

Memo
Make sure that the acquired range image looks like the good example given below. If it resembles the bad example, click the [Scan] button again to re-scan the calibration chart.

11 Click the [Convert] button.
The [File-Import-Digitizer-Step Scan-Convert] dialog box will appear.
12. **Enter the desired element name, and set parameters.**

- Select the desired rate from 1/1, 1/4, 1/9, 1/16 and No polygon by selecting the corresponding pulldown menu.
- If you want to generate points to fill in holes caused by missing data, set the File Holes setting to On.
- The Remove pull-down menu lets you select which points to remove from the imported data. You can set this to any of the following: “None”, “Boundary(B.)”, “5deg. & B.”, “10deg. & B.”, “15deg. & B.”, or “20deg. & B.”
- If you want to filter the imported data, select the appropriate parameter from the Filter pull-down menu.
- To save the raw scan data (.cam) when importing data, check the [Save camera data] check-box.

**Note**

*The element name must consist of up to 31 characters.*

13. **Click the [OK] button.**

Each scanned image will be subjected to registration and displayed, and a dialog box asking whether you want to perform fine-adjustment will appear. The element list will also show the element name specified at step 12 plus “rotation step”. The element name is highlighted, indicating that it is currently selected.

- The loaded data will be ready to be displayed in all windows. It will be displayed in the active window and the windows for which all the elements are set to be displayed.
- When the data is loaded for the first time after the software is started, it will be fully framed in all the windows including those that are hidden automatically.
- If a rotating stage has been designated, the rotating stage will rotate back to the original position before data reading starts.

- If the [Save camera data] checkbox was checked at step 12, the [Remote-Save] dialog box will appear before the one that asks whether you want to perform fine-adjustment.
  ① Enter the desired file name.
  ② Click the [Save] button.

**Note**

*The file name must consist of alphanumeric characters only.*

14. **Click the [OK] button.**

Fine-adjustment of the element position will be performed and the data will be displayed again.

- If a rotating stage has been selected by the Turntable, the stage will turn to the next angle and then scan will be performed.
- If you are not going to perform fine-adjustment, click the [Cancel] button instead of the [OK] button.
Fine-adjustment can be cancelled even if it has started, by clicking the [Cancel] button in the dialog box that appears during fine-adjustment.

<table>
<thead>
<tr>
<th>Parameters for [File-Import-Digitizer-Step Scan] (When VIVID 700 is Selected) Dialog Box</th>
</tr>
</thead>
<tbody>
<tr>
<td>Turntable</td>
</tr>
<tr>
<td><strong>Note</strong></td>
</tr>
<tr>
<td>Rotation step</td>
</tr>
<tr>
<td>Current Angle</td>
</tr>
<tr>
<td>Zoom</td>
</tr>
<tr>
<td>Scan</td>
</tr>
<tr>
<td>Option</td>
</tr>
<tr>
<td>Manual</td>
</tr>
<tr>
<td>Distance</td>
</tr>
<tr>
<td>Laser Intensity</td>
</tr>
<tr>
<td>Auto read</td>
</tr>
<tr>
<td>Read</td>
</tr>
<tr>
<td>Focus Lock</td>
</tr>
<tr>
<td>Convert</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Parameters for [File-Import-Digitizer-Step Scan-Convert] Dialog Box</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reduction Rate</td>
</tr>
<tr>
<td>Fill Holes</td>
</tr>
<tr>
<td>Remove</td>
</tr>
<tr>
<td>Filter</td>
</tr>
<tr>
<td>Save camera data</td>
</tr>
</tbody>
</table>
File – Import – Digitizer – PC Card (When VIVID 700 is Selected)
Importing Data from the Memory Card of VIVID 700

This command is used to remote-control the data stored in the memory card of the VIVID 700 (VI-700).

Memo
Before performing the procedure below, make sure that the digitizer you are going to use is selected by the File – Select Digitizer command.

Memo
For details of the File – Select Digitizer command, refer to page 99.

Memo
This command does not operate on step-scan scan data in the memory card.

[Operating Procedure]

1. From the [File] menu, select [Import], [Digitizer] and then [PC Card].

   Memo
   Upper-case file names specified using the camera will be converted to lower-case file names when the files are imported to this software.

2. Select the file you want to import.
   • To display the preview image, check the [Preview Image] checkbox (so that a check mark appears in the check box). A color image of the selected file will be displayed.

   Memo
   A clock icon will be displayed during loading.

Parameters for [File-Import-Digitizer-PC Card] Dialog Box

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File name</td>
<td>Displays file names stored in the memory card.</td>
</tr>
<tr>
<td>Date</td>
<td>Displays the dates on which the files are stored in the memory card.</td>
</tr>
<tr>
<td>Size</td>
<td>Displays the size of each file (in bytes).</td>
</tr>
<tr>
<td>Total files</td>
<td>Displays the total number of camera data files stored in the memory card.</td>
</tr>
<tr>
<td>** MB/ ** MB</td>
<td>Displays the unoccupied capacity and total capacity of the memory card.</td>
</tr>
</tbody>
</table>

Sorting the Files (Sort radio button)

The [Name] and [Date] radio buttons are used to select whether file names are displayed alphabetically or by date.

[Operating Procedure]

Before starting the following procedure, make sure that the [File-Import-Digitizer-PC Card] dialog box is displayed.
1 Click the [Name] radio button to sort the files alphabetically or [Date] radio button to sort by date.
The files will be sorted alphabetically if the [Name] radio button is selected or by date if the [Date] radio button is selected.
• When sort is complete, selection state of each file in the file list and preview image will be cleared.

**Updating the File List ([Update] button)**
The [Update] button is used to load the file names from the memory card to this software and update the file list.
If the memory card is replaced while the [File-Import-Digitizer-PC Card] dialog box is open, be sure to click this button to update the file list.

**[Operating Procedure]**
Before starting the following procedure, make sure that the [File-Import-Digitizer-PC Card] dialog box is displayed.
1 Click the [Update] button.
All the file names in the memory card will be loaded to the software and a new file list will be displayed.

**Loading the Selected Data ([Load] button)**
The [Load] button is used to load the data of the selected file from the memory card to the software.

**[Operating Procedure]**
Before starting the following procedure, make sure that the [File-Import-Digitizer-PC Card] dialog box is displayed.
1 From the file list, select the file you want to load.
2 Click the [Load] button.
A dialog box will appear, allowing you to enter the desired element name.
The file name in the memory card will be displayed as an element name.
3 Change the element name if necessary, and set the parameters.
   • Select the desired rate from 1/1, 1/4, 1/9, 1/16 and No polygon by selecting the corresponding pulldown menu.
   • If you want to generate points to fill in holes caused by missing data, set the File Holes setting to On.
   • The Remove pull-down menu lets you select which points to remove from the imported data. You can set this to any of the following: “None”, “Boundary(B.)”, “5deg. & B.”, “10deg. & B.”, “15deg. & B.”, or “20deg. & B.”
   • If you want to filter the imported data, select the appropriate parameter from the Filter pulldown menu.
4 Click the [Load] button.
The data of the selected file will be loaded and displayed in the view window. The names of the imported elements will also appear in the element list, indicating that the elements have been selected (highlighted).
- The loaded data will be ready to be displayed in all windows. It will be displayed in the active window and the windows for which all the elements are set to be displayed.
- When the data is loaded for the first time after the software is started, it will be fully framed in all the windows including those that are hidden.

Memory
A clock icon will be displayed during loading.

<table>
<thead>
<tr>
<th>Parameters for [File-Import-Digitizer-PC Card-Load] Dialog Box</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reduction Rate</td>
</tr>
<tr>
<td>Fill Holes</td>
</tr>
<tr>
<td>Remove</td>
</tr>
<tr>
<td>Filter</td>
</tr>
</tbody>
</table>

Deleting the Selected File ([Delete] button)
The [Delete] button is used to delete the selected file from the memory card.

[Operating Procedure]
Before starting the following procedure, make sure that the [File-Import-Digitizer-PC Card] dialog box is displayed.

1 From the file list, select the file you want to delete.

2 Click the [Delete] button. A message dialog box will appear.

3 Click the [Delete] button. The file will be deleted.
Deleting All the Files ([Delete All] button)

The [Delete All] button is used to delete all the files from the memory card.

[Operating Procedure]
Before starting the following procedure, make sure that the [File-Import-Digitizer-PC Card] dialog box is displayed.

1. **Click the [Delete All] button.**
   A message dialog box will appear.

2. **Click the [Delete All] button.**
   All the files in the memory card will be deleted.

   **Note**
   All the files in the memory card will be deleted, irrespective of whether or not they are currently selected in the file list.

Saving the Selected File ([Copy] button)

The [Copy] button is used to copy the selected file from the memory card and save it as camera data.

[Operating Procedure]
Before starting the following procedure, make sure that the [File-Import-Digitizer-PC Card] dialog box is displayed.

1. **From the file list, select the file you want to copy.**

2. **Click the [Copy] button.**
   The [PC Card-Copy] dialog box will appear.
   The copy destination directory and names of the files present in that directory will be displayed.

3. **Change the directory and file name if necessary.**
   **Note**
   The file name must consist of alphanumeric characters only.

4. **Click the [Copy] button.**
   The file will be saved as camera data.
File Menu

Saving All the Files ([Copy All] button)

The [Copy All] button is used to copy the data of all the files from the memory card and save them as camera data.

[Operating Procedure]

Before starting the following procedure, make sure that the [File-Import-Digitizer-PC Card] dialog box is displayed.

1. Click the [Copy All] button.
   The copy destination directory will be displayed.

2. Change the directory if necessary.

3. Click the [Copy All] button.
   All the files will be saved as camera data.

   • If a file(s) having the same name exists, a message dialog box will appear.
     ① Select [Overwrite], [Overwrite All], [Skip] or [Cancel].
     • Clicking the [Overwrite] button will overwrite the file which is currently displayed in the message dialog box.
     • Clicking the [Overwrite All] button will overwrite the file which is currently displayed in the message dialog box as well as all the remaining files having the same names at once. The message dialog box will not be displayed for those remaining files.
     • Clicking the [Skip] button will ignore the file displayed in the dialog box and proceed to the next file on the file list.
     • Clicking the [Cancel] button will close the dialog box without saving all the remaining files (including the one displayed in the dialog box).
Changing the Selected File Name ([Rename] button)

The [Rename] button is used to change the name of the file selected from the memory card.

[Operating Procedure]

Before starting the following procedure, make sure that the [File-Import-Digitizer-PC Card] dialog box is displayed.

1. From the file list, select the name of the file you want to change.

2. Click the [Rename] button.

3. Enter the new name and click the [Rename] button.
   The file name will be changed.

Note
Names of the files stored in the memory card must consist of up to eight characters. Only alphabets, numerical numbers, bars “-” and underbars “_” can be used. Lower-case characters contained in file names will be converted to upper-case characters.
File – Import – Digitizer – One Scan (When VIVID 900/910 is Selected)

Performing One Scan with the VIVID 900/910

This command is used to cause the VIVID 900/910 (VI-900/910) to scan the object one scan at a time using the remote control function of this software. If a rotating stage has been selected by the Turntable, rotation of the stage can also be controlled.

**Note**
If the rotating stage does not operate correctly from the dialog box, turn OFF the stage, turn it ON again, and then try to operate it.

**Memo**
- Before performing the procedure below, make sure that the digitizer you are going to use is selected by the File – Select Digitizer command.
- Note that although this version of the software supports simultaneous use of two VIVID 900/910 units, the software can only access the memory card located in the unit with the higher SCSI ID.

**Ref.** For details of the File – Select Digitizer command, refer to page 99.

**[Operating Procedure]**

1. **From the [File] menu, select [Import], [Digitizer] and then [One Scan].**
   The [File-Import-Digitizer-One Scan] dialog box will appear.
   - The monochrome monitor image currently captured by the instrument will appear in the Image area of the dialog box.

2. **Set an object in place.**
   If you are going to use the rotating stage, place the object on it.

3. **To display the object in the middle of the window, change the position of the object or move the instrument back and forth to change the view angle.**
   **Memo**
   If necessary, replace the lens attached to the instrument.
4 Select the desired scan mode (Fine or Fast).

5 If you are going to use the turntable, set the serial port and rotating stage type to be used under the Hardware tab.

6 Set optional parameters.

7 Click the [Scan] button. Scan will start, and both color and range images will be displayed.

   **Memo**
   - In the range image, areas comprised of regular data are shown in color.
   - In High Quality mode, data for which laser intensity was too high are displayed in bright gray, while data for which intensity was too low are displayed in dark gray.

   - If the color and range images are not scanned at the same time, clicking the [Color Read] button or double-clicking on the image will capture a color image and display it.

   - Dragging the mouse on the color image will enlarge the image. If necessary, enable color correction such as “Dark”, “Log” and “Smooth”, and load the color image again.

   - To restart scan, repeat steps 2 to 4. If necessary, click the [Mono] button to display a monochrome image.

8 Click the [Convert] button. The [Remote-Convert] dialog box will appear.

9 Enter the desired element name, and set parameters.

   - Select the desired rate from 1/1, 1/4, 1/9, 1/16 and No polygon by selecting the corresponding pull-down menu.

   - If you want to generate points to fill in holes caused by missing data, set the File Holes setting to On.
File Menu

- The Remove pull-down menu lets you select which points to remove from the imported data. You can set this to any of the following: “None”, “Boundary(B.)”, “5deg. & B.”, “10deg. & B.”, “15deg. & B.”, or “20deg. & B.”

- If you want to filter the imported data, select the appropriate parameter from the Filter pull-down menu.

- To save the raw scan data (.cdm) when importing data, check the [Save CDM] checkbox.

N°T
The element name must consist of up to 31 characters.

10 Click the [OK] button.
The scanned image will be displayed. The names of the imported elements will also appear in the element list, indicating that the elements have been selected (highlighted).

- The loaded data will be ready to be displayed in all windows. It will be displayed in the active window and the windows for which all the elements are set to be displayed.
- When the data is loaded for the first time after the software is started, it will be fully framed in all the windows including those that are hidden automatically.

- If the [Save CDM] checkbox was checked at step 9, the [Remote-Save] dialog box will appear.
  ①Enter the desired file name.
  ②Click the [Save] button.

N°T
The file name must consist of alphanumeric characters only.
### Parameters for [File-Import-Digitizer-One Scan] (When VIVID 900/910 is Selected) Dialog Box

<table>
<thead>
<tr>
<th><strong>Common Area</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>AF</td>
<td>Executes auto-focus.</td>
</tr>
<tr>
<td>Mono</td>
<td>Displays a monochrome monitoring image.</td>
</tr>
<tr>
<td>Color</td>
<td>Takes and displays a color picture.</td>
</tr>
<tr>
<td>Pitch</td>
<td>Displays previously scanned pitch image. (This button appears only if you are using two interconnected VIVID units.)</td>
</tr>
<tr>
<td>Distance</td>
<td>Checking this item sets Distance on.</td>
</tr>
<tr>
<td>Intensity</td>
<td>Checking this item sets LD and Gain on.</td>
</tr>
<tr>
<td>LD</td>
<td>Sets the intensity of the laser beam.</td>
</tr>
<tr>
<td>Gain</td>
<td>Sets the gain.</td>
</tr>
<tr>
<td>Focus Lock</td>
<td>Locks the focus. When you select this item, the program automatically places checks in the Distance and Intensity checkboxes, and displays the currently set position, the current laser-beam intensity, and the gain value.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>General Tab</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Scan</td>
<td>Executes scanning from the VIVID unit.</td>
</tr>
<tr>
<td>Color Read</td>
<td>When you press this button after taking a scan, the program takes a color shot and updates the picture on the display. This button is effective only after scanning, and only if Use Texture is checked and Auto Read is unchecked.</td>
</tr>
<tr>
<td>Convert</td>
<td>Use when you want the program to load camera data. Opens the [Remote-Convert] dialog.</td>
</tr>
<tr>
<td>Export</td>
<td>Export scanned data in various data formats.</td>
</tr>
<tr>
<td>Go</td>
<td>Sequentially executes those of the following functions that are checked: AF, Scan, Convert, Export, and Close.</td>
</tr>
</tbody>
</table>

**Camera 1 Tab**

- **Log**: If this button is ON, the program applies log correction for color data. Set this feature ON when you want to brighten up neutral color.
- **Smooth**: If this button is ON, the program applies smoothing to color data. Set this feature ON if illumination is low and the image is unclear.
- **Dark**: If this button is ON, the program applies dark correction to color data. Set this feature ON if you are getting striation-type noise in the images.
- **Color Level**: Checking this item sets the program to use color exposure level.
- **Threshold**: Checking this item sets the program to use a threshold for distance-image creation.
- **Fine/Fast**: Selects the scan mode.
- **Dynamic Range Expansion Mode**: If this button is checked, the program takes multiple shots so as to expand the dynamic range and reduce data loss. This button is displayed only for the VIVID 910.

**High Quality Mode**

- **Use Texture**: Checking this item enables use of color images when converting and exporting. Note that if you use the Go button, the program will automatically load color data after scanning, regardless of whether Auto Read is checked.
- **Auto read**: Checking this item enables auto-read operation. If auto-read is enabled, the program will load data after scanning (after the Scan button is clicked), with no need to click the Color Read button.
- **Scan loop**: Sets the number of scan iterations when taking multiple scans.
- **Auto Load Parameters**: Causes the command to automatically load the parameter settings saved by the Save Parameters feature.
- **Save Parameters**: Saves the parameter settings entered under the Camera 1 tab.
- **Load Parameters**: Loads the parameter settings saved by the Save Parameters feature.

**Hardware Tab**

- **Auto SCSI ID**: Check this item if you want the program to automatically check SCSI connections for VIVID units. If this item is not checked, the program will recognize VIVID units at specified SCSI IDs only.
File Menu

<table>
<thead>
<tr>
<th>Parameters for [File-Import-Digitizer-One Scan] (When VIVID 900/910 is Selected) Dialog Box</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Vertical</strong></td>
</tr>
<tr>
<td><strong>Horizontal</strong></td>
</tr>
<tr>
<td><strong>Apply</strong></td>
</tr>
<tr>
<td><strong>Note</strong></td>
</tr>
<tr>
<td><strong>Angle</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Parameters for [Remote-Convert] Dialog Box</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Reduction Rate</strong></td>
</tr>
<tr>
<td><strong>Fill Holes</strong></td>
</tr>
<tr>
<td><strong>Remove</strong></td>
</tr>
<tr>
<td><strong>Filter</strong></td>
</tr>
<tr>
<td><strong>Save CDM</strong></td>
</tr>
</tbody>
</table>
Performing Step Scan with the VIVID 900/910

This command is used to take two or more shots using the rotating stage via the remote control function of this software. If a rotating stage has been selected by the Turntable, rotation of the stage can also be controlled. After the necessary shots are taken, scan the calibration chart required for calibration of rotation. Data acquired from different angles will be subjected to registration, and the resulting data will appear.

**WARNING**

Never stare into the laser emitting window.
Do not place a lens, mirror or optical element in the passage of the laser beam. Doing so may converge the laser beam, resulting in damage to your eyes, burns or fire. To prevent the above accidents, make sure that a wall or similar which can block the laser beam is located behind the object.

**Memo**

- The calibration chart is an accessory of the rotating stage set.
- Before performing the procedure below, make sure that the digitizer you are going to use is selected by the File – Select Digitizer command.
- If you have connected multiple VIVID 900/910 units, you can select the unit to be used by changing the SCSI ID. Note that the software can only load memory-card data from the VIVID unit with the highest SCSI ID.

**Note**

If the rotating stage does not operate correctly from the dialog box, turn OFF the stage, turn it ON again, and then try to operate it.

For details of the File – Select Digitizer command, refer to page 99.

When Using Only the Rotating Stage

**[Operating Procedure]**

**1**
From the [File] menu, select [Import], [Digitizer] and then [Step Scan].
The [File-Import-Digitizer-Step Scan] dialog box will appear.
- The monochrome monitor image currently captured by the VIVID 900/910 will appear in the Image area of the dialog box.

**2**
Place the object on the rotating stage.

**3**
To display the object in the middle of the window, change the position of the object or move the VIVID 900/910 back and forth to change the view angle.

If necessary, replace the lens attached to the VIVID 900/910.
4 Select the desired rotation step from “90”, “60” and “Other” so that the rotating stage will rotate at the selected step.
If “Other” is selected, enter the desired rotation angle.

**Memo**
To check whether the object is scanned properly when it is rotated, click [Check scanning area].
While the rotating stage rotates at the step selected by Rotation Step, the monochrome image acquired from each angle will be displayed in the preview area.
When the rotating stage completes one turn, it will return to the home position and the check is complete.
If any problem is detected, repeat step 3.

**Memo**
The rotating stage may rotate in the opposite direction during measurement depending on its type.

5 Select the desired scan mode (Fine or Fast).

6 Set optional parameters.

**Memo**
If high measurement accuracy is required, set the distance parameter.

7 Click the [Scan] button.
Scan will start, and both color and range images will be displayed.
The [Next angle: **degree] message dialog box will also appear.

**Memo**
- In the range image, areas comprised of regular data are shown in color.
- In High Quality mode, data for which laser intensity was too high are displayed in bright gray, while data for which intensity was too low are displayed in dark gray.
- If the color and range images are not scanned at the same time, clicking the [Color Read] button or double-clicking on the image will capture a color image and display it.
- Dragging the mouse on the color image will enlarge the image. If necessary, enable color correction such as “Dark”, “Log” and “Smooth”, and load the color image again.
- If the type of rotating stage has not been designated, turn the rotating stage manually to the next angle displayed in the [Next angle] dialog box.
Click the [OK] button.
The next specified angle will appear in [Current angle], and the object will be scanned for the next image.

- If a rotating stage has been selected by the Turntable, the stage will turn to the next angle and then the object will be scanned.

- To cancel scan, click the [Cancel] button instead of the [OK] button, and repeat steps 6 to 8.

**Note**
The rotating stage may rotate in the opposite direction during measurement depending on its type.

Repeat step 8 until shots from all the desired angles are captured.
When shots from all the desired angles are captured, the [Scan the chart? The turntable will be move.] message dialog box will appear.

- If you want to acquire a shot again, click the [Cancel] button to close the dialog box, click the angle currently displayed in [Current] with the left mouse button, then select the desired angle among those which have been set from the pull-down menu that appears.

**Memo**
If an angle (rotation step) has been selected at step 4, necessary steps (angles) to complete 360 degrees will be displayed in the pull-down menu. However, it is not necessary to scan at all the angles. You can select necessary steps (angles) only.

- Click the [OK] button. The rotating stage will start to rotate toward the angle (home position) where the calibration chart is to be measured. When the rotating stage has reached that angle (home position), the “Scanning the Calibration Chart.” dialog box will appear.

Place the calibration chart on the rotating stage.
When the “Scanning the Calibration Chart.” dialog box appears, position the chart with the black line facing the VIVID, and place it on the rotating stage so that both entire side surfaces are observed in the viewfinder.

- If “Chart” is not displayed in [Current angle], click the left mouse button and select “Chart” from the pull-down menu that appears.
If it is not possible to perform calibration using calibration chart S, use calibration chart M.

11 Click the [OK] button. The calibration chart will be scanned.

**Note**
Make sure that the acquired range image looks like the good example given below. If it resembles the bad example, click the [Scan] button again to re-scan the calibration chart.

Good example

Bad example

12 Click the [Convert] button. The [Remote-Convert] dialog box will appear.

13 Enter the desired element name, and set parameters.
   - Select the desired rate from 1/1, 1/4, 1/9, 1/16 and No polygon by selecting the corresponding pull-down menu.
   - If you want to generate points to fill in holes caused by missing data, set the File Holes setting to On.
The Remove pull-down menu lets you select which points to remove from the imported data. You can set this to any of the following: “None”, “Boundary(B.)”, “5deg. & B.”, “10deg. & B.”, “15deg. & B.”, or “20deg. & B.”

If you want to filter the imported data, select the appropriate parameter from the Filter pull-down menu.

If you want to save the raw scan data (.cdm) when importing, check the “Save CDM” checkbox.

Note
The element name must consist of up to 31 alphanumeric characters.

14 Click the [OK] button.

Each scanned image will be subjected to registration and displayed, and a dialog box asking whether you want to perform fine-adjustment will appear.

The element list will also show the element name specified at step 13 plus “rotation step”. The element name is highlighted, indicating that it is currently selected.

- The loaded data will be ready to be displayed in all windows. It will be displayed in the active window and the windows for which all the elements are set to be displayed (i.e. the windows that are not set to “Selective”).
- When the data is loaded for the first time after the software is started, it will be fully framed in all the windows including those that are hidden automatically.
- If a rotating stage has been designated, the rotating stage will rotate back to the original position before data reading starts.

- If the [Save CDM] checkbox was checked at step 13, the [Remote-Save] dialog box will appear before the dialog box that asks whether you want to perform fine-adjustment.
  ① Enter the desired file name.
  ② Click the [Save] button.

Note
The file name must consist of alphanumeric characters only.

15 Click the [OK] button.

Fine-adjustment of the element position will be performed and the data will be displayed again.

- If a rotating stage has been selected by the Turntable, the stage will turn to the next angle and then the object will be scanned.
- If you are not going to perform fine-adjustment, click the [Cancel] button instead of the [OK] button.

Memo
Fine-adjustment can be cancelled even if it has started, by clicking the [Cancel] button in the dialog box that appears during fine-adjustment.
When Using the Bench Top Frame Set

Memo
The VIVID 900/910 can be mounted on the bench top frame set vertically or horizontally. For the mounting method, refer to the instruction manual of the frame set. Saving the calibration chart data helps you reduce work time when scanning different objects under the same conditions.

[Operating Procedure]

1. From the [File] menu, select [Import], [Digitizer] and then [Step Scan]. The [File-Import-Digitizer-Step Scan] dialog box will appear.
   - The monochrome monitor image currently captured by the VIVID 900/910 will appear in the Image area of the dialog box.

2. Select the desired installation direction of the VIVID 900/910.
   - From the [Hardware] tab, check the [Bench Top Frame set] checkbox, and select the VIVID 900/910 installation direction by clicking the corresponding [Mounted] radio button.
   - Select [Vertical] if the VIVID 900/910 is mounted vertically, or select [Horizontal] if it is mounted horizontally.

Memo
If the VIVID 900/910 is mounted horizontally, the preview image will be in portrait form. After the image is converted to 3D, it will be displayed according to the coordinate system of the VIVID 900/910.

3. Place the object on the rotating stage.

Memo
If the VIVID 900/910 is mounted on the frame set horizontally, the object will be affected by repeated reflection on the rotating stage surface, preventing correct scan operation. To prevent this, place an appropriate item of the following thickness under the object to raise it.

<table>
<thead>
<tr>
<th>Measurement Distance</th>
<th>Thickness of Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>600 mm</td>
<td>Approx. 30 mm</td>
</tr>
<tr>
<td>1000 mm</td>
<td>Approx. 20 mm</td>
</tr>
</tbody>
</table>

4. To display the object in the middle of the window, change the position of the object or move the instrument back and forth to change the view angle.

Memo
If necessary, replace the lens attached to the VIVID 900/910.
5 Select the desired rotation step from “90”, “60” and “Other” so that the rotating stage will rotate at the selected step. If “Other” is selected, enter the desired rotation angle.

Memo
To check whether the object is scanned properly when it is rotated, click [Check scanning area]. While the rotating stage rotates at the step selected by Rotation Step, the monochrome image acquired from each angle will be displayed in the preview area. When the rotating stage completes one turn, it will return to the home position and the check is complete. If any problem is detected, repeat step 4.

Memo
The rotating stage may rotate in the opposite direction during measurement depending on its type.

6 Select the desired scan mode (Fine or Fast).

7 Set optional parameters.

Memo
If high measurement accuracy is required, set the distance parameter.

8 Click the [Scan] button.
Scan will start, and both color and range images will be displayed. The [Next angle: ***degree] message dialog box will also appear.

- If the color and range images are not scanned at the same time, clicking the [Color Read] button or double-clicking on the image will capture a color image and display it.
- Dragging the mouse on the color image will enlarge the image. If necessary, enable color correction such as “Dark”, “Log” and “Smooth”, and load the color image again.
- If the type of rotating stage has not been designated, turn the rotating stage manually to the next angle displayed in the [Next angle] dialog box.

Memo
Step 8 and subsequent steps can be processed automatically. (For details, refer to page 70.)
9 **Click the [OK] button.**

The next specified angle will appear in [Current angle], and the object will be scanned for the next image.

- If a rotating stage has been selected by the Turntable, the stage will turn to the next angle and then the object will be scanned.

- To cancel scan, click the [Cancel] button instead of the [OK] button, and repeat steps 6 to 8.

**Note**

The rotating stage may rotate in the opposite direction during measurement depending on its type.

10 **Repeat step 9 until shots from all the desired angles are captured.**

When shots from all the desired angles are captured, the [Scan the chart? The turntable will be move.] message dialog box will appear.

If calibration chart data already exists, click the [OK] button to import it. After the data has been imported, proceed to step 13.

If you click the [Cancel] button, the stage will move to the angle that allows measurement of the calibration, and the [Please set the chart.] message dialog box will appear.

**Note**

If no chart data exists or the existing chart data does not match the measurement conditions, the following error messages will appear.

11 **Place the calibration chart on the rotating stage.**

Position the chart with the black line facing the VIVID 900/910, and place it on the rotating stage so that both entire side surfaces are observed in the viewfinder.

- If “Chart” is not displayed in [Current angle], click the left mouse button and select “Chart” from the pull-down menu that appears.

**Note**

If it is not possible to perform calibration using calibration chart S, use calibration chart M.
12 Click the [OK] button.
The calibration chart will be scanned, and the [Save the chart data?] message dialog box will appear.
To save the calibration chart data, click the [OK] button.

**Memo**
Saving the calibration chart data helps you reduce work time when scanning different objects under the same conditions.

**Note**
- If accurate data is required, it is recommended that calibration be performed each time.
- Make sure that the acquired range image looks like the good example given below. If it resembles the bad example, click the [Scan] button again to re-scan the calibration chart.

![Good example](image1)

![Bad example](image2)
13 Click the [Convert] button. The [Remote-Convert] dialog box will appear.

14 Enter the desired element name, and set parameters.
   - Select the desired rate from 1/1, 1/4, 1/9, 1/16 and No polygon by selecting the corresponding pull-down menu.
   - If you want to generate points to fill in holes caused by missing data, set the File Holes setting to On.
   - The Remove pull-down menu lets you select which points to remove from the imported data. You can set this to any of the following: “None”, “Boundary(B.)”, “5deg. & B.”, “10deg. & B.”, “15deg. & B.”, or “20deg. & B.”
   - If you want to filter the imported data, select the appropriate parameter from the Filter pull-down menu.
   - If you want to save the raw scan data (.cdm) when importing, check the “Save CDM” checkbox.

   ![Parameter-Convert](image)

   *The element name must consist of up to 31 alphanumeric characters.*

15 Click the [OK] button. Each scanned image will be subjected to registration and displayed, and a dialog box asking whether you want to perform fine-adjustment will appear. The element list will also show the element name specified at step 14 plus “rotation step”. The element name is highlighted, indicating that it is currently selected.

   - The loaded data will be ready to be displayed in all windows. It will be displayed in the active window and the windows for which all the elements are set to be displayed (i.e. the windows that are not set to “Selective”).
   - When the data is loaded for the first time after the software is started, it will be fully framed in all the windows including those that are hidden automatically.
   - If a rotating stage has been designated, the rotating stage will rotate back to the original position before data reading starts.

   - If the [Save CDM] checkbox was checked at step 14, the [Remote-Save] dialog box will appear before the dialog box that asks whether you want to perform fine-adjustment.
      1. Enter the desired file name.
      2. Click the [Save] button.

   *The file name must consist of alphanumeric characters only.*
Click the [OK] button.
Fine-adjustment of the element position will be performed and the data will be displayed again.

- If a rotating stage has been selected by the Turntable, the stage will turn to the next angle and then the object will be scanned.

- If you are not going to perform fine-adjustment, click the [Cancel] button instead of the [OK] button.

*Memo*
Fine-adjustment can be cancelled even if it has started, by clicking the [Cancel] button in the dialog box that appears during fine-adjustment.
Performing Scan Operations Automatically

If the bench top frame set is used and calibration chart data exists, a series of scan operations can be processed automatically.

**Memo**
For details of how to save the calibration chart data, refer to page 67.

[Operating Procedure]

1. **From the [File] menu, select [Import], [Digitizer] and then [Step Scan].**
   The [File-Import-Digitizer-Step Scan] dialog box will appear.
   - The monochrome monitor image currently captured by the VIVID 900/910 will appear in the Image area of the dialog box.

2. **Select the desired installation direction of the VIVID 900/910.**
   From the [Hardware] tab, check the [Bench Top Frame set] checkbox, and select the VIVID 900/910 installation direction by clicking the corresponding [Mounted] radio button.
   Check the [Auto Scan] checkbox under the Hardware tab.
   Select [Vertical] if the VIVID 900/910 is mounted vertically, or select [Horizontal] if it is mounted horizontally.
   **Memo**
   If the VIVID 900/910 is mounted horizontally, the preview image will be in portrait form.
   After the image is converted to 3D, it will be displayed according to the coordinate system of the VIVID 900/910.

3. **Place the object on the rotating stage.**
   **Memo**
   If the VIVID 900/910 is mounted on the frame set horizontally, the object will be affected by repeated reflection on the rotating stage surface, preventing correct scan operation. To prevent this, place an appropriate item of the following thickness under the object to raise it.

<table>
<thead>
<tr>
<th>Measurement Distance</th>
<th>Thickness of Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>600 mm</td>
<td>Approx. 30 mm</td>
</tr>
<tr>
<td>1000 mm</td>
<td>Approx. 20 mm</td>
</tr>
</tbody>
</table>

4. **To display the object in the middle of the window, change the position of the object or move the rotating stage back and forth to change the view angle.**
   **Memo**
   If necessary, replace the lens attached to the VIVID 900/910.
5. Select the desired rotation step from “90”, “60” and “Other” so that the rotating stage will rotate at the selected step. If “Other” is selected, enter the desired rotation angle.

**Memo**
To check whether the object is scanned properly when it is rotated, click [Check scanning area]. While the rotating stage rotates at the step selected by Rotation Step, the monochrome image acquired from each angle will be displayed in the preview area. When the rotating stage completes one turn, it will return to the home position and the check is complete.

If any problem is detected, repeat step 4.

**Note**
The rotating stage may rotate in the opposite direction during measurement depending on its type.

6. Select the desired scan mode (Fine or Fast).

7. Set optional parameters.
   - Check the Convert checkbox of “Scan & Functions” item.

   **Note**
   If high measurement accuracy is required, set the distance parameter.

8. Click the [Go] button.

   **Note**
   If no chart data exists or the existing chart data does not match the measurement conditions, the following error messages will appear.
9 Enter the desired element name, and set parameters.

- Select the desired rate from 1/1, 1/4, 1/9, 1/16 and No polygon by selecting the corresponding pull-down menu.

- If you want to generate points to fill in holes caused by missing data, set the File Holes setting to On.

- The Remove pull-down menu lets you select which points to remove from the imported data. You can set this to any of the following: “None”, “Boundary(B.)”, “5deg. & B.”, “10deg. & B.”, “15deg. & B.”, or “20deg. & B.”

- If you want to filter the imported data, select the appropriate parameter from the Filter pull-down menu.

- If you want to save the raw scan data (.cdm) when importing, check the “Save CDM” check-box.

**Note**
The element name must consist of up to 31 alphanumeric characters.

10 Click the [OK] button.

A dialog box will appear, allowing you to enter the desired element name.

The element list will also show the element name specified at step 9 plus “rotation step”. The element name is highlighted, indicating that it is currently selected.

- The loaded data will be ready to be displayed in all windows. It will be displayed in the active window and the windows for which all the elements are set to be displayed (i.e. the windows that are not set to “Selective”).

- When the data is loaded for the first time after the software is started, it will be fully framed in all the windows including those that are hidden automatically.

- If a rotating stage has been designated, the rotating stage will rotate back to the original position before data reading starts.

- If the [Save CDM] checkbox was checked at step 9, the [Remote-Save] dialog box will appear before the dialog box that asks whether you want to perform fine-adjustment.

1. Enter the desired file name.
2. Click the [Save] button.

**Note**
The file name must consist of alphanumeric characters only.
11 Click the [OK] button.
The object will be scanned sequentially at the step selected by Rotation Step. Registration of the scanned images will be performed using the saved chart data to convert them to 3D data, and the result will be displayed.

- If you are not going to perform fine-adjustment, click the [Cancel] button instead of the [OK] button.

**Note**
The rotating stage may rotate in the opposite direction during measurement depending on its type.
File Menu

<table>
<thead>
<tr>
<th>Parameters for [File-Import-Digitizer-Step Scan] (When VIVID 900/910 is selected) Dialog Box</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Common Area</strong></td>
</tr>
<tr>
<td>AF</td>
</tr>
<tr>
<td>Mono</td>
</tr>
<tr>
<td>Color</td>
</tr>
<tr>
<td>Distance</td>
</tr>
<tr>
<td>Intensity</td>
</tr>
<tr>
<td>LD</td>
</tr>
<tr>
<td>Gain</td>
</tr>
<tr>
<td>Focus Lock</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>General Tab</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scan (Auto Scan)</td>
</tr>
<tr>
<td>Color Read</td>
</tr>
<tr>
<td>Convert</td>
</tr>
<tr>
<td>Export</td>
</tr>
<tr>
<td>Go</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Camera 1 Tab</th>
</tr>
</thead>
<tbody>
<tr>
<td>Log</td>
</tr>
<tr>
<td>Smooth</td>
</tr>
<tr>
<td>Dark</td>
</tr>
<tr>
<td>Color Level</td>
</tr>
<tr>
<td>Threshold</td>
</tr>
<tr>
<td>Fine/Fast</td>
</tr>
<tr>
<td>Dynamic Range Expansion Mode</td>
</tr>
<tr>
<td>High Quality Mode</td>
</tr>
<tr>
<td>Use Texture</td>
</tr>
<tr>
<td>Note</td>
</tr>
<tr>
<td>Auto read</td>
</tr>
<tr>
<td>Auto Load Parameters</td>
</tr>
<tr>
<td>Save Parameters</td>
</tr>
<tr>
<td>Load Parameters</td>
</tr>
</tbody>
</table>
File Menu

Parameters for [File-Import-Digitizer-Step Scan] (When VIVID 900/910 is selected) Dialog Box

<table>
<thead>
<tr>
<th>Hardware Tab</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Auto SCSI ID</strong></td>
</tr>
<tr>
<td><strong>Vertical</strong></td>
</tr>
<tr>
<td><strong>Horizontal</strong></td>
</tr>
<tr>
<td><strong>Apply</strong></td>
</tr>
<tr>
<td><strong>Rotation Step</strong></td>
</tr>
<tr>
<td><strong>Current angle</strong></td>
</tr>
<tr>
<td><strong>Check Scanning area</strong></td>
</tr>
<tr>
<td><strong>Bench Top Frame Set</strong></td>
</tr>
<tr>
<td><strong>Auto Scan</strong></td>
</tr>
<tr>
<td><strong>Chart File Data</strong></td>
</tr>
</tbody>
</table>

Parameters for [Remote-Convert] Dialog Box

| **Reduction Rate** | Selects the reduction rate to be applied when importing the data. You can select any of the following: “1/1”, “1/4”, “1/9”, “1/16”, or “No polygon” |
| **Fill Holes** | Selects whether the programs fill in holes when importing the data. If the setting is On, the program will automatically generate points to fill in holes left by missing data. |
| **Remove** | Selects which data the program excludes when carrying out the import. Select from an of the following: “None”, “Boundary (B.)”, “5deg. & B.”, “10deg. & B.”, “15deg. & B.”, or “20deg. & B.” None: Removal is not carried out when importing the data. Boundary(B.): The program removes boundary points. 5deg. & B.,10deg. & B., 15deg. & B., 20deg. & B.: The program removes boundary points, and also removes polygons within the specified angular range (5°, 10°, 15°, or 20°) to the view vector |
| **Filter** | None: The program does not perform filtering when importing the data. Noise Filter (N.F.): When importing the data, the points that appear to be noise will be corrected according to other data. High Quality (H.Q.): The program filters out unreliable data. (Effective only when importing data that was scanned using the VIVID 910.) H.Q & N.F.: Applies both noise filter and high quality filter. (Effective only when importing data that was scanned using the VIVID 910.) |
| **Save CDM** | Save the images as camera data. |
File – Import – Digitizer – PC Card (When VIVID 900/910 is Selected)

Importing Data from the Memory Card of VIVID 900/910

This command is used to remote-control the data stored in the memory card of the VIVID 900/910 (VI-900/910).

Before performing the procedure below, make sure that the digitizer you are going to use is selected by the File – Select Digitizer command.

Note that if multiple VIVID 900/910 units are connected, the software can only access the memory card in the VIVID unit with the highest SCSI ID setting.

For details of the File – Select Digitizer command, refer to page 99.

This command does not operate on step-shot scan data in the memory card.

[Operating Procedure]

1. From the [File] menu, select [Import], [Digitizer] and then [PC Card].
   
   Only the raw image data (.cdm) scanned by the instrument will be displayed.
   
   Upper-case file names specified using the camera will be converted to lower-case file names when the files are imported to this software.

2. Select the file you want to import.
   
   To perform dark correction for the color data, check the [Dark Correction] checkbox.
   
   To display the preview image, check the [Preview] checkbox (so that a check mark appears in the check box). A color image of the selected file will be displayed.
   
   A clock icon will be displayed during loading.

Parameters for [File-Import-Digitizer-PC Card] Dialog Box

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File name</td>
<td>Displays file names stored in the memory card.</td>
</tr>
<tr>
<td>Date</td>
<td>Displays the dates on which the files are stored in the memory card.</td>
</tr>
<tr>
<td>Size</td>
<td>Displays the size of each file (in bytes).</td>
</tr>
<tr>
<td>Total ** files</td>
<td>Displays the total number of camera data files stored in the memory card.</td>
</tr>
<tr>
<td>** MB/ ** MB</td>
<td>Displays the unoccupied capacity and total capacity of the memory card.</td>
</tr>
</tbody>
</table>

Sorting the Files (Sort radio button)

The [Name] and [Date] radio buttons are used to select whether file names are displayed alphabetically or by date.

[Operating Procedure]

Before starting the following procedure, make sure that the [File-Import-Digitizer-PC Card] dialog box is displayed.
1 Click the [Name] radio button to sort the files alphabetically or [Date] radio button to sort by date.

Clicking the [Name] radio button will sort the files alphabetically, and clicking the [Date] radio button will sort them by date.

When sort is complete, selection state of each file in the file list and preview image will be cleared.

### Updating the File List ([Update] button)

The [Update] button is used to load the file names from the memory card to this software and update the file list. If the memory card is replaced while the [File-Import-Digitizer-PC Card] dialog box is open, be sure to click this button to update the file list.

#### [Operating Procedure]

Before starting the following procedure, make sure that the [File-Import-Digitizer-PC Card] dialog box is displayed.

1 Click the [Update] button.

All the file names in the memory card will be loaded to the software and a new file list will be displayed.

### Loading the Selected Data ([Load] button)

The [Load] button is used to load the data of the selected file from the memory card to the software.

#### [Operating Procedure]

Before starting the following procedure, make sure that the [File-Import-Digitizer-PC Card] dialog box is displayed.

1 From the file list, select the name of the file you want to load.

2 Click the [Load] button.

A dialog box will appear, allowing you to enter the desired element name.

The file name in the memory card will be displayed as an element name.

3 Change the element name if necessary, and set the parameters.

   - Select the desired rate from 1/1, 1/4, 1/9, 1/16 and No polygon by selecting the corresponding pull-down menu.

   - If you want to program to generate points to fill in holes caused by missing data, set the File Holes setting to On.

   - Use the Remove pull-down menu to select which points to remove from the imported data.

     You can set this to any of the following: “None”, “Boundary(B.)”, “5deg. & B.”, “10deg. & B.”, “15deg. & B.”, or “20deg. & B.”

   - If you want to filter the imported data, select the appropriate parameter from the Filter pull-down menu.
4 Click the [Load] button.
The data of the selected file will be loaded and displayed in the view window. The names of the imported elements will also appear in the element list, indicating that the elements have been selected (highlighted).

- The loaded data will be ready to be displayed in all windows. It will be displayed in the active window and the windows for which all the elements are set to be displayed.
- When the data is loaded for the first time after the software is started, it will be fully framed in all the windows including those that are hidden.

**Memo**
A clock icon will be displayed during loading.

### Parameters for [File-Import-Digitizer-PC Card-Load] Dialog Box

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Element name</td>
<td>Enter the desired element name.</td>
</tr>
<tr>
<td>Reduction Rate</td>
<td>Selects the reduction rate to be applied when importing the data. You can select any of the following: “1/1”, “1/4”, “1/9”, “1/16”, or “No polygon”.</td>
</tr>
<tr>
<td>Fill Holes</td>
<td>Selects whether the program fills in holes when importing the data. If the setting is On, the program will automatically generate points to fill in holes left by missing data.</td>
</tr>
</tbody>
</table>
| Remove         | Selects which data the program excludes when carrying out the import. Select from an of the following: “None”, “Boundary (B.)”, “10deg. & B.”, “15deg. & B.”, or “20deg. & B.”.  
None: Removal is not carried out when importing the data.  
Boundary(B.): The program removes boundary points.  
5deg. & B.,10deg. & B., 15deg. & B., 20deg. & B.: The program removes boundary points, and also removes polygons within the specified angular range (5°, 10°, 15°, or 20°) to the view vector. |
| Filter         | Selects whether the program filters when importing the data.  
None: The program does not perform filtering when importing the data.  
Noise Filter (N.F.): When importing the data, the points that appear to be noise will be corrected according to other data.  
High Quality (H.Q.): The program filters out unreliable data. (Effective only when importing data that was scanned using the VIVID 910.)  
H.Q & N.F.: Applies both noise filter and high quality filter. (Effective only when importing data that was scanned using the VIVID 910.) |

### Deleting the Selected File ([Delete] button)
The [Delete] button is used to delete the selected file from the memory card.

**[Operating Procedure]**
Before starting the following procedure, make sure that the [File-Import-Digitizer-PC Card] dialog box is displayed.

1 **From the file list, select the name of the file you want to delete.**

2 **Click the [Delete] button.**
A message dialog box will appear.

3 **Click the [Delete] button.**
The file will be deleted.
Deleting All the Files ([Delete All] button)
The [Delete All] button is used to delete all the files from the memory card.

[Operating Procedure]
Before starting the following procedure, make sure that the [File-Import-Digitizer-PC Card] dialog box is displayed.

1. Click the [Delete All] button.
   A message dialog box will appear.

2. Click the [Delete All] button.
   All the files in the memory card will be deleted.
   
   **Note**
   All the files in the memory card will be deleted, irrespective of whether or not they are currently selected in the file list.

Saving the Selected File ([Copy] button)
The [Copy] button is used to copy the selected file from the memory card and save it as camera data.

[Operating Procedure]
Before starting the following procedure, make sure that the [File-Import-Digitizer-PC Card] dialog box is displayed.

1. From the file list, select the name of the file you want to save.

2. Click the [Copy] button.
   The [PC Card-Copy] dialog box will appear.
   The copy destination directory and names of the files present in that directory will be displayed.

3. Change the directory and file name if necessary.
   
   **Note**
   The file name must consist of alphanumeric characters only.

4. Click the [Copy] button.
   All the files will be saved as camera data.
File Menu

Saving All the Files ([Copy All] button)

The [Copy All] button is used to copy the data of all the files from the memory card and save them as camera data.

[Operating Procedure]

Before starting the following procedure, make sure that the [File-Import-Digitizer-PC Card] dialog box is displayed.

1. **Click the [Copy All] button.**
   The [File-Import-Digitizer-PC Card-Copy All] dialog box will appear.
   The copy destination directory will be displayed.

2. **Change the directory if necessary.**

3. **Click the [Copy All] button.**
   All the files will be saved as camera data.
   - If a file(s) having the same name exists, a message dialog box will appear.
     ①Select [Overwrite], [Overwrite All], [Skip] or [Cancel].
     • Clicking the [Overwrite] button will overwrite the file which is currently displayed in the message dialog box.
     • Clicking the [Overwrite All] button will overwrite the file which is currently displayed in the message dialog box as well as all the remaining files having the same names at once. The message dialog box will not be displayed for those remaining files.
     • Clicking the [Skip] button will ignore the file displayed in the dialog box and proceed to the next file on the file list.
     • Clicking the [Cancel] button will close the dialog box without saving the files displayed in the dialog box.
Changing the Selected File Name ([Rename] button)

The [Rename] button is used to change the name of the file selected from the memory card.

[Operating Procedure]

Before starting the following procedure, make sure that the [File-Import-Digitizer-PC Card] dialog box is displayed.

1. From the file list, select the name of the file you want to save.


3. Enter the new name and click the [Rename] button. The file name will be changed.

Note

Names of the files stored in the memory card must consist of up to eight characters. Only alphabets, numerical numbers, bars “-” and underbars “_” can be used. Lower-case characters contained in file names will be converted to upper-case characters.
Aligning Multiple Scans

This program allows you to take and align multiple shots (multiple scans) of a single object using a VIVID 910. You use the program to remotely control the scans, and you attach markers onto the object so that the program can correlate the data taken from multiple shots (at multiple angles). The program aligns the data based on the markers, and displays the result.

**Memo**
- This command works only with the VIVID 910.
- To use all function of this command, connecting to VIVID 910 and the license will be required.
- Prior preparation (calibration) is required for the marker to be automatically recognized.

For details about the Automatic Marker Recognition, refer to page 86.

**[Operating Procedure]**

1. From the [File] menu, select [Import] – [Digitizer] and click [Easy Align].

   The program opens the [File-Import-Digitizer-Easy Align] dialog and a temporary window.
   
   - If a VIVID 910 is connected, the program displays a monochrome monitor image.

   The very first time you use this command (with the VIVID 910 connected), the command begins by displaying the “License Failure” dialog.

   **Memo**
   If the VIVID 910 is not connected when you first execute this command, the “License Failure” dialog will not appear and the program will not check for a license. You can continue directly from step 2 below.

   ① Click the [OK] button.


   ② At the dialog, enter the license code that corresponds to the displayed VIVID 910 serial number, and then click [OK].

   **Note**
   If you do not enter the correct licence code, the [Convert] button will not be enabled. This means that you will not be able to make use of the aligned data.
2 Adhere markers onto the object.

Note that some objects have delicate surfaces that may be damaged when markers are peeled off after use. In particular, the markers we provide have fairly strong adhesive and will become difficult to peel off if left attached for more than 24 hours.

3 Adjust the position of the object and move the VIVID 910 forward or back so that the object appears at the center of the display at the appropriate view angle.

4 Click the [Scan Mode] tab, and set the scan mode to either Fine or Fast.

5 If you are using a turntable, click the [Turntable] tab and set the serial port, the rotating stage type, and the rotation angle.

6 Set other parameters as necessary.

7 Click the [Scan] button.

The program takes the scan and displays the resulting color image in the work window on the left of the dialog. It also automatically detects the markers, and displays a single character (0 to 9 or A to Y) for each “marker ID” (0 to 34) in each location at which a marker was detected. If the program determines that the scanned data is good enough for alignment processing, the condition bar (under the work window) becomes blue and displays the “Good condition” message. If the program determines that the scan results are not good enough for alignment, the condition bar turns red and displays “No good”.

On the color image, areas that have no distance data are displayed as black.

- When [Auto Marker Detection] checkbox is unchecked, the automatic marker detection will not be carried out.
- As an alternative to taking the scan at this time, you can import a saved scan (CDM file) that was previously taken with the VIVID 910. Just click the [Import] button and load the appropriate file.
If necessary, adjust the marker correspondences.

- If any of the detected marker IDs does not match the corresponding marker on the actual object, correct as follows: right-click the marker ID on the image, and then enter the correct marker ID at the dialog that opens.

- If any of the marker IDs displayed on the previously stored image (the image stored at step 9 below) does not match the corresponding marker ID displayed on the image scanned at step 7 above, correct as follows: Left-click the mismatched ID in either of these two images, and then left-click on the correct corresponding marker ID in the other image. The program will change the IDs so that they are identical.

- To set up a “new” marker ID on images from Step 7 on Step 9 in a location where there was no physical marker on the object (or where the program failed to detect a marker), left-click the corresponding points in the two images. The program will display a marker ID of “#” at these points.

Note

If the condition bar (under the work window) is red, this means that the data is not yet suitable for alignment. Adjust the marker correspondences and take other steps as necessary until the bar becomes blue.

Click the [Store] button.

The data displayed in the work window moves over into the store window on the right side of the dialog. Marker detection results are indicated in the condition bar. The temporary window shows a preliminary converted image (“pre-converted” image) of all of the stored data.

Repeat steps 7 to 9 as necessary to scan at all desired angles.

- You can use the [<<Prev] button or [Next>>] button to move through the stored-data displays.

- You can use the [Delete] button to delete unnecessary stored data.

- You can use the [View] button to move through the data display or hiding in the temporary window.

If you have adjusted the marker correspondences, click the [Pre-Convert] button.

The image displayed in the store window is realigned based on the change in the marker correspondence, and the result appears in the temporary window.

Click the [Convert] button.

The program opens the [File-Import-Digitizer-Easy Align-Convert] dialog.

- If you did not enter a valid license code at Step 1 above, the [Convert] button will not appear.

Enter an element name and set the element parameters.

- Select the data resolution from the Reduction Rate drop-down list. Choices are: “1/1”, “1/4”, “1/9”, “1/16”, or “No polygon”.

- If you want the program to fill-in lost data areas when loading the data, set Fill Holes to “On”.

8

File Menu
At the Remove drop-down list, select the data to be excluded at time of loading. Choices are: “None”, “Boundary (B.)”, “5deg.& B.”, “10deg.& B.”, “15deg.& B.”, and “20deg.& B.”

If you want to filter the data when loading it, make the appropriate selection at the Filter drop-down list.

If you want to apply 3D processing to the marker sections, make the appropriate selection at the Marker Correction drop-down list.

If you want to use texturing, check the Use Texture box.

If you want to save the data at the time of conversion, check the Save Data box.

**Note**
Enter an element name of up to 31 alphanumeric characters.

14 Click the [OK] button.
The temporary window (the window that was showing the pre-converted image) closes. The program converts the data that was displayed in the store window, and displays the resulting aligned data.

The loaded data will be ready for display in all windows. It will be shown in the active window and in those windows for which all elements are set to be displayed (i.e., in those windows that are not set to “Selective”).

The first time the program loads data after starting up, it will be fully framed in all windows (including those that are hidden automatically).

If you are using the rotating stage, the stage now rotates back to its origin.

For elements that existed prior to execution of this command, the selection status and display states remain unchanged.

If you checked Save Data (at Step 13 above), the program opens the [Easy Align-Save] dialog (shown at right).

1. Enter a filename for the saved file.
2. Click the [Save] button.

**Note**
The filename must be alphanumeric characters only.

---

**Calibration to Facilitate Automatic Marker Recognition**

In the Easy Align, position alignment is carried out based on the marker information gotten from the markers affixed to the object to be measured. The program identifies markers by color patterns. Under some scan lighting conditions, however, the program is unable to distinguish the markers correctly. Accordingly, adjustment is necessary to carry out by implementing calibration of the White Balance adjustment and Color Chart under the same lighting conditions as those used for the actual scan in order to get stable and correct marker information, as you will use for scanning the marked object.

The calibration procedure described below generates the reference file. Once the file has been created, the program will use it as reference when detecting markers from the scanned images.

**Memo**
In performing calibration, always be sure to attach the same lens that will be used during the actual scan of the object to be measured.
VIVID 910 White Balance Adjustment

Because the Easy Align command must automatically detect the markers adhered to the scanned object, lighting conditions are of critical importance. This means that it is necessary to adjust the white balance at the VIVID 910 unit before using the command, and it is important to keep the illumination conditions constant during measurements.

**Note**
The Easy Align command cannot be used if you are working near a window exposed to the midday sun, or if you are using a tungsten-color fluorescent light source.

**Memo**
The recommended light source is a daylight-colored fluorescent lamp with a brightness that is appropriate for a typical office environment (about 500 lux).

For information about how to carry out white-balance adjustment, refer to page 43, in the VIVID 910 unit’s Instruction Manual.

Color Chart Calibration

**[Operating Procedure]**

To carry out the following procedure, you must first open the [File-Import-Digitizer-Easy Align] dialog.

1. **Click the [Parameters] tab.**
   
   **Note**
The [Settings] button will not appear if [Auto Maker Detection] is unchecked.

2. **Click the [Settings] button.**
The name of the button changes to [Calibration]. It is now possible to change the color level.
Place the supplied color chart same position as the object to be scanned.
Set the lighting to the same conditions you will use when carrying out the actual scan. Set the color chart so that it is directly facing the VIVID 910 lens.

**Note**
To be sure that you scan only the chart and not anything else, check the image shown in dialog to confirm that you have placed the chart in the right place.

4 Click the [Calibration] button.
The program executes calibration. If calibration is successful, the “Calibration success.” dialog appears.
- If calibration is not successful, the “Calibration failure.” dialog appears. If this happens, click the dialog’s [OK] button, and effect the measures listed below in accordance with the content given in the dialog.
  - In the case of “Lighting is too bright.”, the light source is too strong, so decrease its intensity.
  - In the case of “Lighting is too dark.”, the light source is too dark, so increase its intensity.
  - In the case of “Chart setting is improper. or Light source is improper.”, either the Color Chart has been improperly set or the light source is unstable. Make sure that the Color Chart directly faces the VIVID 910 and that it fills the screen completely. Also check to make sure that the fluorescent light is not flickering.

5 Click the [OK] button.
The dialog closes. This completes the calibration.
### Parameters in the [File-Import-Digitizer-Easy Align] Dialog

<table>
<thead>
<tr>
<th>Area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Base Area</strong></td>
<td></td>
</tr>
<tr>
<td>Import</td>
<td>Lets you import data that was previously scanned by a VIVID 910 and saved as a CDM file. Once you have imported the data, you can proceed just as you would when working with an actual scan. Note that if you are using saved CDM data from a step-scan, the program will only import the data currently shown in the preview. The data that is not in the color image or VIVID 900 data cannot be imported.</td>
</tr>
<tr>
<td>AF</td>
<td>Executes auto-focus. To manually adjust the distance, exposure, or other settings, open the General tab and set as desired. This button is active only if the VIVID 910 is connected.</td>
</tr>
<tr>
<td>Scan</td>
<td>Executes scanning. When [Auto Marker Detection] checkbox is checked, the automatic marker detection will be carried out. When the Color Level box is unchecked at the time of automatic marker detection, the automatic switching of color levels will be carried out, and there are cases when color images are taken multiple times. This button is active only if the VIVID 910 is connected.</td>
</tr>
<tr>
<td>Color Read</td>
<td>Retakes a color shot and display the newest picture by clicking this button after scanning. This button will be enabled after scanning.</td>
</tr>
<tr>
<td>Auto</td>
<td>If the Auto box is checked, the program will automatically execute store processing on imported or scanned data that is determined to be in “good condition” (i.e., for which the condition bar appears blue). When the command starts, this checkbox is empty.</td>
</tr>
<tr>
<td>Store</td>
<td>Registers the scanned data as stored data, and pre-converts it.</td>
</tr>
<tr>
<td>View marker ID</td>
<td>Turns display of marker IDs in the work and store windows ON or OFF.</td>
</tr>
<tr>
<td>Mono/Color/Pitch</td>
<td>Changes the type of the display in the work window. If “Mono”, the window displays monochrome monitor data. (The “Mono” selection is available only if a VIVID 910 is connected.) If “Color”, the window displays color data. If “Pitch”, the window displays distance data for scanned or imported data.</td>
</tr>
<tr>
<td>Prev/Next</td>
<td>Change display to the previous or next stored data by clicking the “Prev” or “Next” button.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the stored data currently shown in the store window. If the program has pre-converted the data and is showing the result as an element in the temporary window, this element is also deleted.</td>
</tr>
<tr>
<td>Pre-Convert</td>
<td>Pre-converts and aligns the stored data, and displays the result in the temporary window.</td>
</tr>
<tr>
<td>View</td>
<td>Turns the pre-converted element display in the temporary window ON or OFF.</td>
</tr>
<tr>
<td>Convert</td>
<td>Converts all stored data in accordance with the specified parameter settings, and displays the aligned result.</td>
</tr>
<tr>
<td><strong>General Tab</strong></td>
<td></td>
</tr>
<tr>
<td>Distance</td>
<td>Checking this item sets Distance on.</td>
</tr>
<tr>
<td>Intensity</td>
<td>Checking this item sets LD and Gain on.</td>
</tr>
<tr>
<td>LD</td>
<td>Sets the intensity of the laser beam.</td>
</tr>
<tr>
<td>Gain</td>
<td>Sets the gain.</td>
</tr>
<tr>
<td>Focus Lock</td>
<td>Executes focus lock. When you select this item, the program automatically places checks in the Distance and Intensity checkboxes, and displays the current set position, the laser-beam intensity, and the gain value.</td>
</tr>
<tr>
<td><strong>Scan Mode Tab</strong></td>
<td></td>
</tr>
<tr>
<td>Fine/Fast</td>
<td>Sets the scan mode.</td>
</tr>
<tr>
<td>Dynamic Range Expansion</td>
<td>If this box is checked, the program takes multiple shot so as to expand the dynamic range and reduce data loss.</td>
</tr>
<tr>
<td>High Quality</td>
<td>If this box is checked, the program includes display of low-reliability data. On the range image, data for which laser intensity was too high appear in light gray, while data for which intensity was too low are shown in dark gray.</td>
</tr>
<tr>
<td><strong>Parameters Tab</strong></td>
<td></td>
</tr>
<tr>
<td>Auto Marker Detection</td>
<td>Check this box if using markers.</td>
</tr>
<tr>
<td>Settings</td>
<td>When you set this button On, the button’s name changes to Calibration. You can then change the color level and carry out calibration. This button appears only if Auto Marker Detection is checked.</td>
</tr>
<tr>
<td>Color Level</td>
<td>Checking this item sets the program to use color exposure level.</td>
</tr>
</tbody>
</table>
### File Menu

#### Parameters in the [File-Import-Digitizer-Easy Align] Dialog

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Calibration</strong></td>
<td>If this check box is checked, the program gets a color image and generates a reference file from it. This check box appears only if Auto Maker Detection is checked.</td>
</tr>
<tr>
<td><strong>Log</strong></td>
<td>If this check box is checked, the program applies logarithmic correction to color data. Set this feature On if you want to brighten up neutral colors. This check box appears only if Auto Maker Detection is unchecked.</td>
</tr>
<tr>
<td><strong>Smooth</strong></td>
<td>If this check box is checked, the program applies smoothing to color data. Set this feature On if illumination is low and the image is unclear. This check box appears only if Auto Maker Detection is unchecked.</td>
</tr>
<tr>
<td><strong>Dark</strong></td>
<td>If this check box is checked, the program applies dark correction to color data. Set this feature On if you are getting striation-type noise in the images. This check box appears only if Auto Maker Detection is unchecked.</td>
</tr>
</tbody>
</table>

#### Turntable Tab

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Apply</strong></td>
<td>When you click Apply after selecting the serial port and rotating stage, the Angle slidebar becomes effective and stage control is enabled.</td>
</tr>
<tr>
<td><strong>Angle</strong></td>
<td>The Angle slidebar becomes enabled when the program determines that the rotating stage is operating normally. You can use the slidebar to control the stage’s rotation.</td>
</tr>
</tbody>
</table>

#### Parameters in the [File-Import-Digitizer-Easy Align-Convert] Dialog

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Reduction Rate</strong></td>
<td>Selects the reduction rate to be applied when importing data. You can select any of the following: “1/1”, “1/4”, “1/9”, “1/16”, or “No polygon”.</td>
</tr>
<tr>
<td><strong>Fill Holes</strong></td>
<td>Selects whether the program fills in holes when importing the data. If the setting is On, the program will automatically generate points to fill in holes left by missing data.</td>
</tr>
<tr>
<td><strong>Remove</strong></td>
<td>Selects which data the program excludes when carrying out the import. Select from any of the following: “None”, “Boundary (B.)”, “5deg. &amp; B.”, “10deg &amp; B.”, “15deg &amp; B.”, or “20deg. &amp; B.”</td>
</tr>
<tr>
<td><strong>Filter</strong></td>
<td>None: The program does not perform filtering when importing the data. Noise Filter (N.F.): When importing data, the program corrects the points that appear to be noise. High Quality (H.Q.): The program filters out unreliable data. (Effective only when importing data that was scanned using the VIVID 910.) H.Q &amp; N.F.: Applies both noise filter and high quality filter. (Effective only when importing data that was scanned using the VIVID 910.)</td>
</tr>
<tr>
<td><strong>Marker Correction</strong></td>
<td>None: The program does not perform filtering the marker sections. Cut marker: The data in the marker section will be deleted and treated as a hole. Smooth marker: Smoothing will be carried out for the marker section data.</td>
</tr>
<tr>
<td><strong>Use Texture</strong></td>
<td>Check this item when using texture.</td>
</tr>
<tr>
<td><strong>Save Data</strong></td>
<td>If you check this item, the program will automatically save the data into a camera data file when carrying out conversion.</td>
</tr>
</tbody>
</table>

---

*Note: If connecting to a SKIDS-60YAW unit, select “CSG-602R (Ver.1.0)” from the menu. If connecting to a SKIDS-60YAW (Ver.2.0) unit, select “CSG-602R (Ver.2.0)”.*
**File – Export – Elements**

**Exporting Element Data as Various Formats**

This command is used to export the data of the selected elements in various data formats.

[Operating Procedure]

1. From the element list, select the elements to be exported.
   
   **Memo**
   
   It is possible to select two or more elements by clicking them while holding down the [Shift] or [Ctrl] key.

2. From the [File] menu, select [Export] and then click [Elements].
   
   
   - If two or more elements have been selected, their names will be displayed in the order they are displayed in the element list.

3. If you want to change the file name, enter a new file name.
   
   **Note**
   
   The file name must consist of alphanumeric characters only.

4. From the “File as type” pull-down menu, select the desired format.
   
   The following file types are available.
   
   - VRML1.0 (*.wrl)
   - VRML2.0 (*.wrl)
   - Softimage (*.hrs)
   - Wavefront (*.obj)
   - DXF (*.dxf)
   - ASCII (*.asc)
   - STL (ascii, binary) (*.stl)
   - MGF (*.mgf)

   - If a format (i.e. VRML1.0, VRML2.0, Softimage) that allows attachment of images is selected, the [With images] checkbox will be effective. If you want to attach images to the data, check the checkbox.
5 **Click the [Export] button.**

The first element will be exported, and a dialog box for the next element will appear.

- When all the elements are exported, the dialog box will close.
- If you click the [Cancel] button, the next element and subsequent elements will not be exported.

**Memo**

If Softimage has been selected in [Export as type] and the [Export] button is clicked, four kinds of files will be exported (*.hrc, *.mtr, *.pic, *.txt). (Only “*.hrc” files will be exported if the [With images] checkbox is not checked.)

To use exported data with Softimage, store the data files in the following directories of the Softimage database.

- “*.hrc” file → [Models] directory
- “*.mtr” file → [MATERIALS] directory
- “*.pic” file → [Pictures] directory
- “*.txt” file → [TEXTURES2D] directory

**Note**

If the element data contains two or more images, an error message will appear when the [Export] button is clicked with Softimage selected in [File as type], [With images] checked and [With Merged Image] unchecked.

<table>
<thead>
<tr>
<th>Parameters for [File-Export-Elements] Dialog Box</th>
</tr>
</thead>
<tbody>
<tr>
<td>Export in</td>
</tr>
<tr>
<td>File name</td>
</tr>
<tr>
<td>File as type</td>
</tr>
<tr>
<td>With Images</td>
</tr>
<tr>
<td>With Merged Image</td>
</tr>
</tbody>
</table>

**Texture Merging**

To merge textures and output the result when the element is exported, follow the procedure given below.

**Operating Procedure**

Before starting the following procedure, make sure that the desired file and output format have been selected in the [File-Export-Elements] dialog box.

1 **Check the [With images] and then [With Merged Image] checkbox in this order.**

**Note**

If two or more elements have been selected, it is not possible to check the [With Merged Image] checkbox (the checkbox will be ineffective).
2 **Click the [Export] button.**

The [File-Export-Elements] dialog box will close, and the dialog box shown on the right will appear instead.

- The loaded data will be ready to be displayed in all windows. It will be displayed in the active window and the windows for which all the elements are set to be displayed.
- The unselected elements which have been displayed when this command is executed will be hidden in all windows. The elements that have been hidden will be displayed when the menu is exited.
- A projection plane will be displayed in each window in such a way that it encloses the element (default projection plane: Cylindrical). The axis of the projection plane is indicated in red, the green end of the axis indicates the top side of the projection plane and the blue end indicates the bottom side. In addition, disconnections of textures are indicated by purple lines.

3 **Select the desired projection and move or rotate it.**

Dragging with the left mouse button will rotate the projection, and dragging with the left mouse button while holding down the [Shift] button will move it horizontally.

- Changing the “projection” type will cause the projection displayed inside the window to change to the selected type. The projection will be displayed so that it encloses the element.

**Note**

*It is possible to change view mode for the view window, but not to close the view window.*

4 **Set the size and background color.**

- Clicking [Background color] with the left mouse button will open a color palette, allowing you to set the desired background color.

- Width and Height must be set within the range of “0” and “10000”. An error message will appear if they are outside the range.
5 Click the [Preview] button.
All the view windows will be hidden, and the image and preview windows will appear.
- The image window shows the color image projected on the projection plane.
- The preview window shows the texture-mapped element in full frame. Dragging with the left mouse button inside the preview window rotates the camera.
- The [Preview] button in the [Merge Texture] dialog box will change to the [Preview Close] button. Buttons except [OK], [Preview Close] and [Cancel] buttons will be ineffective.
- Clicking the [Preview Close] button will close the image and preview windows and display all the view windows.
  - The [Preview Close] button will change to the [Preview] button.
  - If the image and preview windows are closed, the [Preview Close] button will change to the [Preview] button.
    - All the view windows will be displayed.

**Note**
- It is not possible to rotate/move the projection plane inside the preview window.
- Shortcut keys cannot be used while the preview window is active.
- It is not possible to change view mode for the view window.

6 Click the [OK] button.
The element containing the color image projected on the projection plane will be exported in the specified format.
- When the element has been exported, the [Merge Texture] dialog box will close.
  - If the image window and temporary window are open, they will be closed and all the view windows will open instead.
- Clicking the [Cancel] button will cancel all the operations that have been performed after the [Merge Texture] dialog box was opened.
  - If the image window and preview window are open, they will be closed and all the view windows will open instead.
File – Export – Images
Exporting Image Data as Various Formats

This command is used to export the color image data of the selected elements in various data formats.

[Operating Procedure]

1. From the element list, select the elements to be exported.
   
   **Memo**
   It is possible to select two or more elements by clicking them while holding down the [Shift] or [Ctrl] key.

2. From the [File] menu, select [Export] and then click [Images].
   
   The [File-Export-Images] dialog box will appear.
   If two or more elements have been selected, their names will be displayed in the order they are displayed in the element list.

3. If you want to change the file name, enter a new file name.
   
   **Memo**
   The file name must consist of alphanumeric characters only.

4. From the “File as type” pull-down menu, select the desired format.
   
   The following image data file types are available.
   - TIFF (*tif)
   - BMP (*bmp)
   - PPM/PGM (*ppm)
   - JPEG (*jpg)

5. Click the [Export] button.
   
   The first element will be exported, and a dialog box for the next element will appear.
   When all the elements are exported, the dialog box will close.
   If you click the [Cancel] button, the next element and subsequent elements will not be exported.

### Parameters for [File-Export-Elements] Dialog Box

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Export in</td>
<td>Displays the currently selected folder name.</td>
</tr>
<tr>
<td>File name</td>
<td>Displays the currently selected file name.</td>
</tr>
<tr>
<td>File as type</td>
<td>Displays the type of the currently selected file.</td>
</tr>
</tbody>
</table>
File – Remove Elements

Removing the Selected Element(s)

This command is used to remove element(s) selected in the element list.

Memo

The File – Remove Elements command has the same functions as the Edit – Delete – Elements command.

Memo

For details of the Edit – Delete – Elements command, refer to page 129.

[Operating Procedure]

1. From the element list, select the element to be removed.

Memo

It is possible to select two or more elements by clicking them while holding down the [Shift] or [Ctrl] key.

2. Click [Remove Elements] on the [File] menu.

A message asking you whether to delete all the selected elements will appear.

3. Click the [OK] button.

All the selected elements and their corresponding points will be removed.
**File – Preferences**

**Displaying Information for Setting Conditions**

This command is used to display information related to various settings.

**[Operating Procedure]**

1. **Click [Preferences] on the [File] menu.**
   The [File-Preferences] dialog box will appear, showing the setting conditions.

2. **Click the desired tab and make the desired setting for each parameter.**

3. **Click the [OK] button.**
   The dialog box will close and the settings made at step 2 will be saved.

   **Memo**
   Clicking the [OK] button will effectuate all the changes made in the [General] and [Attribute] tabs immediately. The settings made in the [Default Behavior] tab will be saved, and will be effective when this software is started next time.

   **Note**
   *If the Undo number is reduced, the old information corresponding to the amount of reduction will be deleted and cannot be restored.*
To set a color, click the color button and select the desired color from the dialog box that appears. Point and line sizes must be set numerically.

- The selected and unselected colors will be hidden if the size of “Selected Color” and “Unselected Color” for Vertex is set to “0”, respectively.
- If you set the wireframe line width to “0”, the display will show points only-and if you are using LOD at the same time, then no data at all will appear. If setting the line width to “0”, therefore, please also sure to set the “Use LOD” setting to “Off”.

### Parameters for [Attribute] Tab of [File-Preference] Dialog Box

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Wireframe</strong></td>
<td></td>
</tr>
<tr>
<td>Selected</td>
<td>Used to set the wireframe color of the currently selected elements. Pink</td>
</tr>
<tr>
<td>Unselected</td>
<td>Used to set the wireframe color of the currently unselected elements. Dark gray</td>
</tr>
<tr>
<td>Line width</td>
<td>Used to set the wireframe line width (0–10). 1</td>
</tr>
<tr>
<td><strong>Shading</strong></td>
<td></td>
</tr>
<tr>
<td>Selected</td>
<td>Used to set the shading color of the currently selected elements. Dark green</td>
</tr>
<tr>
<td>But note that if you have checked the [Auto] checkbox, the program will automatically set the shading color for each element using a prearranged color scheme.</td>
<td></td>
</tr>
<tr>
<td>Unselected</td>
<td>Used to set the shading color of the currently unselected elements. Dark gray</td>
</tr>
<tr>
<td><strong>Vertex</strong></td>
<td></td>
</tr>
<tr>
<td>Selected</td>
<td>Used to set the color and size of the currently selected points. Red, Size: 2</td>
</tr>
<tr>
<td>Unselected</td>
<td>Used to set the color and size of the currently unselected points. Blue, Size: 2</td>
</tr>
<tr>
<td>Auxiliary</td>
<td>Used to set the color and size of auxiliary points White, Size: 2</td>
</tr>
<tr>
<td><strong>Normal</strong></td>
<td></td>
</tr>
<tr>
<td>Color</td>
<td>Used to set the color and size of the normal. Green Size: 10</td>
</tr>
<tr>
<td><strong>Window</strong></td>
<td></td>
</tr>
<tr>
<td>Background Color</td>
<td>Used to set the window’s background color.</td>
</tr>
</tbody>
</table>

### Parameters for [Default Behavior] Tab of [File-Preference] Dialog Box

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Simplify unselected elements</strong></td>
<td>Selects whether the program displays unselected elements in simplified form (On) or in detailed form (Off). On</td>
</tr>
<tr>
<td><strong>Move input elements to origin</strong></td>
<td>Effective when loading camera data. If the setting is On, the program moves input elements to the origin. If the setting is Off, the program displays the elements at their original input coordinates. Off</td>
</tr>
<tr>
<td><strong>Select points of input elements</strong></td>
<td>If this setting is On, the program sets the all input elements into selected state when loading the data. Off</td>
</tr>
<tr>
<td><strong>Use CAD views as initial windows</strong></td>
<td>Selects the window display mode used when the program starts up. If this setting is On, the program starts up using CAD views. If this setting is Off, the program starts up using single-window (isometric) view. On</td>
</tr>
<tr>
<td><strong>Show points</strong></td>
<td>Sets display of points to On or Off. Off</td>
</tr>
<tr>
<td><strong>Show normals</strong></td>
<td>Sets display of normals to On or Off. Off</td>
</tr>
</tbody>
</table>
## File Menu

<table>
<thead>
<tr>
<th>Parameters for [Default Behavior] Tab of [File-Preference] Dialog Box</th>
<th>Default Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show axis</td>
<td>Sets axis display to On or Off.</td>
</tr>
<tr>
<td>Flat shading</td>
<td>Selects the shading condition, flat shading (On) or smooth shading (Off).</td>
</tr>
<tr>
<td>Rendering mode</td>
<td>Sets the default rendering mode.</td>
</tr>
<tr>
<td>Use LOD</td>
<td>Selects whether the program shows simplified display (On) or detailed display (Off) during editing of elements. Also sets the level between 1 and 100%.</td>
</tr>
</tbody>
</table>
File – Select Digitizer

Selecting a Digitizer

This command is used to select the VIVID connected to the computer from the digitizer list.

[Operating Procedure]

1. Click [Select Digitizer] on the [File] menu.
   The [File-Select Digitizer] dialog box will appear, showing the currently selected digitizer.
   
   **Memo**
   After installed this software, the dialog box shows “None” until selecting the [File-Select Digitizer] command.

2. Select the digitizer you want to use, and click the [OK] button.
   The selected digitizer can be controlled via the menus that appear when File – Import – Digitizer is selected.
   
   **Memo**
   If a digitizer has already been selected and you switch it to another digitizer, the new digitizer will be usable when this software is started next time.
Exiting the Polygon Editing Tool

This command is used to exit the Polygon Editing Tool.

[Operating Procedure]

   The software will be exited.

   • If modifications have been made to an element after it has been imported or saved, the “Some elements are modified. Do you want to save them?” message dialog box will appear.
   • To save the element data, click the [Yes] button.
   • Clicking the [No] button will exit the software without saving the element data.

   For details of how to save elements, refer to the File – Save – Elements command (page 26).
View Menu

Orbit ................................................................. 102
Zoom .............................................................. 103
Full Frame All ................................................... 104
Full Frame ........................................................ 105
Area Orbit ....................................................... 106
Area Zoom ...................................................... 107
Move Plane ..................................................... 108
Move Light ...................................................... 109
Camera Settings .............................................. 110
Image ............................................................. 111
Show Element List/Hide Element List ............... 112
Show Toolbar .................................................. 113
View – Orbit [O] (Effective while held down)

Rotating the Camera

This command is used to rotate the camera at the point of interest.

For a description of camera position and point of interest, refer to the View – Camera Settings command (page 110).

**Note**
- This command is effective only for the “Isometric” or “Perspective” element window.
- View – Orbit mode will be active when this command is selected. To cancel the View – Orbit mode, execute the View – Orbit command again. However, if you are executing this command using the shortcut key, the View – Orbit mode can be canceled by releasing the key.

**[Operating Procedure]**


2. Drag the item in an element window while holding down the left mouse button.
   - The element will rotate in the direction it is dragged. The element will rotate horizontally when dragged to right or left, and will rotate vertically when dragged up or down.
     - Dragging while holding down the middle ([Shift] + Left) button will rotate the element horizontally.
     - Dragging while holding down the right button will rotate the element vertically.
   - The element will be displayed in simple form during drag. It will be displayed in detailed form when dragging is canceled.
**View – Zoom**

**[Z] (Effective while held down)**

Enlarging/Reducing the Displayed Item

This command is used to enlarge (zoom-in) or reduce (zoom-out) the displayed item, or to move the camera to change the view angle.

For a description of camera position, refer to the View – Camera Settings command (page 110).

**Note**

View – Zoom mode will be active when this command is selected. To cancel the View – Zoom mode, execute the View – Zoom command again. However, if you are executing this command using the shortcut key, the View – Zoom mode can be canceled by releasing the key.

**[Operating Procedure]**

1. Click [Zoom] on the [View] menu.

2. Drag the item in an element window while holding down the left mouse button.

   Dragging the item upward will enlarge it (zoom-in) and dragging it downward will reduce it (zoom-out).

   - To move the camera (i.e. drag the camera), drag while holding down the right mouse button.

   **Memo**

   The element will be displayed in simple form during zoom and drag. It will be displayed in detailed form when zooming or dragging is canceled.

   Left : zoom-in, zoom-out

   Middle ([Shift] + Left) : –

   Right : Drags the camera.
View – Full Frame All  [Shift] + [F]

Displaying Data Fully in all Windows

This command is used to fully frame the data completely in each element window.

[Operating Procedure]

1. Click [Full Frame All] on the [View] menu.
   The currently displayed elements will be zoomed in so that they are fully framed in their corresponding windows.
View – Full Frame

Displaying Data Fully in Active Window

This command is used to fully frame the data displayed in the active window.

[Operating Procedure]

1. Click [Full Frame] on the [View] menu.
   The element currently displayed in the active window will be zoomed in so that it is fully framed.
**View – Area Orbit**  
**[W]** (Effective while held down)

**Rotating the Camera and Setting the Rotation Center**

Use this command to set the camera’s rotation center point, and to rotate the camera in any direction.

- **To find the camera’s current position and point-of-interest, use the View – Camera Settings command (p. 110).**

**Note**

This command is effective in element windows whose view direction is set to Isometric or Perspective.

**Legend**

<table>
<thead>
<tr>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left</td>
<td>Rotates the camera in any direction</td>
</tr>
<tr>
<td>Middle ([Shift] + Left)</td>
<td>–</td>
</tr>
<tr>
<td>Right</td>
<td>Sets the center of rotation.</td>
</tr>
</tbody>
</table>

**[Operating Procedure]**

1. **Open the [View] menu and click [Area Orbit].**

2. **Hold down the left mouse button, and drag the element (in the element window) to rotate it about its center.**
   - Dragging left or right rotates the element horizontally, while dragging up or down rotates it vertically.
   - The image rotates around the center point that you select by right-clicking on the element window.

   **Memo**
   - The program automatically switches to simplified element display while the camera is in motion. When you finish dragging, the program displays from the new camera position using the originally selected display type.

3. **Press the [ESC] key.**
   - View–Area Orbit mode will be canceled.
View – Area Zoom [X] (Effective while held down)
Enlarging/Reducing Item Enclosed by Specified Rectangle

This command is used to enlarge (zoom-in) the item enclosed by a rectangle or reduce (zoom-out) the currently displayed item so that it is displayed within the rectangle, by defining a rectangle to be used as a scale on the element window.

[Operating Procedure]

1. Click [Area Zoom] on the [View] menu.

2. Locate the mouse pointer to the start point of the desired area (rectangle), drag it, then release the mouse button at the end point.
   The rectangle to be used as a scale will be defined. Dragging while holding down the left mouse button will enlarge the item, and dragging while holding down the right button will reduce it.

3. Press the [ESC] key.
   View – Area Zoom mode will be canceled.
View – Move Plane  [A] (Effective while held down)

Setting Display Depth

This command is used to set the display depth by changing the position (Near Plane) where the target element starts to appear and the position (Far Plane) where it starts to disappear.

<table>
<thead>
<tr>
<th>Button</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left</td>
<td>Near Plane</td>
</tr>
<tr>
<td>Middle ([Shift] + Left)</td>
<td>Near Plane/Far Plane</td>
</tr>
<tr>
<td>Right</td>
<td>Far Plane</td>
</tr>
</tbody>
</table>

[Operating Procedure]

2. Click the point on the element where you want to set the display range.
   - If you click with the left mouse button, the Near Plane will be set on the point you clicked. If you click with the right mouse button, the Far Plane will be set on the point you clicked.
   - If you click with the middle mouse button ([Shift] + Left), the Near Plane/Far Plane (fixed depth) will be centered on the point you clicked.
3. To move the plane, drag it.
   - If you drag with the mouse left button pressed, the Near Plane will move. If you drag with the mouse right button pressed, the Far Plane will move.
   - If you drag with the middle mouse button ([Shift] + Left) pressed, the Near Plane/Far Plane (fixed depth) will move.
4. Press the [ESC] key.
   View-Move Plane mode will be canceled.
View – Move Light

Moving the Light

This command is used to move the light, for instance when the element is displayed in shading mode.

**Memo**
- The light is a pseudo light designed to produce a shadow when the element window is in shading mode.
- The position of the light is set relative to the point of view and line of vision of the window. By default, the light is located in the rear right quarter of the line of vision.
- One point light must be used as the light.

<table>
<thead>
<tr>
<th>Direction</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left</td>
<td>Moves the light perpendicular to the line of vision.</td>
</tr>
<tr>
<td>Middle ([Shift] + Left)</td>
<td>–</td>
</tr>
<tr>
<td>Right</td>
<td>Moves the light along the line of vision.</td>
</tr>
</tbody>
</table>

[Operating Procedure]

1. **Click [Move Light] on the [View] menu.**
   The active window will be set in shading mode.

2. **Drag the item in an element window while holding down the left mouse button.**
   The light will move on a plane perpendicular to the line of vision, causing the view of the element to change accordingly.
   
   - Dragging upward while holding down the right mouse button will move the light forward along the line of vision, and dragging downward will move the light backward along the line of vision.
   
   **Memo**
   Dragging while holding down the [Shift] key will increase the movement of the light.

3. **Press the [ESC] key.**
   View – Move Light mode will be canceled. However, the element will remain displayed in shading mode.
View – Camera Settings
Setting the Camera Parameters

This command is used to set the camera parameters.

Memo
- The camera indicator is provided to help you understand the direction in which the image displayed in “Isometric” or “Perspective” element window is taken. (The image displayed in “Isometric” or “Perspective” element window is the image of the object viewed from the camera position.)
- The point of interest indicates the direction in which the image is taken by the camera.

[Operating Procedure]

1. From the [View] menu, select [Camera] and then click [Settings].
   The [View-Camera Settings] dialog box will appear.

2. Set the camera parameters.
   ![View-Camera Settings dialog box]
   - **Note**
     If the window view is not set to Isometric or Perspective, some parameters settings are disabled. In particular, it will not be possible to set the “View angle” or to set some of the “View point” and “Interest” values, as follows.
     - If view is set to Front or Back: Only the Z parameters can be set.
     - If view is set to Top or Bottom: Only the Y parameters can be set.
     - If view is set to Right or Left: Only the X parameters can be set.
     - If view is set to Isometric, all parameters other than “View angle” can be set.
     - If view is set to Perspective, all parameters can be set.

3. Click the [Preview] button.
   The changes made to the camera parameters for the active window will be effective, and the contents of the view window will change accordingly.

4. Click the [OK] button.
   The dialog box will close and the changes made to the view window will be confirmed.

<table>
<thead>
<tr>
<th>Parameters for [View-Camera Settings] Dialog Box</th>
</tr>
</thead>
<tbody>
<tr>
<td>View point</td>
</tr>
<tr>
<td>Interest</td>
</tr>
<tr>
<td>View angle</td>
</tr>
<tr>
<td>Near plane</td>
</tr>
<tr>
<td>Far plane</td>
</tr>
</tbody>
</table>
View – Image
Displaying Color Images

This command is used to display color images of the element currently selected in the element list.

[Operating Procedure]

1. From the element list, select the desired element.

2. Click [Image] on the [View] menu.
   An image window will open and display a color image of the selected element.

   **Memo**
   If the element includes multiple color images, you can switch among color images by placing the mouse pointer over the element window, opening the pop-up menu, and selecting the Change Image command.
View – Show Element List/Hide Element List

Displaying/Hiding the Element List

This command is used to display or hide the element list.

[Operating Procedure]
When the element list is not displayed:

1. Click [Show Element List] on the [View] menu.
   The element list will be displayed.

[Operating Procedure]
When the element list is displayed:

1. Click [Hide Element List] on the [View] menu.
   The element list will be closed.
View – Show Toolbar

Displaying the Toolbar

This command is used to display the toolbar.

[Operating Procedure]

When the toolbar is not displayed:

1  Click [Show Toolbar] on the [View] menu.
   The toolbar will appear.

   *Memo*
   Nothing will happen if the toolbar is already displayed.
Select Menu

Point ................................................................. 115
Rectangle ........................................................................ 116
Bezier ............................................................................. 117
Boundary – Elements .................................................. 119
Boundary – Points ....................................................... 120
Color ............................................................................. 121
Toggle Points ............................................................ 123
Select by Elements ..................................................... 124
Unselect by Elements .................................................. 125
Select Front .............................................................. 126
Select – Point
Selecting/Unselecting a Point by Clicking the Mouse

This command is used to select or unselect the clicked point.

Memo
Selected points will be displayed in red, and unselected points will be displayed in blue.

Left : Selects one point present within the rectangle area by clicking the mouse.
Middle ([Shift] + Left) : –
Right : Unselects one point present within the rectangle area by clicking the mouse.

[Operating Procedure]

1 From the element list, select the desired element.

2 Click [Point] on the [Select] menu.
The selected element will be ready to be displayed in all windows. It will be displayed if it is not displayed in the active window or the windows for which all the elements are set to be displayed.

3 Click the desired point.
The point will be selected if it is left-clicked and unselected if it is right-clicked.

Memo
• Selected points will be displayed in red, and unselected points will be displayed in blue.
• If the Select – Select Front command is switched on (i.e. the command name is checked in the menu), the Select – Point command will operate only on points comprising polygons that are at the front and that are visible, and the mouse cursor will change to “+F”. If the Select – Select Front command is off (unchecked), the Select – Point command will operate on all points, and the mouse cursor will change to “+”.

4 Press the [ESC] key.
Select – Point mode will be canceled.
Select – Rectangle [E] (Effective while held down)
Selecting/Unselecting Points within Specified Rectangle Area

This command is used to select/unselect the points present within a rectangle area drawn using the mouse.

Selected points will be displayed in red, and unselected points will be displayed in blue.

Left : Selects all the points present within the rectangle area.
Middle ([Shift] + Left) : –
Right : Unselects all the points present within the rectangle area.

[Operating Procedure]

1. From the element list, select the desired element.
2. Click [Rectangle] on the [Select] menu.
   The selected element will be ready to be displayed in all windows. It will be displayed if it is not displayed in the active window or the windows for which all the elements are set to be displayed.
3. Locate the mouse pointer to the start point of the desired area (rectangle), press the left mouse button and drag it, then release the mouse button at the end point.
   A rectangle will be drawn as illustrated, and all the points inside the rectangle will be selected if the rectangle is drawn while the left mouse button is pressed or they will be unselected if it is drawn while the right mouse button is pressed.

   
   Press a mouse button at the start point. Drag Release the mouse button at the end point.

   • Selected points will be displayed in red, and unselected points will be displayed in blue.
   • If using the shortcut key (default is [E]), note that you must hold the key down while setting the range of points to be selected (or deselected). The shortcut key works only on visible parts of the element.
   • If the Select – Select Front command is switched on (i.e. the command name is checked in the menu), the Select – Point command will operate only on points comprising polygons that are at the front and that are visible, and the mouse cursor will change to “+F”. If the Select – Select Front command is off (unchecked), the Select – Point command will operate on all points, and the mouse cursor will change to “+”.

4. Press the [ESC] key.
   Select – Rectangle mode will be canceled.
**Select – Bezier**

**Selecting Points within Specified Bezier Curve**

This command is used to select the points present within a Bezier curve drawn using the mouse.

**Note**
- No any other commands can be executed until this command is canceled. To execute another command, press the [ESC] key to cancel the Select – Bezier mode.
- All the steps must be carried out within the same window. The size of the window (full or 1/4) must be set in advance.

**Memo**
Selected points will be displayed in red, and unselected points will be displayed in blue.

**[Operating Procedure]**

1. **From the element list, select the desired element.**

2. **Click [Bezier] on the [Select] menu.**
   - The selected element will be ready to be displayed in all windows. It will be displayed if it is not displayed in the active window or the windows for which all the elements are set to be displayed.

3. **Enclose the desired area with a Bezier curve.**
   - Clicking the left mouse button will create a control point. Dragging it will create a tangent line for the created control point. Locate the mouse to the next desired point, and click the left button to create another control point.
   - Repeat the above steps until the desired area is enclosed with a Bezier curve.

   **Memo**
   - The Bezier curve will be shown in white and the control points in yellow.
   - If the Select – Select Front command is switched on (i.e. the command name is checked in the menu), the Select – Point command will operate only on points comprising polygons that are at the front and that are visible, and the mouse cursor will change to “+F”. If the Select – Select Front command is off (unchecked), the Select – Point command will operate on all points, and the mouse cursor will change to “+”.

4. **Click the right mouse button.**
   - The Bezier curve will be closed and edit mode is activated.
Select Menu

5. To edit the Bezier curve, drag control points or tangent lines while holding down the left button.

6. Click the right or middle mouse button.
   If the right button is clicked, the Bezier curve will be confirmed, and the points present within the curve will be selected.
   If the middle button is clicked, the Bezier curve will be confirmed, and the points present within the curve will be unselected.

   Memo
   • Selected points will be displayed in red, and unselected points will be displayed in blue.
   • If the Select – Select Front command is switched on (if the command name is checked in the menu), then the Bezier selection command operates only on points comprising polygons that are at the front and that are visible.
   If the Select – Select Front command is off (unchecked), then the Bezier selection command operates on all points.

7. Press the [ESC] key.
   Select – Bezier mode will be canceled.
Select – Boundary – Elements

Selecting Only the Boundary of Holes of Element(s)

This command is used to select only the points on the boundary of holes among those comprising the selected element(s).

**Memo**

Selected points will be displayed in red, and unselected points will be displayed in blue.

**[Operating Procedure]**

1. Select the desired element(s).

2. From the [Select] menu, select [Boundary] and then click [Elements].

   Among the points comprising the currently selected element(s), the points on the boundary of holes will be selected and the other points will be unselected.
   - The selected element(s) will be ready to be displayed in all windows. It will be displayed if it is not displayed in the active window or the windows for which all the elements are set to be displayed.
Select – Boundary – Points

Selecting Only the Boundary of Holes of Points

This command is used to select only the points on the boundary of holes, among those currently selected.

Memo
Selected points will be displayed in red, and unselected points will be displayed in blue.

[Operating Procedure]

1. Select the desired element.

2. Select the desired points.

3. From the [Select] menu, select [Boundary] and then click [Points].
   Among the selected points, the points on the boundary of holes will be selected and the other points will be unselected.
   - The selected element will be ready to be displayed in all windows. It will be displayed if it is not displayed in the active window or the windows for which all the elements are set to be displayed.
**Select – Color**

**Selecting Points within Specified Homogeneous Area**

This command is used to select the points corresponding to the homogeneous areas that are selected by specifying sample color data (sample point) on the color image window.

**Memo**

Selected points will be displayed in red, and unselected points will be displayed in blue.

- **Left**: Selects the sample color data (sample points).
- **Middle ([Shift] + Left)**: Selects the sample color data to be excluded from the area enclosed by a dotted line.
- **Right**: Cancels the previous operation (Undo).

**[Operating Procedure]**

1. **Select the desired element.**

2. **Click [Color] on the [Select] menu.**
   
   The [Select-Color] dialog box will appear.
   
   The cursor will switch to a cross cursor when it is located over the color image window.
   
   - The selected element will be ready to be displayed in all windows. It will be displayed if it is not displayed in the active window or the windows for which all the elements are set to be displayed.
   - If the image window that displays a color image has not been opened, it will be displayed when this command is selected. If the color image window of an element other than the selected element is currently displayed, it will be closed.

3. **On the color image window, locate the cross cursor to the point (sample point) containing the desired color, then click the left mouse button.**

   An “×” mark will be displayed on the sample point, and the homogeneous color area around the sample point will be enclosed by a blinking dotted line. The size of the area changes according to the value set in “Color range”.

4. **While observing the selected area, adjust the Color range (1 to 100) in the [Select-Color] dialog box.**

   - The larger the color range is, the larger the enclosed area.
   - If the color range is changed after the sample point is specified, the selected area (the area enclosed by a dotted line) will change accordingly.
5 If the enclosed area contains an unwanted area, locate the cursor to the sample point of that area and click the middle mouse button ([Shift] + Left button).
The corresponding area on the color image will be excluded from the enclosed area, according to the Color range.

6 If you need another sample area, locate the cursor to another sample point, then click the left button.
A new enclosed area will be created on the color image.

- Clicking the right mouse button over an image window will cancel the selections made by clicking the left button or middle button ([Shift] + Left button), and will cause the previously selected areas to be displayed. (This will also cancel the sample points.) Only the one previous selection can be canceled. Older selections will not be canceled.

7 Click the [Apply] button.
The points corresponding to the selected areas on the color image will be selected.
- Only the points comprising front-facing surfaces will be selected.
- Points on back surfaces, points forming back-facing surfaces and isolated points that are not forming a surface will not be selected.

Memo
- Each time the [Apply] button is clicked, the previously selected areas and selection state of the points in those areas will be canceled, and the points within the currently selected areas will be selected.
- If sample areas are selected on more than two color image windows and the color image window is switched from one to another, the sample areas (i.e. areas enclosed by a dotted line) on the previous color image window will be deleted. The state of the points selected by clicking the [Apply] button on the previous color image window will be confirmed, and those selected by clicking the [Apply] button from the sample area on the new color image window will be added to the confirmed points.

8 Click the [OK] button.
Selection state of the points on the view window will be confirmed, and the dialog box will be closed.
Select – Toggle Points
Reversing Selection State of Points of Selected Element(s)

This command is used to reverse the selection state of all the points present in the currently selected element(s).

Memo
Selected points will be displayed in red, and unselected points will be displayed in blue.

[Operating Procedure]

1. Select the desired element.

2. Click [Toggle Points] on the [Select] menu.

   Selection state of all the points present in the currently selected element will be reversed.
   - The selected element will be ready to be displayed in all windows. It will be displayed if it is not displayed in the active window or the windows for which all the elements are set to be displayed.
Select – Select by Elements  

[Ctrl] + [A]

Selecting All the Points of Element(s)

This command is used to select all the points present in the currently selected element(s).

Memo
Selected points will be displayed in red, and unselected points will be displayed in blue.

[Operating Procedure]

1. Select the desired element.

2. Click [Select by Elements] on the [Select] menu.
   All the points present in the selected element will be selected.
   • The selected element will be ready to be displayed in all windows. It will be displayed if it is not displayed in the active window or the windows for which all the elements are set to be displayed.
Select – Unselect by Elements
Unselecting All the Points of Element(s)

This command is used to unselect all the points present in the currently selected element(s).

Memo
Selected points will be displayed in red, and unselected points will be displayed in blue.

[Operating Procedure]

1. Select the desired element.

2. Click [Unselect by Elements] on the [Select] menu.
   All the points present in the selected element will be unselected.
   • The selected element will be ready to be displayed in all windows. It will be displayed if it is not dis-
     played in the active window or the windows for which all the elements are set to be displayed.
Select – Select Front

Selecting Only the Points Comprising Polygons that are Both Visible and at the Front

This command is used to limit point selection to only the points that comprise visible, front-facing polygons (as determined by the current view direction of the selected element).

[Operating Procedure]

1. Click [Select Front] on the [Select] menu.
   A check mark will be placed and cleared alternately each time this command is selected. (“Select Front” is enabled when a check mark is placed, and disabled when no check mark is placed.)
   - This command determines the action of the Select – Point, Select – Rectangle and Select – Bezier commands. Specifically, if the Select – Select Front command is active (if a checkmark appears next to the command name in the menu), then the Select – Point, Select – Rectangle and Select – Bezier commands will only operate on points comprising front-facing, visible polygons. In this case, the mouse cursor will change to “+F”.
   - If no check mark is placed, all the points in the selecting area will be selected. In this case, the mouse cursor will change to “+”.

Edit Menu

Undo ............................................................... 128
Redo ..................................................................... 128
Delete – Elements ............................................. 129
Delete – Points .................................................. 130
Delete – Polygons ............................................. 131
Images ................................................................ 132
Define .................................................................. 140
Recalc LOD ....................................................... 141
**Edit – Undo**  
[Ctrl] + [Z]

**Canceling the Previous Operation**

This command is used to cancel the previous operation. This command can be performed for the number of times specified by the File – Preferences command.

**Note**

*Execution of this command may not display simplified data.*

For details of the File – Preferences command, refer to page 96.

**Operating Procedure**

1. **Click [Undo] on the [Edit] menu.**
   
The state in effect before the previous operation was performed will be restored. (In the case of a command that activates a mode, the state in effect before that command was performed will be restored.)

   **Memo**
   
The Undo function cannot be used for the following.
   - Commands in the [File] menu, except for those provided to import camera data and element data
   - Commands in the [Info], [View], [File Import Digitizer] and [Window] menus
   - Selection and display in the element list
   - Commands in pop-up menus, except for those provided to delete elements.
   - Changes to window properties
   - Selection/unselection of elements in view windows
   - Operations on image windows

**Edit – Redo**  
[Ctrl] + [Y]

**Performing the Canceled Operation**

This command is used to perform the previous operation that has been canceled by the Edit – Undo command. It is possible to repeat this command up to the state in effect before the Edit – Undo was started.

**Note**

*Execution of this command may not display simplified data.*

For details of the Edit – Undo command, refer to page 128.

**Operating Procedure**

1. **Click [Redo] on the [Edit] menu.**
   
The previous operation that has been canceled by the Edit – Undo command will be performed.

   **Memo**
   
   This command can be repeated until the state in effect before the Edit – Undo was performed is restored.
**Edit – Delete – Elements**

Deleting the Selected Elements from the Element List

This command is used to delete the element(s) selected from the element list.

**Memo**
The Edit – Delete – Elements command has the same function as the File – Remove Elements command.

**Re** For details of the File – Remove Elements command, refer to page 95.

**[Operating Procedure]**

1. **Select the element(s) you want to delete.**
   **Memo**
   It is possible to select two or more elements by clicking them while holding down the [Shift] or [Ctrl] key.

2. **From the [Edit] menu, select [Delete] and then click [Elements].**
   A message asking you whether to delete all the selected elements will appear.

3. **Click the [OK] button.**
   All the selected elements and their corresponding points will be removed.
Delete – Points

Deleting the Selected Points

This command is used to delete the point(s) selected for the currently displayed element.

**Note**
Execution of this command may not display simplified data.

**[Operating Procedure]**

1. **Select the desired element.**
   
   **Memo**
   It is possible to select two or more elements by clicking them while holding down the [Shift] or [Ctrl] key.

2. **Select the point(s) you want to delete.**

3. **From the [Edit] menu, select [Delete] and then click [Points].**
   The selected point(s) will be deleted.
   - The selected element will be ready to be displayed in all windows. It will be displayed if it is not displayed in the active window or the windows for which all the elements are set to be displayed.

   **Memo**
   If all the points of the element are deleted, the element will be deleted from the element list.
Edit – Delete – Polygons

Deleting Polygons Comprised of Selected Points

This command is used to delete the polygon(s) that are comprised of the points selected in the currently displayed element.

[Operating Procedure]

1 Select the desired element.
   *Memo*
   It is possible to select two or more elements by clicking them while holding down the [Shift] or [Ctrl] key.

2 Select the polygon(s) you want to delete.
   To select a polygon, all the constituent vertices must be selected.

3 From the [Edit] menu, select [Delete] and then click [Polygons].
   The selected polygon(s) will be deleted.
   * Memo *
   Even if a polygon is deleted, the vertices comprising that polygon will not be deleted.
   The selected element will be ready to be displayed in all windows. It will be displayed if it is not displayed in the active window or the windows for which all the elements are set to be displayed.
Edit – Images

Editing the Texture of Selected Element

This command is used to edit or output color images of the selected element.

[Operating Procedure]

1 Select the desired element.

2 From the [Edit] menu, and then click [Images].

   The [Edit-Images] dialog box will appear.
   • The selected element will be ready to be displayed in all windows. It will be displayed if it is not displayed in the active window or the windows for which all the elements are set to be displayed.
   • If image windows for displaying color images have been opened, they will be closed when this command is selected.

The Texture List will show the names of the images that belong to the selected element.

   • Clicking an image name will display its corresponding color image.

   [Note]

   An error message will appear if an element that has no images is selected. In this case, the command will not be executed.

3 Add, delete or replace textures.

4 Click the [OK] button.

   The [Edit-Images] dialog box will close, and the texture changes made at step 3 will be effected.
Adding a Texture ([ADD] button)

The [Add] button allows you to add a texture to the element.

[Operating Procedure]

Before starting the following procedure, make sure that the [Edit-Images] dialog box is displayed.

1. **Click the [Add] button.**

2. **Select the desired texture file.**
   - To display files of a certain format only, select the desired format from the “Files of type” pull-down menu.

3. **Click the [Open] button.**
   The [Texture List] and [Edit-Images-Open Image] dialog boxes will close, the data of the selected file will be loaded, then the [Point Set] dialog box will appear.
   - All the view windows will disappear (be hidden), an image window to display the color image of the loaded data and an image window to display the color image of the element will appear.

4. **On the first image window click the desired point using the left mouse button, then click the left button at its corresponding point on the second image window.**
   When the left mouse button is clicked on an image window, a marker (“×” mark) will be displayed. A red marker will be displayed for the point you are currently designating, and a black marker for those that have already been designated.

   **Note**
   - An alarm will be heard if a point that has no data is clicked in the image window showing the color image of the element, or if the left button is clicked twice or more continuously in the same window.
   - It is not possible to close image windows.

5. **Repeat step 4 until six or more pairs of corresponding points are designated.**
   The order of designating points in the first and second image windows for the first pair can differ from that for the second pair.

   **Memo**
   For satisfactory registration of the images, approximately 12 pairs of corresponding points must be designated.
6 To delete a pair of corresponding points, click either of those points with the left mouse button while holding down the [Shift] button. The pair of corresponding points will be deleted.
- Even when designating corresponding points, they can be deleted by clicking with the left mouse button while holding down the [Shift] button.
- An alarm will be heard if a point other those designated is clicked with the left mouse button while holding down the [Shift] button.

7 Click the [Preview] button.
A temporary window will appear, showing the preview image.
- The temporary window is a Perspective view, and is displayed in texture mapping mode.
- Dragging while holding down the left mouse button inside the preview window will rotate the camera.

**Note**
- An error message will appear if only five or less pairs of points have been designated.
- An error message will appear if calculation cannot be made based on the designated points.

**Memo**
If registration is not satisfactory, designate more corresponding points or delete unsatisfactory corresponding points.

8 Click the [OK] button.
A new image will be added to the element.
- All the image windows, [Point Set] dialog box and the temporary window (if it is open) will close, and the [Texture List] dialog box will appear. All the view windows will also appear. The added image will be displayed in the [Texture List] dialog box.
Replacing a Texture ([Replace] button)

The [Replace] button allows you to replace a texture with a new one.

[Operating Procedure]

Before starting the following procedure, make sure that the [Edit-Images] dialog box is displayed.

1. From the Texture List, select the desired image.

2. Click the [Replace] button.


3. Select the desired texture file.
   
   • To display files of a certain format only, select the desired format from the “File of type” pull-down menu.

4. Click the [Open] button.

   The data of the selected file will be loaded, replacing the image selected from the Texture List with the one loaded.
   
   • The [Edit-Images-Open Image] dialog box will close, and the name of that new image will be displayed in the [Texture List] dialog box.

   [Note]
   
   If the aspect ratio of the selected image differs from the aspect ratio of the image selected in the Texture list, the program will display an error message. In this case, the texture will not be replaced.
Deleting a Texture ([Delete] button)

The [Delete] button allows you to delete a texture from the element.

[Operating Procedure]
Before starting the following procedure, make sure that the [Edit-Images] dialog box is displayed.

1. From the Texture List, select the desired image.

2. Click the [Delete] button.
   A message asking you whether to delete the selected image will appear.

3. Click the [OK] button.
   The selected image will be deleted.
   - The name of the deleted image will be removed from the [Texture List] dialog box.
Exporting a Texture ([Export])

The [Export] button lets you output the selected texture in any of a variety of data formats.

[Operating Procedure]

Open the [Edit-Images] dialog box before starting the following procedure.

1. **Click on the appropriate image name in the Texture list.**

2. **Click the [Export] button.**
   The Export-Image dialog appears.

Now proceed in the same way as if using the File-Export-Images command. (For information about the File-Export-Images command, see page 95).
Changing a Texture’s Brightness ([Brightness])

Use the [Brightness] slidebar to adjust the brightness of the selected texture.

[Operating Procedure]

Open the [Edit-Images] dialog box before starting the following procedure.

1. Click on the appropriate image name in the Texture list.

2. Adjust the brightness by moving the [Brightness] slidebar.
   The brightness changes as you move the slidebar.

3. If you want to return to the original brightness, click [Reset].
   The [Reset] button resets both the brightness and contrast to their original settings.

4. When you are satisfied with the brightness, click [OK].
   The program registers the new brightness setting, and the dialog closes.
   - The program will also register your new setting if you change the name selection in the Texture list.
Changing a Texture’s Contrast ([Contrast])

Use the [Contrast] slidebar to adjust the contrast of the selected texture.

[Operating Procedure]

Open the [Edit-Images] dialog box before starting the following procedure.

1. Click on the appropriate image name in the Texture list.

2. Adjust the contrast by moving the [Contrast] slidebar.
   The contrast changes as you move the slidebar.

3. If you want to return to the original contrast, click [Reset].
   The [Reset] button resets both the brightness and contrast to their original settings.

4. When you are satisfied with the contrast, click [OK].
   The program registers the new contrast setting, and the dialog closes.
   - The program will also register your new setting if you change the name selection in the Texture list.
Edit – Define

Defining Points as a New Element

This command is used to define the points selected for the currently selected element(s) as a new element.

[Operating Procedure]

1. Select the desired element(s).

2. Select the desired points.

   The [Edit-Define] dialog box will appear.
   • The selected element(s) will be ready to be displayed in all windows. It will be displayed if it is not displayed in the active window or the windows for which all the elements are set to be displayed.

4. Enter the desired element name, and set parameters.
   - Note
   The element name must consist of up to 31 alphanumeric characters.
   • To copy the color image data of the original element, check the [Copy image(s)] checkbox.

5. Click the [OK] button.
   The selected points will be defined as an element.
   • The defined element will be displayed in the window. The name of the element will also appear in the element list, indicating that the element has been selected.
   • All the elements except for those newly defined will be hidden in all windows and cannot be selected.
Edit – Recalc LOD
Recalculating the Simplified Display Data

This command is used to recalculate the simplified display data of the element(s) selected in the element list.

**Note**
This feature is disabled if you have set “Use LOD” to “Off” in the File-Preferences dialog (Default Behavior tab).

**Memo**
The simplified display data is displayed, for example, while the camera is dragged. If recalculation is not performed, the data in effect when the element(s) was simplified lastly will be displayed. If necessary, recalculate the simplified display data after the data is edited.

**[Operating Procedure]**

1. **Select the desired element.**

2. **Click [Recalc LOD] on the [Edit] menu.**
The simplified display data of the selected element will be recalculated.

**Note**
An error message may appear if the selected element contains an excessively small number of polygons.
Build Menu

Registration – Initial – Manual ........................................................... 143
Registration – Initial – Auto ............................................................... 145
Registration – Fine – Elements .......................................................... 147
Registration – Fine – Points ............................................................... 148
Move – Points .................................................................................. 149
Move – Elements .............................................................................. 151
Move – To Origin ............................................................................... 153
Move – To X-Y-Z .............................................................................. 154
Rotate – Elements ........................................................................... 159
Merge ............................................................................................... 161
Fill Holes – Manual ......................................................................... 162
Fill Holes – Auto ............................................................................... 163
Smooth – Element ........................................................................... 165
Smooth – Points ............................................................................... 166
Subsample – Uniformly – Element .................................................... 167
Subsample – Uniformly – Points ....................................................... 168
Subsample – Adaptively – Element ................................................... 169
Subsample – Adaptively – Points ....................................................... 170
Modify – Element ............................................................................. 171
Modify – Points ............................................................................... 172
Subdivision – Element .................................................................... 173
Subdivision – Points ........................................................................ 174
Triangulate – Elements ................................................................... 175
Triangulate – Polygons .................................................................... 175
Texture Blending ............................................................................... 176
Check Polygons – Element ............................................................... 177
Check Polygons – Polygons ............................................................. 179
Performing Initial Registration of Elements Manually

This command is used to perform registration of elements by designating corresponding points.

**[Operating Procedure]**

1. **Select the two desired elements.**

2. **From the [Build] menu, select [Registration], [Initial] and then click [Manual].**
   - The selected element will be ready to be displayed in all windows. It will be displayed if it is not displayed in the active window or the windows for which all the elements are set to be displayed.

3. **Select the basis element in the dialog box, and click the [OK] button.**
   - All the currently displayed windows will be hidden, and the temporary window for each selected element will appear.
   - Each temporary window is a “Isometric” or “Perspective” view and displayed in texture mapping mode (if the element has a color image) or in shading mode (if the element has no color image). One element will be displayed in each temporary window. The elements will be fully framed.
   - It is not possible to change the view mode and rendering mode for the temporary windows.

4. **On the first window click the desired point using the left mouse button, then click the left button at the corresponding point on the second window.**
   - When the left mouse button is clicked on a window, a marker (mark) will be displayed. Different colors of markers are available, and each pair of corresponding points will have a different color.
   - Dragging a corresponding point with the left mouse button will move it.

   **Note**
   - An alarm will be heard if a point that has no data is clicked in a window or if the left button is clicked twice or more continuously in the same window.

5. **Repeat step 4 until three or more pairs of corresponding points are designated.**
   - The order of designating points in the first and second windows for the first pair can differ from that for the second pair.
6 To delete a pair of corresponding points, click either of those points with the middle button ([Shift] + Left).
   The marker will be deleted.

   **Memo**
   Even when designating corresponding points, they can be deleted by clicking with the middle button ([Shift] + Left).

   **Note**
   An alarm will be heard if a point other those designated is clicked with the middle button ([Shift] + Left).

7 After designation of corresponding points has been completed, click the right mouse button.
   The initial registration will start, and the result will be displayed in the window.
   A message dialog box asking whether the result is satisfactory will appear.

8 Click the [OK] button.
   The program executes fine registration, and opens a dialog asking whether the results are satisfactory.
   • If you click [Retry], the program will reopen the temporary windows so that you can reset the correspondences again.
   • If you click [Cancel], fine registration will be canceled and closes the menu.

9 Click the [OK] button.
   All temporary registration windows close, and the program reopens the windows that were on display when you started the command.

   **Memo**
   The “Error Average” and “Sigma” values are indicators of the correctness of the registration (the alignment).
   In general, the closer to zero they are, the more accurate alignment is.
   • To continue fine registration processing, click the [Repeat] button.
Performing Initial Registration of Elements Automatically

This command is used to automatically detect data overlap of each element to perform registration of the elements.

[Operating Procedure]

1. **Select the desired elements.**
   
   **Memo**
   It is possible to select two or more elements by clicking them while holding down the [Shift] or [Ctrl] key.

2. **Select the desired points for each selected element.**
   The selected points will be subjected to detection of overlapped data.

3. **From the [Build] menu, select [Registration], [Initial] and then click [Auto].**
   The [Build-Registration-Initial-Auto] dialog box will appear.
   - The selected element will be ready to be displayed in all windows. It will be displayed if it is not displayed in the active window or the windows for which all the elements are set to be displayed.

4. **Select the basis element in the dialog box, and click the [OK] button.**
   Initial registration will start. A bar will be displayed to indicate progress of initial registration.
   
   **Memo**
   - If registration with the selected basis element fails for any elements, a new basis element will be selected automatically from the elements whose relative positions are known.
   - If 50% or more of the element data overlap or if elements are angled at less than approximately 60 degrees, initial registration may be satisfactory. (However, it may still fail depending on the shape of the elements.)

   **Note**
   An error message will appear if the number of points selected in the elements is below a certain number.
Build Menu

The dialog box shown on the right will appear when initial registration was successful for all the elements.

The dialog box shown on the right will appear if initial registration was unsuccessful for any of the elements.
- The elements that have failed initial registration will be hidden in all windows.

5 Click the [OK] button.
The menu will be exited.
Performing Fine Registration of Elements

This command is used to perform registration of the selected elements.

[Operating Procedure]

1. **Select the desired elements.**
   
   *Memo*
   It is possible to select two or more elements by clicking them while holding down the [Shift] or [Ctrl] key.

2. **From the [Build] menu, select [Registration], [Fine] and then click [Elements].**
   
   The [Build-Registration-Fine-Elements] dialog box will appear.
   
   - The selected element will be ready to be displayed in all windows. It will be displayed if it is not displayed in the active window or the windows for which all the elements are set to be displayed.

3. **Set the base element, and then click the [OK] button.**
   
   The program executes fine registration for the selected elements, and displays a dialog asking whether results are satisfactory.

4. **Click the [OK] button.**
   
   The menu will be exited.
   
   *Memo*
   The “Error Average” and “Sigma” values are indicators of the correctness of the registration (the alignment).
   In general, the closer to zero they are, the more accurate alignment is.
   
   - To continue fine registration processing, click the [Repeat] button.
Performing Fine Registration of Selected Points

This command is used to perform fine registration of the points present in the selected elements.

[Operating Procedure]

1. Select the desired elements.
   - Memo
     - It is possible to select two or more elements by clicking them while holding down the [Shift] or [Ctrl] key.
     - Among the selected elements, the element located first in the element list will be used as the basis element for registration.

2. From each selected element, select the points to be subjected to fine registration.

3. From the [Build] menu, select [Registration], [Fine] and then click [Points].
   - Memo
     - The selected element will be ready to be displayed in all windows. It will be displayed if it is not displayed in the active window or the windows for which all the elements are set to be displayed.

4. Set the base element, and then click the [OK] button.
   - The program executes fine registration for the selected points in the selected elements. It then displays a dialog asking whether results are satisfactory.

5. Click the [OK] button.
   - The menu will be exited.
   - Memo
     - The “Error Average” and “Sigma” values are indicators of the correctness of the registration (the alignment).
     - In general, the closer to zero they are, the more accurate alignment is.
     - To continue fine registration processing, click the [Repeat] button.
Build – Move – Points [P] (Effective while held down)

Moving the Selected Points

This command is used to move the selected point(s).

**Note**

Execution of this command may not display simplified data.

- **Left** : Moves the point(s) using the mouse.
- **Middle ([Shift] + Left)** : Moves the point(s) along the major axis.
- **Right** : Moves the point(s) by entering values.

**[Operating Procedure]**

1. **Select the desired element.**

2. **Select the point(s) you want to move.**

3. **From the [Build] menu, select [Move] and then click [Points].**

   The selected element will be ready to be displayed in all windows. It will be displayed if it is not displayed in the active window or the windows for which all the elements are set to be displayed.

   - If you select all of the element’s points at Step 2 above, this command becomes equivalent to the Build – Move – Elements command.

   [Ref] For information about the Build – Move – Elements command, see page 151.

4. **Drag the points with the left mouse button.**

   The point(s) will move accordingly.

   - Dragging with the middle (or [Shift] + Left) button will move the point(s) along the major axis.

5. **Press the [ESC] key.**

   Build – Move – Points mode will be canceled.
Moving the Point(s) by Entering Values

To move the point(s) by specifying how much they must be moved, follow the procedure given below.

**Note**
If Build – Move – Points mode was activated using the shortcut key, the point(s) cannot be moved by this method.

**[Operating Procedure]**

The following steps must be carried out in Build – Move – Points mode.

1. **Click the right mouse button.**
   The [Build-Move-Points] dialog box will appear.

2. **Enter the desired amount of movement for X, Y and Z.**
   The amount can be entered for all the axes at the same time.

3. **Click the [Apply] button.**
   The selected point(s) will move according to the values entered.
   - If you change a value(s) and click the [Apply] button, the point(s) will move again according to the new value(s).
     New values will not be added to the previous values. They are absolute values from the original position.

4. **Click the [OK] button.**
   The [Build-Move-Points] dialog box will close, movement of the point(s) will be confirmed, and the Build-Move-Points mode will be canceled.
   - Clicking the [Cancel] button will cancel all the operations that have been performed since the dialog box was opened.
Build – Move – Elements [M] (Effective while held down)

Moving Element(s)

This command is used to move the selected element(s).

- **Left**: Moves the element(s) using the mouse.
- **Middle ([Shift] + Left)**: Moves the element(s) along the major axis.
- **Right**: Moves the element(s) by entering values.

**[Operating Procedure]**

1. Select the desired element(s).

2. From the [Build] menu, select [Move] and then click [Elements].
   The selected element will be ready to be displayed in all windows. It will be displayed if it is not displayed in the active window or the windows for which all the elements are set to be displayed.

3. Drag with the left mouse button.
   The element(s) will move accordingly.
   - Dragging with the middle (or [Shift] + Left) button will move the element(s) along the major axis.

   **Memo**
   The element will be displayed in simple form during drag. It will be displayed in detailed form when dragging is canceled.

4. Press the [ESC] key.
   Build – Move – Elements mode will be canceled.
Moving the Element(s) by Entering Values

To move the element(s) by specifying how much they must be moved, follow the procedure given below.

**Note**
If Build – Move – Elements mode was activated using the shortcut key, the element(s) cannot be moved by this method.

**[Operating Procedure]**
The following steps must be carried out in Build – Move – Elements mode.

1. **Click the right mouse button.**  

2. **Enter the desired amount of movement for X, Y and Z.**  
The amount can be entered for all the axes at the same time.

3. **Click the [Apply] button.**  
The selected element(s) will move according to the values entered.

   • If you change a value(s) and click the [Apply] button, the element(s) will move again according to the new value(s).  
   New values will not be added to the previous values. They are absolute values from the original position.

4. **Click the [OK] button.**  
The [Build-Move-Points] dialog box will close, movement of the point(s) will be confirmed, and the Build-Move-Points mode will be canceled.

   • Clicking the [Cancel] button will cancel all the operations that have been performed since the dialog box was opened.
**Build – Move – To Origin**

**Moving the Element(s) to the Origin**

This command is used to move the selected element(s) to the origin.

**[Operating Procedure]**

1. Select the desired element(s).

2. From the [Build] menu, select [Move] and then click [To Origin].
   The selected element(s) will move in such a way that the center of gravity of all the constituent points is located at the origin.
   - The selected element will be ready to be displayed in all windows. It will be displayed if it is not displayed in the active window or the windows for which all the elements are set to be displayed.
Build – Move – To X-Y-Z

Converting the Coordinate System of Elements

This command is used to convert the coordinate system of the currently selected element(s) to the specified coordinate system.

**Note**

When you execute this command, all screen display modes change to Show Vertex.

[Operating Procedure]

1. **Select the desired element(s).**
   
   *Note*  
   It is possible to select two or more elements by clicking them while holding down the [Shift] or [Ctrl] key.

2. **From the [Build] menu, select [Move] and then click [To X-Y-Z].**
   
   
   - The selected element(s) will be ready to be displayed in all windows. It will be displayed if it is not displayed in the active window or the windows for which all the elements are set to be displayed (i.e. the windows that are not set to “Selective”).

3. **At the pull-down menu, select the desired method for setting the new coordinate system. Then click the [OK] button.**

4. **Extract the desired face, lines and points.**
   
   - If you have selected [Point/Point/Point], extract three points in succession.
   - If [Face/Point/Point] is selected, extraction will be performed in the order of face, point and point.
   - If [Face/Point/Line] is selected, extraction will be performed in the order of face, point and line.
   - If [Face/Line/Line] is selected, extraction will be performed in the order of face, line and line.

   When all the elements are extracted, they will be displayed in the new coordinate system.
   
   And [Confirmation (for Coordinate)] dialog box will appear.

5. **Save the coordinate system.**
   
   If you selected [Point/Point/Point]:
   
   - Once you have extracted the three points, the program displays the input design values and the standard deviations of the extracted points.
   
   - Click [Yes] to continue.
   
   - Click [No] if you wish to re-enter the design values.
If you selected [Face/Point/Point], [Face/Point/Line], [Face/Line/Line]:

- You can use the [Reverse] button to invert the normal vector of the face that you extracted in Step 4 above. If you select [Reverse], the program will invert the face, recalculate the coordinate system, and then redraw the display accordingly.

6 Click the right mouse button.
The [Question] dialog box will appear.

7 Click the [OK] button.
Coordinate conversion will be performed.

<table>
<thead>
<tr>
<th>Parameters for [Build-Move-To X-Y-Z] Dialog Box</th>
</tr>
</thead>
<tbody>
<tr>
<td>Point/Point/Point</td>
</tr>
<tr>
<td>Face/Point/Point</td>
</tr>
<tr>
<td>Face/Point/Line</td>
</tr>
<tr>
<td>Face/Line/Line</td>
</tr>
</tbody>
</table>

## Extracting a Face

Extract a face from the selected points as explained below.

### Operating Procedure

The following steps must be carried out in Build – Move – To X-Y-Z mode.

1 Select the desired points.

- Select the points using the Select and View menu commands.
- After operation, please cancel the Select or View menu command.

2 Click the right mouse button.
The [Select Face Attribute] dialog box will appear.
3. Select the desired face attribute from the pull-down menu.
When the selected attribute of the face is “XY-Plane”, Z-Axis is made in agreement with the face normal. But the direction of the axis is calculated by the algorithm. If the direction is not suitable, click the [Reverse] button in [Confirmation(for coordinate)] dialog box to reverse the axis direction.

4. Click the [OK] button.
The generated face will be displayed, and the [Confirmation] dialog box will appear.

5. Click the [OK] button.
Proceed to the extraction procedure for the next element (point or line).

### Parameters for [Select Face Attribute] Dialog Box

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>XY-Plane</td>
<td>Generates a XY plane based on the selected points.</td>
</tr>
<tr>
<td>YZ-Plane</td>
<td>Generates a YZ plane based on the selected points.</td>
</tr>
<tr>
<td>ZX-Plane</td>
<td>Generates a ZX plane based on the selected points.</td>
</tr>
</tbody>
</table>

---

## Extracting a Point

Extract a point from the selected points as explained below.

### [Operating Procedure]

The following steps must be carried out in Build – Move – To X-Y-Z mode.

1. Select the desired points.

   - Select the points using the Select and View menu commands.
   - After operation, please cancel the Select or View menu command.

2. Click the right mouse button.
The [Select Point Type] dialog box will appear.

3. Select the desired point type from the pull-down menu.
4 Click the [OK] button.
The [Input XYZ Value] dialog box will appear.

5 Enter the design values for the point.

   \textbf{Memo}
   For certain types of extraction, you will only be able to enter values for two of three axes. For instance, if XY-Plane is selected, the text box for \( z \) value will be inactive since it is not necessary to enter the \( z \)-coordinate value.

6 Click the [OK] button.
The generated point will be displayed, and the [Confirmation] dialog box will appear.

7 Click the [OK] button.
Proceed to the extraction procedure for the next element (point or line).

   \begin{itemize}
   \item When you have completed extraction of all elements: Right-click the mouse to open the Question dialog, and proceed to convert to the new coordinate system.
   \end{itemize}

\begin{table}[h]
\centering
\begin{tabular}{|l|l|}
\hline
\textbf{Parameters for [Select Point Type] Dialog Box} & \\
\hline
Gravity Point & Generates the gravity point based on the selected points. \\
\hline
Center of Circle & Generates the center of circle based on the selected points. \\
\hline
Center of Sphere & Generates the center of sphere based on the selected points. \\
\hline
\end{tabular}
\end{table}

\textbf{Extracting a Line}

Extract a line from the selected points as explained below.

\textbf{[Operating Procedure]}
The following steps must be carried out in Build – Move – To X-Y-Z mode.

1 Select the desired points.

   \textbf{Memo}
   \begin{itemize}
   \item Select the points using the Select and View menu commands.
   \item After operation, please cancel the Select or View menu command.
   \end{itemize}
2 Click the right mouse button. 
The [Select Line Attribute] dialog box will appear.

3 Select the desired line attribute from the pull-down menu.

4 Click the [OK] button. 
The line direction will be displayed, and the [Question] dialog box will appear.

5 If you want to change the direction, click the [No] button. 
The line direction will be changed, and the [Question] dialog box will reappear.

6 Click the [Yes] button. 
The generated line will be displayed, and the [Confirmation] dialog box will appear.

7 Click the [OK] button. 
Proceed to the extraction procedure for the next element (point or line).

- When you have completed extraction of all elements: Right-click the mouse to open the Question dialog, and proceed to convert to the new coordinate system.

<table>
<thead>
<tr>
<th>Parameters for [Select Line Attribute] Dialog Box</th>
</tr>
</thead>
<tbody>
<tr>
<td>X-Axis Generates the X-axis based on the selected points.</td>
</tr>
<tr>
<td>Y-Axis Generates the Y-axis based on the selected points.</td>
</tr>
<tr>
<td>Z-Axis Generates the Z-axis based on the selected points.</td>
</tr>
</tbody>
</table>
**Build – Rotate – Elements**  
**[R]** (Effective while held down)

**Rotating Element(s)**

This command is used to rotate the selected element(s).

- **Left**: Rotates the element(s) using the mouse.
- **Middle ([Shift] + Left)**: Rotates the element(s) along the major axis.
- **Right**: Rotates the element(s) by entering values.

**[Operating Procedure]**

1. **Select the desired element(s).**
2. **From the [Build] menu, select [Rotate] and then click [Elements].**
   The selected element will be ready to be displayed in all windows. It will be displayed if it is not displayed in the active window or the windows for which all the elements are set to be displayed.

3. **Drag while holding down the left button.**
   The element(s) will rotate at their center of gravity.
   - Dragging with the middle (or [Shift] + Left) button will rotate the element(s) along the major axis.
   
   **Memo**
   The element will be displayed in simple form during drag. It will be displayed in detailed form when dragging is canceled.

4. **Press the [ESC] key.**
   Build – Rotate – Elements mode will be canceled.
Rotating the Element(s) by Entering a Value Directly

To rotate the element(s) by specifying the rotating angle, follow the procedure given below.

**Note**
*If Build – Rotate – Elements mode was activated using the shortcut key, the element(s) cannot be moved by this method.*

**[Operating Procedure]**

The following steps must be carried out in Build – Rotate – Elements mode.

1. **Click the right mouse button.**
   The [Build-Rotate-Elements] dialog box will appear.

2. **Select X, Y or Z to be used as the pivot, and enter the desired rotating angle.**

3. **Click the [Apply] button.**
   The selected element(s) will rotate by the specified angle.
   - If you change the angle and click the [Apply] button, the element(s) will rotate again according to the new angle. The new angle will not be added to the previous angle. It is an absolute angle from the original position.

4. **Click the [OK] button.**
   The [Build-Move-Points] dialog box will close, movement of the point(s) will be confirmed, and the Build-Move-Points mode will be canceled.
   - Clicking the [Cancel] button will cancel all the operations that have been performed since the dialog box was opened.
**Build – Merge**

**Merging Elements**

This command is used to merge elements that have been subjected to registration.

**[Operating Procedure]**

1. **Select the elements to be merged.**

2. **Click [Merge] on the [Build] menu.**
   The [Build-Merge] dialog box will appear.
   - The selected element will be ready to be displayed in all windows. It will be displayed if it is not displayed in the active window or the windows for which all the elements are set to be displayed.

3. **Set the merge smoothness using the scale bar.**
   - To merge only the points selected in the elements, check the [With selected points] checkbox.

4. **Click the [OK] button.**
   A dialog box asking you to enter a new element name will appear.

5. **Enter the new element name, and click the [OK] button.**
   The program merges the elements to create a new element. The new element is given the name that you just entered.
   - The elements in effect before merging started will be hidden.
   - The registrated data will be ready to be displayed in all windows, and will be displayed in the active window as well as the windows for which all the elements are set to be displayed.

**Note**
The element name must consist of up to 31 alphanumeric characters.
This command is to create polygon data using the mouse for the holes (i.e. areas where no data is present) located in the area selected in the currently displayed element.

### Operating Procedure

1. Select one desired element.

2. Select the points on the boundary of the hole for which you want to create polygon data.

3. From the [Build] menu, select [Fill Holes] and then click [Manual].
   - The system will search for holes present within the area of the selected points. A bar will be displayed during search to indicate progress. If a hole is found, only the points on its boundary will be selected.
   - If no holes are found, a message dialog box will appear. Clicking the [OK] button will close the dialog box and exit the menu.

4. Among the selected points, click the three nodes of a triangular polygon with the left mouse button, one by one in a counter-clockwise direction (when viewed from the front of the polygon).
   - When the node is clicked, a white rubber band will appear between that node and the mouse pointer.
   - When all the three nodes are clicked, a polygon composed of those three nodes will be formed.
   - Selection of the points which are no longer on the boundary of the hole due to the created polygon will be canceled.

   - To cancel designation of the points or created polygon, click the right mouse button. By clicking the right button repeatedly, it is possible to return to the state in effect before this command was selected.

   - It is not possible to designate nodes if they have not been selected.
   - It is not possible to designate nodes of a triangle facing opposite the adjacent polygons.
   - While a rubber band is displayed, it is not possible to switch the view and designate a point or change the window size.

5. When the hole is filled, click the [ESC] key.
   - Selection state of points will remain and Build – Fill Holes – Manual mode will be canceled.
Build – Fill Holes – Auto

Filling Holes Automatically

This command is to create polygon data automatically for the holes (i.e. areas where no data is present) located in the area selected in the currently displayed element. However, some complicated holes may not be filled.

[Operating Procedure]

1. Select one desired element.

2. Select the points on the boundary of the hole for which you want to create polygon data.

3. From the [Build] menu, select [Fill Holes] and then click [Auto].

   The system will search for holes present within the area of the selected points. A bar will be displayed during search to indicate progress. If a hole is found, only the points on its boundary will be selected.
   - If no holes are found, a message dialog box will appear. Clicking the [OK] button will close the dialog box and exit the menu.

   All the view windows will be hidden, and the temporary window and [Build-Fill Holes-Auto] dialog box will appear.
   - The hole for which you want to create polygon data will be displayed in the temporary window. The points comprising the hole will be highlighted (yellow). The selected holes will be processed one by one, starting with the hole composed of the largest number of points.

   **Memo**
   If the number of remaining holes (Number of holes) is 1, the [OK] button will be displayed instead of the [Next Hole] button.

   **Note**
   It is not possible to close the temporary window.

4. Set the “Flatness” and “Algorithm” parameters, and click the [Apply] button.

   The program merges the elements to create a new element. The new element is given the name that you just entered.

   A progress bar shows the progress while the fill is being carried out. If you click the progress bar’s [Cancel] button, the program suspends fill processing and displays a dialog showing results up to that moment.

   **Memo**
   The program retains the fill data generated up to the time when you clicked the [Cancel] button. If you wish to resume the fill operation, click the [All] button. Filling will then continue from the hole at which the operation was suspended.
• If you mchange the “Flatness” and “Algorithm” parameter settings and click the [Apply] button, the holes will be filled according to the new parameter settings.

• To restore the initial state (i.e. holes are not filled), click the [Hole Reset] button.

• To fill all the holes, click the [All] button.
  • All the holes which have not been filled will be filled according to the parameter settings.
  • After filling the holes, the program closes the dialog and the temporary window, and then displays a dialog indicating the results.

5 **Click the [Next Hole] button.**
The dialog box will close and a new dialog box will appear. The hole to be filled next will be displayed in the window.

6 **Repeat step 4 until all the desired holes are filled.**

• If you click the [Next Hole] button without clicking the [Apply] button, nothing will happen, and the dialog box will close and a new dialog box will appear.

• If you click the [Close] button, the program will close the dialog box, windows, and menu. All hole fills that you have executed will be retained.

7 **Click the [OK] button.**
The dialog box and window will close, and the menu will be exited. All the view windows will be displayed.

<table>
<thead>
<tr>
<th>Parameters for [Build-Fill Holes-Auto] Dialog Box</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of nodes</td>
</tr>
<tr>
<td>Number of holes</td>
</tr>
<tr>
<td>Flatness</td>
</tr>
<tr>
<td>Algorithm</td>
</tr>
<tr>
<td>by curvature</td>
</tr>
<tr>
<td>by connecting nodes</td>
</tr>
<tr>
<td>by curvature and replace facets</td>
</tr>
</tbody>
</table>
**Build – Smooth – Element**

**Smoothing the Selected Element**

This command is used to make the selected element smooth as well as to regularize surface points density.

**[Operating Procedure]**

1. **Select one desired element.**

2. **From the [Build] menu, select [Smooth] and then click [Element].**
   - The [Build-Smooth-Element] dialog box will appear.
   - The selected element will be ready to be displayed in all windows. It will be displayed if it is not displayed in the active window or the windows for which all the elements are set to be displayed.

3. **Set the parameters.**

4. **Click the [Apply] button.**
   - The selected element will be smoothed according to the parameter settings and then displayed.
   - If you change the parameter settings and click the [Apply] button again, the element will be smoothed according to the new parameter settings.

5. **Click the [OK] button.**
   - This will confirm execution of smoothing and close the dialog box.

<table>
<thead>
<tr>
<th>Parameters for [Build-Smooth-Element] Dialog Box</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Weight</td>
<td>Used to set level of regularization of surface points density.</td>
</tr>
<tr>
<td>Repetition</td>
<td>Used to set level of smoothness.</td>
</tr>
</tbody>
</table>
Build – Smooth – Points
Smoothing the Selected Points

This command is used to make the boundary of the points selected in the currently displayed element smooth as well as to regularize surface points density.

[Operating Procedure]

1. Select one desired element.

2. Select the desired points.

3. From the [Build] menu, select [Smooth] and then click [Points].
   
   The [Build-Smooth-Points] dialog box will appear.
   
   • The selected element will be ready to be displayed in all windows. It will be displayed if it is not displayed in the active window or the windows for which all the elements are set to be displayed.

4. Set the parameters.

5. Click the [Apply] button.
   
   The boundary of the selected points will be smoothed according to the parameter settings and then displayed.
   
   • If you change the parameter settings and click the [Apply] button again, the element will be smoothed according to the new parameter settings.

6. Click the [OK] button.
   
   This will confirm execution of smoothing and close the dialog box.

<table>
<thead>
<tr>
<th>Parameters for [Build-Smooth-Points] Dialog Box</th>
</tr>
</thead>
<tbody>
<tr>
<td>Weight</td>
</tr>
<tr>
<td>Repetition</td>
</tr>
</tbody>
</table>
Build – Subsample – Uniformly – Element

Reducing the Number of Points of the Selected Element Uniformly

This command is used to reduce the data of the points of the selected element so that surface points density becomes uniform.

[Operating Procedure]

1 Select one desired element.

2 From the [Build] menu, select [Subsample] – [Uniformly] and then click [Element].
   The [Build-Subsample-Uniformly-Element] dialog box will appear.
   • The selected element will be ready to be displayed in all windows. It will be displayed if it is not displayed in the active window or the windows for which all the elements are set to be displayed.

3 Set the parameters.

4 Click the [Apply] button.
   The data of the points comprising the selected element will be reduced according to the parameter settings so that the surface points density becomes uniform.
   • If you change the parameter settings and click the [Apply] button again, the data comprising the element will be reduced according to the new parameter settings.
   
   Memo
   In some cases, the number of vertices present after data reduction may not match the specified number.

5 Click the [OK] button.
   This will confirm execution of data reduction and close the dialog box.

<table>
<thead>
<tr>
<th>Parameters for [Build-Subsample-Uniformly-Element] Dialog Box</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of points</td>
</tr>
<tr>
<td>Fix boundary</td>
</tr>
</tbody>
</table>
Build – Subsample – Uniformly – Points
Reducing the Selected Points Uniformly

This command is used to reduce the points selected in the currently displayed element so that surface points density becomes uniform.

[Operating Procedure]

1 Select one desired element.

2 Select the desired points.

3 From the [Build] menu, select [Subsample] – [Uniformly] and then click [Points].
   The [Build-Subsample-Uniformly-Points] dialog box will appear.
   • The selected element will be ready to be displayed in all windows. It will be displayed if it is not displayed in the active window or the windows for which all the elements are set to be displayed.

4 Set the parameters.

5 Click the [Apply] button.
   The data of the selected points will be reduced according to the parameter settings so that the surface points density becomes uniform.
   • If you change the parameter settings and click the [Apply] button again, the data comprising the points will be reduced according to the new parameter settings.
   Memo
   In some cases, the number of vertices present after data reduction may not match the specified number.

6 Click the [OK] button.
   This will confirm execution of data reduction and close the dialog box.

<table>
<thead>
<tr>
<th>Parameters for [Build-Subsample-Uniformly-Points] Dialog Box</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Number of points</strong></td>
</tr>
<tr>
<td><strong>Fix boundary</strong></td>
</tr>
</tbody>
</table>
   Memo
   Processing may take time if the element is composed of many points. |
Build – Subsample – Adaptively – Element

Reducing the Number of Points of the Selected Element Adaptively

This command is used to reduce the data of the points of the selected element so that surface points density in simple-shaped areas is lower than that in complicated-shaped areas.

Memo
The elements selected before execution of this command will be divided to triangular polygons.

[Operating Procedure]

1 Select one desired element.

   • The selected element will be ready to be displayed in all windows. It will be displayed if it is not displayed in the active window or the windows for which all the elements are set to be displayed.

3 Set the parameters.

4 Click the [Apply] button.
   The data of the points comprising the selected element will be reduced according to the parameter settings so that surface points density in simple-shaped areas is lower than that in complicated-shaped areas.
   • The polygons comprising the selected element will be triangulated.

   • If you change the parameter settings and click the [Apply] button again, the data comprising the element will be reduced according to the new parameter settings.

   Memo
   In some cases, the number of vertices present after data reduction may not match the specified number.

5 Click the [OK] button.
   This will confirm execution of data reduction and close the dialog box.

<table>
<thead>
<tr>
<th>Parameters for [Build-Subsample-Adaptively-Element] Dialog Box</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Number of points</strong></td>
</tr>
<tr>
<td><strong>Range of errors</strong></td>
</tr>
<tr>
<td><strong>Fix boundary</strong></td>
</tr>
</tbody>
</table>
Build – Subsample – Adaptively – Points

Reducing the Selected Points Adaptively

This command is used to reduce the points selected in the currently displayed element so that surface points density in simple-shaped areas is lower than that in complicated-shaped areas.

Memo
The elements selected before execution of this command will be divided to triangular polygons.

[Operating Procedure]

1. Select one desired element.
2. Select the desired points.
   The [Build-Subsample-Adaptively-Points] dialog box will appear.
   • The selected element will be ready to be displayed in all windows. It will be displayed if it is not displayed in the active window or the windows for which all the elements are set to be displayed.

4. Set the parameters.

5. Click the [Apply] button.
   The data of the selected points will be reduced according to the parameter settings so that surface points density in simple-shaped areas is lower than that in complicated-shaped areas.
   • The polygons comprising the selected element will be triangulated.
   • If you change the parameter settings and click the [Apply] button again, the data comprising the points will be reduced according to the new parameter settings.

Memo
In some cases, the number of vertices present after data reduction may not match the specified number.

6. Click the [OK] button.
   This will confirm execution of data reduction and close the dialog box.

Parameters for [Build-Subsample-Adaptively-Points] Dialog Box

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of points</td>
<td>Reduces the current number of points to the specified number. When the [Apply] button is clicked, the current number of vertices will be displayed. (The default for the &quot;Number of points&quot; parameter is set so that the number of selected points will be reduced by 50%).</td>
</tr>
<tr>
<td>Range of errors</td>
<td>The program reduces data in accordance with the value that you enter. The value serves as a general yardstick for the amount of reduction-induced change in model tolerance. The default setting is “0.2&quot;.</td>
</tr>
<tr>
<td>Fix boundary</td>
<td>Among the selected points, the points present on the boundary of the hole will be excluded from data reduction.</td>
</tr>
</tbody>
</table>
Build – Modify – Element
Rebuilding the Selected Element by Deleting Small Polygons

This command is used to rebuild the selected element by deleting small polygons.

Memo
The element selected before execution of this command will be divided to triangular polygons.

[Operating Procedure]

1 Select the desired element.

2 From the [Build] menu, select [Modify] and then click [Element].
   • The selected element will be ready to be displayed in all windows. It will be displayed if it is not displayed in the active window or the windows for which all the elements are set to be displayed.

3 Set the parameters.

4 Click the [Apply] button.
   Polygons smaller than the specified size will be deleted from the selected element.
   • The polygons comprising the selected element will be triangulated.

   • If you change the parameter settings and click the [Apply] button again, the data comprising the element will be reduced according to the new parameter settings.

5 Click the [OK] button.
   This will confirm execution of data reduction and close the dialog box.

<table>
<thead>
<tr>
<th>Parameters for [Build-Modify-Element] Dialog Box</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum edge length</td>
</tr>
<tr>
<td>Minimum face area</td>
</tr>
<tr>
<td>Fix boundary</td>
</tr>
</tbody>
</table>
Build – Modify – Points

Rebuilding the Selected Points by Deleting Small Polygons

This command is used to rebuild the points selected in the currently displayed element by deleting small polygons.

Memo
The elements selected before execution of this command will be divided to triangular polygons.

[Operating Procedure]

1. Select one desired element.
2. Select the desired points.
3. From the [Build] menu, select [Modify] and then click [Points].
   - The [Build-Modify-Points] dialog box will appear.
   - The selected element will be ready to be displayed in all windows. It will be displayed if it is not displayed in the active window or the windows for which all the elements are set to be displayed.
4. Set the parameters.
5. Click the [Apply] button.
   - Polygons smaller than the specified size will be deleted from the selected points.
   - The polygons comprising the selected element will be triangulated.
   - If you change the parameter settings and click the [Apply] button again, the data comprising the points will be reduced according to the new parameter settings.
6. Click the [OK] button.
   - This will confirm execution of data reduction and close the dialog box.

Parameters for [Build-Modify-Points] Dialog Box

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum edge length</td>
<td>Used to set the minimum edge length of polygons to be deleted.</td>
</tr>
<tr>
<td>Minimum face area</td>
<td>Used to set the minimum face area of polygons to be deleted.</td>
</tr>
<tr>
<td>Fix boundary</td>
<td>Among the points comprising the selected element, the points present on the boundary of the hole will be excluded from data reduction.</td>
</tr>
</tbody>
</table>
Build – Subdivision – Element
Rebuilding the Selected Element by Dividing Large Polygons

This command is used to rebuild the selected element by dividing large polygons.

Memo
The element selected before execution of this command will be divided to triangular polygons.

[Operating Procedure]

1 Select the desired element.

2 From the [Build] menu, select [Subdivision] then click [Element].
   The [Build-Subdivision-Element] dialog box will appear.
   - The selected element will be ready to be displayed in all windows. It will be displayed if it is not displayed in the active window or the windows for which all the elements are set to be displayed.

3 Set the parameters.

4 Click the [Apply] button.
   The data of the points comprising the selected element will be rebuilt according to the parameter settings.
   - The polygons comprising the selected element will be triangulated.

   - If you change the parameter settings and click the [Apply] button again, the data for the selected element will be rebuilt according to the new parameter settings.

5 Click the [OK] button.
   This will confirm execution of data rebuilding and close the dialog box.

<table>
<thead>
<tr>
<th>Parameters for [Build-Subdivision-Element] Dialog Box</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum edge length</td>
</tr>
<tr>
<td>Maximum face area</td>
</tr>
</tbody>
</table>
Build – Subdivision – Points

Rebuilding the Selected Points by Dividing Large Polygons

This command is used to rebuild the points selected in the currently displayed element by dividing large polygons.

Memo
The elements selected before execution of this command will be divided to triangular polygons.

[Operating Procedure]

1. Select one desired element.
2. Select the desired points.
   • The selected element will be ready to be displayed in all windows. It will be displayed if it is not displayed in the active window or the windows for which all the elements are set to be displayed.
4. Set the parameters.
5. Click the [Apply] button.
   The data for the selected points will be rebuilt according to the parameter settings.
   • The polygons comprising the selected element will be triangulated.
   • If you change the parameter settings and click the [Apply] button again, the data for the points will be rebuilt according to the new parameter settings.
6. Click the [OK] button.
   This will confirm execution of data rebuilding and close the dialog box.

<table>
<thead>
<tr>
<th>Parameters for [Build-Subdivision-Points] Dialog Box</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum edge length</td>
</tr>
<tr>
<td>Maximum face area</td>
</tr>
</tbody>
</table>
### Build – Triangulate – Elements

**Dividing Polygons in Elements into Triangles**

This command is used to divide polygons of the selected element(s) into triangles.

**[Operating Procedure]**

1. Select the desired element(s).
2. From the [Build] menu, select [Triangulate] then click [Elements].
   - The polygons comprising the selected element(s) will be divided into triangles.
     - The selected element will be ready to be displayed in all windows. It will be displayed if it is not displayed in the active window or the windows for which all the elements are set to be displayed.

### Build – Triangulate – Polygons

**Dividing Selected Polygons into Triangles**

This command is used to divide the polygon(s) composed of the points selected in the currently displayed element into triangles.

**[Operating Procedure]**

1. Select the desired element(s).
2. Select the polygons you want to divide into triangles.
   - A polygon can be selected by selecting all the vertices of which it is comprised.
   - **Memo**
     - It is possible to select polygons in more than one element.
3. From the [Build] menu, select [Triangulate] and then click [Polygons].
   - Polygons comprised of the selected points will be divided into triangles.
     - The selected element will be ready to be displayed in all windows. It will be displayed if it is not displayed in the active window or the windows for which all the elements are set to be displayed.
Build – Texture Blending

Blending Textures

This command is used to make the edges of color image of registrated element smooth.

[Operating Procedure]

1. Select one desired element.

2. Click [Texture Blending] on the [Build] menu.
   All the view windows will be hidden, and the temporary window and [Build-Texture Blending] dialog box will appear.
   • The temporary window is displayed in texture mapping mode, and the selected element will be fully framed in that window.
   • The selected element will be ready to be displayed in all windows. It will be displayed if it is not displayed in the active window or the windows for which all the elements are set to be displayed.

   • An error message will appear if an element that has no images is selected.
   • It is not possible to close the temporary window.

3. Set the parameters.

4. Click the [Apply] button.
   Junctures of textures will be smoothed according to the parameter settings.
   • If you change the parameter settings and click the [Apply] button again, the junctures of textures will be smoothed according to the new parameter settings.

5. Click the [OK] button.
   This will confirm execution of texture blending and close the dialog box.

<table>
<thead>
<tr>
<th>Parameters for [Build-Texture Blending] Dialog Box</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blending Area</td>
</tr>
</tbody>
</table>
**Build – Check Polygons – Element**

**Checking for Illegal Polygons in Element**

This command is used to check for illegal polygons among those comprising the selected element.

**[Operating Procedure]**

1. **Select one desired element.**

2. **From the [Build] menu, select [Check Polygons] then click [Element].**
   The [Build-Check Polygons-Element] dialog box will appear.
   - The selected element will be ready to be displayed in all windows. It will be displayed if it is not displayed in the active window or the windows for which all the elements are set to be displayed.

   **Note**
   *An error message will appear if more than one element is selected.*

3. **Check the checkboxes of the parameter items to be checked.**

4. **Click the [OK] button.**
   Illegal polygons will be detected and the following dialog box will appear.

5. **Click the [OK] button.**
   Only the vertices comprising the illegal polygons will remain selected, the dialog box will close and the menu will be exited.
### Parameters for [Build-Check Polygons-Element] Dialog Box

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intersection</td>
<td>Checks for polygons intersecting with another polygon at points other than at shared vertices and edges.</td>
</tr>
<tr>
<td></td>
<td>ex.) Polygons intersecting with each other</td>
</tr>
<tr>
<td>Degeneration</td>
<td>Checks for polygons whose edges intersect with each other at points other than at shared vertices.</td>
</tr>
<tr>
<td></td>
<td>ex.) Triangular polygon whose three vertices are positioned on a straight line</td>
</tr>
<tr>
<td>Orientation</td>
<td>Checks for polygons that share an edge and face opposite each other.</td>
</tr>
<tr>
<td></td>
<td>ex.) Polygons sharing one edge and facing opposite each other</td>
</tr>
<tr>
<td>Connection</td>
<td>Checks for polygons that share more than three vertices or two non-edge vertices.</td>
</tr>
<tr>
<td></td>
<td>ex.) Quadrangular polygons sharing three vertices</td>
</tr>
<tr>
<td></td>
<td>ex.) Triangular polygon having as an edge the diagonal edge of a quadrangular polygon</td>
</tr>
<tr>
<td>Singularity</td>
<td>Checks for polygons connected to a vertex of conical polygons.</td>
</tr>
<tr>
<td></td>
<td>*All the polygons connected to a vertex will be detected.</td>
</tr>
<tr>
<td></td>
<td>ex.) Triangular polygon sharing its vertex with a conical polygon</td>
</tr>
</tbody>
</table>
Build – Check Polygons – Polygons
Checking for Illegal Polygons Composed of Selected Points

This command is used to check illegal polygons composed of the selected points in the selected element.

[Operating Procedure]

1 Select one desired element.

2 Select the points that contain polygons to be checked
Only the polygons for which all vertices are selected will be checked.

3 From the [Build] menu, select [Check Polygons] and then click [Polygons].
The [Build-Check Polygons-Polygons] dialog box will appear.
• The selected element will be ready to be displayed in all windows. It will be displayed if it is not displayed in the active window or the windows for which all the elements are set to be displayed.

**Note**
An error message will appear if more than one element is selected.

4 Check the checkboxes of the parameter items to be checked.

5 Click the [OK] button.
Illegal polygons will be detected and the following dialog box will appear.

6 Click the [OK] button.
Only the vertices comprising the illegal polygons will remain selected, the dialog box will close and the menu will be exited.
### Build Menu

#### Parameters for [Build-Check Polygons-Polygons] Dialog Box

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
</table>
| Intersection       | Checks for polygons intersecting with another polygon at points other than at shared vertices and edges.  
  ex.) Polygons intersecting with each other |
| Degeneration       | Checks for polygons whose edges intersect with each other at points other than at shared vertices.  
  ex.) Triangular polygon whose three vertices are positioned on a straight line |
| Orientation        | Checks for polygons that share an edge and face opposite each other.  
  ex.) Polygons sharing one edge and facing opposite each other |
| Connection         | Checks for polygons that share more than three vertices or two non-edge vertices.  
  ex.) Quadrangular polygons sharing three vertices  
  ex.) Triangular polygon having as an edge the diagonal edge of a quadrangular polygon |
| Singularity        | Checks for polygons connected to a vertex of conical polygons.  
  *All the polygons connected to a vertex will be detected.  
  ex.) Triangular polygon sharing its vertex with a conical polygon |
## Info Menu

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Elements</td>
<td>182</td>
</tr>
<tr>
<td>Points</td>
<td>183</td>
</tr>
<tr>
<td>Picked Point</td>
<td>184</td>
</tr>
</tbody>
</table>
Info – Elements
Displaying Information for the Element(s)

This command is used to display information related to the selected element.

[Operating Procedure]

1. Select one desired element.

2. Click [Element] on the [Info] menu.
The [Info-Element] dialog box will appear.

3. If you want to change the element name, enter a new name.

4. Click the [OK] button.
The dialog box will close.

Parameters for [Info-Elements] Dialog Box

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Element name</td>
<td>Name of the element</td>
</tr>
<tr>
<td>Points</td>
<td>Number of points comprising the element</td>
</tr>
<tr>
<td>Polygons</td>
<td>Number of polygons comprising the element</td>
</tr>
<tr>
<td>Surface</td>
<td>Element’s surface area</td>
</tr>
<tr>
<td>Volume</td>
<td>Element’s volume</td>
</tr>
<tr>
<td>Date</td>
<td>Acquisition date (“N/A” will be displayed in the case of merged element data)</td>
</tr>
<tr>
<td>Time</td>
<td>Acquisition time (“N/A” will be displayed in the case of merged element data)</td>
</tr>
<tr>
<td>Image No.</td>
<td>Image No. (for the image whose information is displayed)/Total number of images</td>
</tr>
<tr>
<td>Size</td>
<td>Size of the image</td>
</tr>
<tr>
<td>View point</td>
<td>Coordinates of the view point</td>
</tr>
<tr>
<td>Direction</td>
<td>Vector of the line of view</td>
</tr>
<tr>
<td>Up Vector</td>
<td>Upward vector</td>
</tr>
<tr>
<td>Focal length</td>
<td>Focal distance</td>
</tr>
<tr>
<td>Previous</td>
<td>Displays information for the previous image.</td>
</tr>
<tr>
<td>Next</td>
<td>Displays information for the next image.</td>
</tr>
</tbody>
</table>

Memo
The program calculates the surface area by calculating the triangles comprising the element, and then summing the surface areas of these triangles.
The program calculates the volume by estimating the volume enclosed by the polygons comprising the element.
Results may not be precise if elements have many broken parts.
Info – Points
Displaying Information for Points

This command is used to display information related to the points comprising the polygon selected in the selected element.

[Operating Procedure]

1 Select one desired element.

2 Select the desired point(s).

3 Click [Points] on the [Info] menu. The [Info-Points] dialog box will appear.
   • The selected element will be ready to be displayed in all windows. It will be displayed if it is not displayed in the active window or the windows for which all the elements are set to be displayed.

Note
Information for up to 20,000 points can be viewed. If the number of selected points exceeds 20,000, the information for those extra points will be omitted.

4 If you wish to output the displayed information, click the [Export] button. The program outputs the point coordinate data, in ASCII format.

5 Click the [OK] button. The dialog box will close.

<table>
<thead>
<tr>
<th>Parameters for [Info-Points] Dialog Box</th>
</tr>
</thead>
<tbody>
<tr>
<td>No.</td>
</tr>
<tr>
<td>X, Y, Z</td>
</tr>
<tr>
<td>Element name</td>
</tr>
</tbody>
</table>
Info – Picked Point

Displaying Information for the Picked Point

This command is used to display information related to a point selected by clicking it.

[Operating Procedure]

1. From the element list, select the desired element.

2. Click [Picked Point] on the [Info] menu.
   The selected element will be ready to be displayed in all windows. It will be displayed if it is not displayed in the active window or the windows for which all the elements are set to be displayed.

3. Click the point whose information you want to display.
   The information of the left-clicked point will be displayed.

4. Press the [ESC] key.
   Info – Picked Point mode will be canceled.

Parameters for [Info-Picked Point] Dialog Box

<table>
<thead>
<tr>
<th>No.</th>
<th>Serial No. of each point</th>
</tr>
</thead>
<tbody>
<tr>
<td>X, Y, Z</td>
<td>X, Y and Z coordinates</td>
</tr>
<tr>
<td>Element name</td>
<td>Name of the element to which the point(s) belong</td>
</tr>
</tbody>
</table>
Window Menu

New – Front/Right/Left/Back/Top/Bottom/ .......................................................... 186
Isometric/Perspective ....................................................................................... 186
Clone .................................................................................................................... 186
Close ................................................................................................................... 187
Cascade ............................................................................................................... 187
Tiling ................................................................................................................. 188
Layout – 1/4 ........................................................................................................ 188
Layout – 1/1 ........................................................................................................ 188
Layout – Format A ............................................................................................ 189
Layout – Format B ............................................................................................ 189
Property ............................................................................................................. 190
Next .................................................................................................................... 192
Previous ............................................................................................................. 192
**Window – New – Front/Right/Left/Back/Top/Bottom/Isometric/Perspective**

**Changing Direction of View of Element Window**

This command is used to open a new window by selecting the orientation of the image displayed in the window from “Front”, “Right”, “Left”, “Back”, “Top”, “Bottom”, “Isometric” and “Perspective”.

**[Operating Procedure]**

1. From the [Window] menu, select [New] and then click [Front/Right/Left/Back/Top/Bottom/Isometric/Perspective].
   
   A new window will open in the selected view orientation.
   
   The data will be fully framed in the new window.

   **Memo**
   
   • It is possible to open two or more windows having the same orientation.
   
   • If “Perspective” or “Isometric” is selected, the image can be rotated in different directions using a View command.

**Window – Clone**

**Cloning an Element Window**

This command is used to clone (duplicate) the active element window.

**[Operating Procedure]**

1. Click [Clone] on the [Window] menu.
   
   The active window will be cloned.

---

186
**Window – Close**

**Closing Active Element Window**

This command is used to close the active element window.

**[Operating Procedure]**

1. **Click [Close] on the [Window] menu.**
   The active window will close.

   - If only one view window is present and modifications have been made to an element after it has been imported or saved, the “Some elements are modified. Do you want to save them?” message dialog box will appear.
     - Press [YES].
     - If an element file has been imported, its data will be overwritten.
     - If the selected elements are not those explained above (i.e. if they are newly created elements or those that have been imported in another file format), the [File-Save as-Elements] dialog box will appear, displaying the names of the non-saved elements at the top of the element list. (If you want to change the file names, change them) Click the [Save] button to save them one by one.
     - When all the elements are saved, the dialog box and the selected windows will close.

**Window – Cascade**

**Cascading Element Windows**

This command is used to cascade all the currently displayed windows.

**[Operating Procedure]**

1. **Click [Cascade] on the [Window] menu.**
   The currently displayed windows will be cascaded from the top left to bottom right in the view window area.
**Window – Tiling**

**Tiling Element Windows**

This command is used to tile all the currently displayed windows.

[Operating Procedure]

   The currently displayed windows will be fully tiled in the view window area.

**Window – Layout – 1/4**

**Displaying an Element Windows in 1/4 Layout**

This command is used to display windows in 1/4 layout.

[Operating Procedure]

1. From the [Window] menu, select [Layout] and then click [1/4].
   Four views will appear, with Top view in the top left, Isometric view in the top right, Front view in the bottom left and Right view in the bottom right.

**Window – Layout – 1/1**

**Displaying an Element Window in 1/1 Layout**

This command is used to fully display a window in the view window area.

[Operating Procedure]

1. From the [Window] menu, select [Layout] and then click [1/1].
   The active window will be maximized and displayed fully in the view window area.
Window – Layout – Format A

Displaying an Element Window in Format A Layout

This command is used to display windows in Format A layout.

[Operating Procedure]

1. From the [Window] menu, select [Layout] and then click [Format A].
   All the windows except for the active window will close, and a window having the same display properties of that active window will be created. It will be displayed in Format A from certain different viewing angles.

Window – Layout – Format B

Displaying an Element Window in Format B Layout

This command is used to display windows in “Format B” layout.

[Operating Procedure]

1. From the [Window] menu, select [Layout] and then click [Format B].
   All the windows except for the active window will close, and a window having the same display properties of that active window will be created. It will be displayed in the format shown on the right from certain viewing angles.
Displaying Window Properties

This command is used to display and set various types of information related to all the currently displayed windows.

[Operating Procedure]


2. Set the parameters.
   - Clicking the [View reset] button will change the Camera Settings as follows:
     - Interest: 0.000, 0.000, -1000.000
     - Near plane: 500.000
     - Far plane: 5000.000
     - View angle: 45.0
   - To change the element for only the windows for which parameters have been set, check the [Select] checkbox and place a check mark for those elements.
     “Selective” will appear in the window’s title bar.

   **Note**
   For window views other than “Isometric” or “Perspective” view, it is not possible to set “View angle” and certain “View point” and “Interest” parameters.
   - For “Front” and “Back” views, only “Z” parameter can be set.
   - For “Top” and “Bottom” views, only “Y” parameter can be set.
   - For “Right” and “Left” views, only “X” parameter can be set.
   - For “Isometric” view, all parameters other than “View angle” can be set.
   - For “Perspective” view, all the parameters can be set.

   - For those elements set in the element list to be hidden, it is not possible to set them to be shown by checking the [Select] checkbox.

   - The [Flat] and [Smooth] radio buttons cannot be selected if Wireframe is selected as Rendering mode.

3. Click the [Apply] button.
   The windows will be updated according to the parameter settings
   - If you change the parameter settings and click the [Apply] button again, the windows will be updated according to the new parameter settings.

4. Click the [OK] button.
   This will confirm execution of window property change and close the dialog box.
## Window Menu

### Parameters for [Property Dialog] Dialog Box

<table>
<thead>
<tr>
<th>View mode</th>
<th>Click the pull-down menu, and select the desired view mode from “Front”, “Back”, “Top”, “Bottom”, “Right”, “Left”, “Isometric” and “Perspective” from the list that appears.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rendering mode</td>
<td>Click the pull-down menu, and select the desired rendering mode from “Wireframe”, “Shading”, “Texture Mapping”, “Wireframe + Shading” and “Wireframe + Texture Mapping”.</td>
</tr>
</tbody>
</table>

### Parameters for Camera Settings

<table>
<thead>
<tr>
<th>View point</th>
<th>Camera position</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interest</td>
<td>Position of the point of interest</td>
</tr>
<tr>
<td>Near plane</td>
<td>Position (distance from camera) at which subject becomes visible</td>
</tr>
<tr>
<td>Far plane</td>
<td>Position (distance from camera) at which subject goes out of sight</td>
</tr>
<tr>
<td>View angle</td>
<td>View angle of the camera</td>
</tr>
</tbody>
</table>

### Parameters for Display

<table>
<thead>
<tr>
<th>Select</th>
<th>Used to select the elements to be displayed in windows.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Points</td>
<td>Used to set whether to show or hide vertices.</td>
</tr>
<tr>
<td>Normal</td>
<td>Used to set whether to show or hide normal.</td>
</tr>
<tr>
<td>Shading</td>
<td>Used to select flat shading or smooth shading by the [Flat] and [Smooth] radio buttons.</td>
</tr>
</tbody>
</table>
**Window – Next**

**Displaying Next Element Window**

This command is used to switch the next window to the active window.

**[Operating Procedure]**

   Among the windows listed in the [Window] menu, the window listed below the currently active window will be active.

**Window – Previous**

**Displaying Previous Element Window**

This command is used to switch the previous window to the active window.

**[Operating Procedure]**

1. Click [Previous] on the [Window] menu.
   Among the windows listed in the [Window] menu, the window listed above the currently active window will be active.
Tool Menu

Measure .......................................................... 194
Menu Add .......................................................... 200
Menu Del .......................................................... 201
Shortcut Keys ................................................... 202
**Tool – Measure**

**Measuring Dimensions within the Selected Element(s)**

This command measures specified dimensions within the selected element.

**[Operating Procedure]**

1. **Select the elements, and select the [Measure] from the [Tool] menu.**
   
The [Tool – Measure] dialog box will appear.

2. **Select the type of measurement you want to perform by checking on the radio button.**
   
   *Memo*
   
The measurement results is displayed in the upper-right window. Note that the content of this window can be edited.
   
The measurement procedure is indicated sequentially in the Status window.

3. **Click the [Exit] button.**
   
   Tool – Measure mode will be canceled.

**Parameters for [Tool-Measure] Dialog Box**

<table>
<thead>
<tr>
<th>Points</th>
<th>Measures the distance between multiple points on the element (the distance between two selected points, or the dimensions of the “bounding box” fitted to three or more selected points).</th>
</tr>
</thead>
<tbody>
<tr>
<td>Point to Face</td>
<td>Measures the distance between a specified point and a selected face (where the face is specified by selection of multiple points).</td>
</tr>
<tr>
<td>Angle</td>
<td>Measures the angle formed by three specified points.</td>
</tr>
<tr>
<td>Circle</td>
<td>Measures the circle formed by multiple points (the circle defined by three specified points, or the circle formed by fitting of multiple selected points.)</td>
</tr>
</tbody>
</table>

**Measuring the Distance Between Two Points ([Points])**

Use the following procedure to measure the distance between two specified points on the selected element.

**[Operating Procedure]**

1. **Check on the [Points] of the [Distance] category.**
2 Specify the first point on the element by clicking on it.
The specified point is displayed in an element window.

Memo
If you want to redo the point specifying, click the Right mouse button at anywhere.

3 Specify the second point on the element by clicking on it.
The distance between the two points is measured, and the calculated results will be displayed in the upper-right window of the [Tool – Measure] dialog box, and the two specified points and line connecting them will be displayed in an element window.

---

**Parameters Returned When Measuring Distance Between Two Points ([Points])**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dist.</td>
<td>Length of the straight line connecting the two points. (Yellow line in an element window.)</td>
</tr>
<tr>
<td>dx</td>
<td>Distance along x-axis between the two points. (Red arrow in an element window.)</td>
</tr>
<tr>
<td>dy</td>
<td>Distance along y-axis between the two points. (Green arrow in an element window.)</td>
</tr>
<tr>
<td>dz</td>
<td>Distance along z-axis between the two points. (Blue arrow in an element window.)</td>
</tr>
<tr>
<td>Point 1</td>
<td>Coordinates of the first point. (First white point in an element window.)</td>
</tr>
<tr>
<td>Point 2</td>
<td>Coordinates of the second point. (Second white point in an element window.)</td>
</tr>
</tbody>
</table>

---

**Measuring a Bounding Box ([Points])**

Use the following procedure to measure the dimensions of the bounding box fitted to specified points on the selected element.

Memo
A “bounding box” is the rectangular box formed with the shortest boundary lines bounding the selected points.

**[Operating Procedure]**

1 Check on the [Points] of the [Distance] category.

2 Select the points on the element by using the Select menu.

Memo For details of Select commands, refer to page 114 to 126.
3 **Click the Right mouse button.**

The bounding box that covers the selected points is calculated, and the calculated results will be displayed in the upper-right window of the [Tool – Measure] dialog box, and the bounding box fitted to the specified points will be displayed in an element window.

### Parameters Returned When Measuring a Bounding Box ([Points])

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dist.</td>
<td>Length of the diagonal across the bounding box. (Yellow line in an element window.)</td>
</tr>
<tr>
<td>dx</td>
<td>Length of bounding box in the x direction. (Red arrow in an element window.)</td>
</tr>
<tr>
<td>dy</td>
<td>Length of bounding box in the y direction. (Green arrow in an element window.)</td>
</tr>
<tr>
<td>dz</td>
<td>Length of bounding box in the z direction. (Blue arrow in an element window.)</td>
</tr>
<tr>
<td>Point 1</td>
<td>Coordinate at one end of diagonal crossing the box. (White point in an element window.)</td>
</tr>
<tr>
<td>Point 2</td>
<td>Coordinates at the other end of diagonal crossing the box. (White point in an element window.)</td>
</tr>
</tbody>
</table>

### Measuring the Distance Between a Specified Point and a Specified Face ([Point to Face])

Use the following procedure to measure the distance between a specified point and a specified face on the selected element.

#### Operating Procedure

1. **Check on the [Point to Face].**

2. **Select the points on the element by using the Select menu.**

   - For details of Select commands, refer to page 114 to 126.

3. **Click the Right mouse button.**

   A face is fitted with the selected points, and the fitted face will be displayed in an element window.

   - If you want to redo the face extracting, click the Right mouse button again.
4 Specify a single point on the element by clicking on it.
   The distance between the specified point and the face is calculated, and the calculated results will be displayed in the upper-right window of the [Tool – Measure] dialog box, and the line showing the distance will be displayed in an element window.

Memo
   You can specify a different point by clicking on it.
   If you want to change the specified face, click the Right mouse button at anywhere.

<table>
<thead>
<tr>
<th>Parameters Returned When Measuring Distance Between Specified Point and Specified Face ([Point to Face])</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dist. Distance between point and face. (White line in an element window.)</td>
</tr>
<tr>
<td>Point Coordinates of the circle’s center point. (White point in an element window.)</td>
</tr>
<tr>
<td>Plane normal Value of selected face’s normal vector.</td>
</tr>
<tr>
<td>Point on the plane Coordinates of a point on the selected plane. (Yellow on-face point in an element window.)</td>
</tr>
</tbody>
</table>

Measuring an Angle ([Angle])

Use the following procedure to measure the angle formed by three specified points on the selected element.

[Operating Procedure]

1 Check on the [Angle].

2 Specify the first point on the element by clicking on it.
   The specified point will be displayed in an element window.

   Memo
   If you want to redo the point specifying, click the Right mouse button at anywhere.

3 Specify the second point by clicking on it.

   Memo
   If you want to redo the point specifying, click the Right mouse button at anywhere.

4 Specify the third point by clicking on it.
   The angle defined by the three specified points is calculated, and the calculated results will be displayed in the upper-right window of the [Tool – Measure] dialog box, and two lines - connecting the first point to second point and second point to third point - will be displayed in an element window.

   Memo
   To calculate the next angle, click the Right mouse button on the next point.

<table>
<thead>
<tr>
<th>Parameters Returned When Measuring an Angle ([Angle])</th>
</tr>
</thead>
<tbody>
<tr>
<td>Angle Angle formed by the three points, in degrees. (White lines in an element window.)</td>
</tr>
<tr>
<td>Point 1 Coordinates of the first specified point. (Yellow point in an element window.)</td>
</tr>
<tr>
<td>Point 2 Coordinates of the second specified point. (Yellow point in an element window.)</td>
</tr>
<tr>
<td>Point 3 Coordinates of the third specified point. (Yellow point in an element window.)</td>
</tr>
</tbody>
</table>
Measuring the Circle Passing Through Three Specified Points ([Circle])

Use the following procedure to measure the circle fitted to coincide with three specified points on the selected element.

[Operating Procedure]

1. Check on the [Circle].

2. Specify the first point on the element by clicking on it.
   The specified point will be displayed in an element window.
   
   **Memo**
   To redo the point specifying, click the Right mouse button at anywhere.

3. Specify the second point by clicking on it.
   
   **Memo**
   To redo the point specifying, click the Right mouse button at anywhere.

4. Specify the third point by clicking on it.
   The circle fitted to coincide with the specified three points is calculated, and the calculated results will be displayed in the upper-right window of the [Tool – Measure] dialog box, and the fitted circle will be displayed in an element window.
   
   **Memo**
   To calculate the next circle, click the Right mouse button on the next point.

Measuring a Circle Comprised of Multiple Selected Points ([Circle])

Use the following procedure to measure the circle created by fitting of multiple selected points on the selected element.

[Operating Procedure]

1. Check on the [Circle].
2 Select the points on the element by using the Select menu.

For details of Select commands, refer to page 114 to 126.

3 Click the Right mouse button.
The circle fitted with multiple specified point is calculated, and the calculated results will be displayed in the upper-right window of the [Tool – Measure] dialog box, and the fitted circle will be displayed in an element window.

<table>
<thead>
<tr>
<th>Parameters Returned When Measuring a Circle Comprised of Multiple Selected Points ([Circle])</th>
</tr>
</thead>
<tbody>
<tr>
<td>Center</td>
</tr>
<tr>
<td>Radius</td>
</tr>
<tr>
<td>Circle normal</td>
</tr>
</tbody>
</table>
**Tool – Menu Add**

**Adding a Menu**

**[Operating Procedure]**

1. **Click the [Menu Add] on the [Tool] menu.**
   The program opens a file-load dialog.

2. **Select the appropriate menu-addition file.**
   Operation is guaranteed only for well-formed menu-addition files. Operation may not proceed correctly if you select the wrong type of file.

3. **Click the [Open] button.**
   The program opens a confirmation dialog based on the content of the menu-addition file.

4. **Click the [OK] button.**
   The program executes the menu addition in accordance with the content of the file.
Deleting an Added Menu

[Operating Procedure]

1. Click the [Menu Del] on the [Tool] menu.  
The program opens a menu-deletion dialog.

2. Select the appropriate menu name from the list.  
Operation is guaranteed only for well-formed deletion lists. Operation may not proceed correctly if you select an improper list.

3. Click the [OK] button.  
The program deletes the selected menu.
**Tool – Shortcut Keys**

**Displaying a List of Shortcut Keys**

This command is used to display a list of shortcut keys. By default, shortcut keys have already been assigned to popular commands. By using this command, you can add or modify shortcut keys.

**Memo**

Shortcut keys can also be assigned to commands given in pop-up menus.

**[Operating Procedure]**

1. **Click [Shortcut Keys] on the [Tool] menu.**
   
   The [Tool-Shortcut Keys] dialog box will appear.
   
   - A list of shortcut keys is shown for each menu category. To display a list for a certain category, click the corresponding tab with the left mouse button.

2. **In the [Shortcut Key] text boxes, specify the desired keys or combinations of keys.**
   
   - If you want to modify a shortcut key, overwrite it. To add a new shortcut key, just enter it.
   - Alphabet keys, [Shift] key, [Ctrl] key and their combinations can be assigned. However, to use a function key, it cannot be assigned in combination.
   - For instance, if you press the [Ctrl], [Shift] and [a] keys at the same time, “Ctrl + Shift + a” will be displayed in the text box.
   - To restore the following default shortcut key assignment, click the [Default] button.

   - **[File] – [New]**: [Ctrl] + [N]
   - **[File] – [Open]**: [Ctrl] + [O]
   - **[File] – [Save] – [Elements]**: [Ctrl] + [S]
   - **[File] – [Exit]**: [Ctrl] + [Q]
   - **[View] – [Orbit]**: [O]
   - **[View] – [Zoom]**: [Z]
   - **[View] – [Full Frame All]**: [Shift] + [F]
   - **[View] – [Full Frame]**: [F]
   - **[View] – [Area Orbit]**: [W]
   - **[View] – [Area Zoom]**: [X]
   - **[View] – [Move Plane]**: [A]
   - **[Select] – [Rectangle]**: [E]
   - **[Select] – [Select by Elements]**: [Ctrl] + [A]
   - **[Edit] – [Undo]**: [Ctrl] + [Z]
   - **[Edit] – [Redo]**: [Ctrl] + [Y]
   - **[Edit] – [Delete] – [Points]**: [Ctrl] + [X]
• [Popup 1] – [Show Vertex/Hide Vertex] \[F9\]

Note
For commands to which no shortcut key is assigned, “None” will be displayed in their text boxes.
When assigning a shortcut key, an error message will appear if it has already been assigned.
Some commands do not support shortcuts that use \[shift\] + \[Ctrl\]. Attempting to set such a shortcut combination for these commands will produce an error message.

3 Click the [OK] button.
The dialog box will close, and changes made to shortcut key assignment will be effective.
The changes will be saved in the user preference file.

Note
To use a shortcut key, make sure that the mouse cursor is located in a window in the view area.
Pop-up Menus in View Window

Clicking the right mouse button on a view window while holding down the [Ctrl] key will display a pop-up menu, allowing you to make various settings.

View Mode – Front/Right/Left/Back/Top/Bottom/
Isometric/Perspective ..............................................................205
Rendering Mode – Wireframe/Shading/Texture Mapping/
Wireframe + Shading/Wireframe + Texture Mapping .................205
Show Vertex/Hide Vertex ..........................................................206
Show Normal/Hide Normal ......................................................206
Show Axis/Hide Axis ...............................................................207
Smooth Shading/Flat Shading ..................................................207
Select element from window ..................................................208
Create clone window .............................................................209
Close window .........................................................................209
Property ...............................................................................210
View Mode – Front/Right/Left/Back/Top/Bottom/Isometric/Perspective

Changing View Mode

This command is used to change view mode for windows.

[Operating Procedure]

1 Select [View Mode] from a pop-up menu, and click “Front”, “Right”, “Left”, “Back”, “Top”, “Bottom”, “Isometric” or “Perspective”.

   The view mode will be changed.

Rendering Mode – Wireframe/Shading/Texture Mapping/Wireframe + Shading/Wireframe + Texture Mapping

Changing Rendering Mode

This command is used to change rendering mode for windows.

[Operating Procedure]

1 Select [Rendering Mode] from a pop-up menu, and click “Wireframe”, “Shading”, “Texture Mapping”, “Wireframe + Shading” or “Wireframe + Texture Mapping”.

   The rendering mode will be changed.

   • If “Shading” mode is selected, rear-facing surfaces will be displayed in Wireframe mode.
**Show Vertex/Hide Vertex**  

This command is used to set whether to show or hide vertices.

[Operating Procedure] **When Vertices are Currently Hidden**

1. From the pop-up menu, click [Show Vertex].  
The vertices will be shown.

[Operating Procedure] **When Vertices are Currently Showed**

1. From the pop-up menu, click [Hide Vertex].  
The vertices will be hidden.

**Show Normal/Hide Normal**  

This command is used to set whether to show or hide the normal.

[Operating Procedure] **When the Normal is Currently Hidden**

1. From the pop-up menu, click [Show Normal].  
The normal will be shown.

[Operating Procedure] **When the Normal is Currently Shown**

1. From the pop-up menu, click [Hide Normal].  
The normal will be hidden.
**Show Axis/Hide Axis**

**Showing or Hiding Axes**

This command is used to set whether to show or hide axes.

**[Operating Procedure]** When Axes are Currently Hidden

1. From the pop-up menu, click [Show Axis].
   The axes will be shown.

**[Operating Procedure]** When Axes are Currently Shown

1. From the pop-up menu, click [Hide Axis].
   The axes will be hidden.

**Smooth Shading/Flat Shading**

**Changing Shading Mode**

This command is used to change shading mode.

**[Operating Procedure]** When Window is Currently in Flat Shading Mode

1. From the pop-up menu, click [Smooth Shading].
   The window will be displayed in smooth shading mode.

**[Operating Procedure]** When Window is Currently in Smooth Shading Mode

1. From the pop-up menu, click [Flat Shading].
   The window will be displayed in flat shading mode.
Select element from window
Changing Displayed Element by Windows

This command is used to switch the currently selected element to another. This is possible only for the window in which a pop-up menu is displayed.

**Note**
For those elements set in the element list to be hidden, it is not possible to set them to be shown by checking the [Select] checkbox.

**[Operating Procedure]**

1. **From the pop-up menu, click [Select element from window].**
   The [Element to be shown] dialog will appear.
   - If all the elements are set to be shown (i.e. not set to “Selective”), the dialog box will appear with the [Select] checkbox unchecked.
   - Otherwise, the dialog box will appear with the [Select] checkbox checked.

2. **Check the [Select] checkbox (i.e. a check mark is placed).**
   This allows you to set whether to show or hide elements.

3. **Check the checkbox of the desired elements to be shown.**

4. **Click the [OK] button.**
   The dialog box will close and the selected elements will be displayed. “Selective” will appear in the window’s title bar.
Create clone window
Cloning an Element Window

This command is used to clone (duplicate) the active element window.

[Operating Procedure]

1. From the pop-up menu, click [Create clone window].
The active window will be cloned.

Close window
Closing an Element Window

This command is used to close the currently selected element window.

[Operating Procedure]

1. From the pop-up menu, click [Close window].
The currently selected element window will close.

   • If only one view window is present and modifications have been made to an element after it has been imported or saved, the “Some elements are modified. Do you want to save them?” message dialog box will appear.

     Press [YES].

     If an element file has been imported, its data will be overwritten.

     If they are newly created elements or those that have been imported in another file format, the [File-Save as-Elements] dialog box will appear, displaying the names of the non-saved elements at the top of the element list. (If you want to change the file names, change them.) Click the [Save] button to save them one by one.

     When all the elements are saved, the dialog box and the selected windows will close.
Property
Displaying Window Properties

This command is used to display and set various types of information related to all the currently displayed windows.

Memo
This command has the same functions as the Window – Property command.

Ref For details of the Window – Property command, refer to page 190.

[Operating Procedure]

1 From the pop-up menu, click [Property].
   The [Property Dialog] dialog box will appear.

2 Set the parameters.

3 Click the [Apply] button.
   • If you change the parameter settings and click the [Apply] button again, the windows will be updated according to the new parameter settings.

4 Click the [OK] button.
   This will confirm execution of window property change and close the dialog box.
Pop-up Menus in Element List

Clicking the right mouse button on the element list while holding down the [Ctrl] key will display a pop-up menu, allowing you to make various settings.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Element/Unshow Element</td>
<td>212</td>
</tr>
<tr>
<td>Delete Elements</td>
<td>213</td>
</tr>
<tr>
<td>View Image</td>
<td>213</td>
</tr>
<tr>
<td>Set Wireframe Color</td>
<td>214</td>
</tr>
<tr>
<td>Set Shading Color</td>
<td>215</td>
</tr>
<tr>
<td>Rename Element</td>
<td>216</td>
</tr>
</tbody>
</table>
Show Element/Unshow Element

Showing/Hiding Elements

This command is used to show or hide the element(s) selected in the element list.

**Memo**
This command has the same effect as when a check mark is placed for the desired elements in the element list.

**Note**
For a description of selecting elements, refer to page 17, in the Basic Operation Guide.

**Note**
If a pop-up menu is displayed in areas other than element name area in the element list, the menu items [Show Element] and [Unshow Element] will not be displayed.

**Operating Procedure**  When Elements are Currently Hidden

1. Click the element(s) to be shown with the right mouse button, and select [Show Element] from the pop-up menu that appears.
   The element(s) will be shown.

**Operating Procedure**  When Elements are Currently Shown

1. Click the desired element(s) to be hidden with the right mouse button, and select [Unshow Element] from the pop-up menu that appears.
   The element(s) will be hidden.
Delete Elements
Deleting Elements from the Element List

This command is used to delete the element(s) selected from the element list.

Memo
The Delete Elements command has the same function as the File – Remove Elements and Edit – Delete – Elements command.

Ref
• For details of the File – Remove Elements command, refer to page 95.
• For details of the Edit – Delete – Elements command, refer to page 129.

[Operating Procedure]

1 Click the element(s) to be deleted with the right mouse button, and select [Delete Elements] from the pop-up menu that appears.
   A message asking you whether to delete all the selected elements will appear.
   Memo
   If two or more elements have been selected by clicking them while holding down the [Shift] or [Ctrl] key, they can be deleted.

2 Click the [OK] button.
   All the selected elements and their corresponding points will be removed.

View Image
Displaying Color Images

This command is used to display color images of the element(s) currently selected in the element list.

[Operating Procedure]

1 Click the desired element(s) whose color images are to be shown with the right mouse button, and select [View Image] from the pop-up menu that appears.
   The color images of the selected element(s) will be displayed.
   Memo
   If two or more elements have been selected by clicking them while holding down the [Shift] or [Ctrl] key, the color images for those elements can be displayed.
Set Wireframe Color

Changing Wireframe Color

This command is used to set the wireframe color for the element(s) selected in the element list.

**Note**
If a pop-up menu is displayed without elements selected in the element list, [Set Wireframe Color] will not be displayed in the menu.

**[Operating Procedure]**

1. **Click the element(s) for which you want to set wireframe color with the right mouse button, and select [Set Wireframe Color] from the pop-up menu that appears.**
   A color palette dialog box will appear.
   
   **Memo**
   If two or more elements have been selected by clicking them while holding down the [Shift] or [Ctrl] key, the wireframe color for those elements can be set.

2. **Select the desired color from the color palette.**

3. **Click the [OK] button.**
   The wireframe color(s) for the selected element(s) will be changed to the one selected at step 2.
Set Shading Color
Changing Shading Color

This command is used to set the shading color for the element(s) selected in the element list.

**Note**
If a pop-up menu is displayed without elements selected in the element list, [Set Shading Color] will not be displayed in the menu.

**[Operating Procedure]**

1. Click the element(s) for which you want to set shading color with the right mouse button, and select [Set Shading Color] from the pop-up menu that appears. A color palette dialog box will appear.

   **Memo**
   If two or more elements have been selected by clicking them while holding down the [Shift] or [Ctrl] key, the shading color for those elements can be set.

2. Select the desired color from the color palette.

3. Click the [OK] button.
   The shading color(s) for the selected element(s) will be changed to the one selected at step 2.
**Rename Element**

**Changing an Element Name**

This command is used to rename the element(s) currently selected in the element list.

**Memo**

It is also possible to rename an element by double-clicking it in the element list with the right mouse button.

**Note**

If a pop-up menu is displayed without elements selected in the element list, [Rename Element] will not be displayed in the menu.

**[Operating Procedure]**

1. Click the element(s) to be renamed with the right mouse button, and select [Rename Element] from the pop-up menu that appears.

   **Memo**
   
   The element name must consist of up to 31 alphanumeric characters.

   **Memo**
   
   If two or more elements have been selected by clicking them while holding down the [Shift] or [Ctrl] key, they can be renamed.

2. Enter the desired element name, and press the [ENTER] key.

   The element will be renamed.
Pop-up Menus in Image Window

Clicking the right mouse button on an image window while holding down the [Ctrl] key will display a pop-up menu, allowing you to make various settings.

Change Image .................................................................218
Overlay ........................................................................218
Zoom In ........................................................................218
Zoom Out ....................................................................219
Actual Pixels .................................................................219
Close ...........................................................................219
**Change Image**

**Changing the Color Image**

This command is used to change the currently displayed color image with a new one.

**[Operating Procedure]**

1. From the pop-up menu, click [Change Image].
   A sub menu will appear.

2. Select the desired color image.
   The currently displayed color image will be replaced with the selected one.

**Overlay**

**Displaying Wireframe on a Color Image**

This command is used to overlay wireframe on the currently displayed color image.

**[Operating Procedure]**

1. From the pop-up menu, click [Overlay].
   Wireframe will be overlaid on the element image.

   **Note**
   However, if the currently displayed color image is the one that has been added to the data taken by the VIVID (VI) series digitizer, no wireframe will be displayed.

**Zoom In**

**Enlarging the Color Image**

This command is used to enlarge the currently displayed color image.

**[Operating Procedure]**

1. From the pop-up menu, click [Zoom In].
   The color image will be enlarged in steps by the following magnification ratio each time this command is selected.
   1/12, 1/8, 1/6, 1/4, 1/3, 1/2, 2/3, 1, 2, 3, 4, 5, 6, 7 and 8
   • If the image is enlarged beyond the image window, a scroll bar will appear.
**Zoom Out**

**Reducing the Color Image**

This command is used to reduce the currently displayed color image.

**Operating Procedure**

1. From the pop-up menu, click [Zoom Out].
   
   The color image will be reduced in steps by the following magnification ratio each time this command is selected.
   
   1/12, 1/8, 1/6, 1/4, 1/3, 1/2, 2/3, 1, 2, 3, 4, 5, 6, 7 and 8

---

**Actual Pixels**

**Displaying the Color Image in One-to-One Pixel Mode**

This command is used to display color images in one-to-one pixel mode (one data pixel = one monitor pixel).

**Operating Procedure**

1. From the pop-up menu, click [Actual Pixels].
   
   The color images will be displayed in one-to-one pixel mode.

---

**Close**

**Closing the Color Image**

This command is used to close the currently displayed color image.

**Operating Procedure**

1. From the pop-up menu, click [Close].
   
   The color image will close.
Pop-up Menus in Image Window
## Error Messages

The following error messages appear if incorrect operation is performed or an abnormality occurs. If an error message appears, take the appropriate corrective actions as shown in the table below.

<table>
<thead>
<tr>
<th>Error Message (Alphabetically)</th>
<th>Cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>AF error. Laser barrier may be closed</td>
<td>The digitizer was not ready due to an AF error.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>AF error.</td>
<td>The digitizer was not ready due to an AF error.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>Calculation disable.</td>
<td>Failed to calculate using the specified corresponding points.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>Cannot display wireframe.</td>
<td>The command was selected even though the currently displayed color image was the one added to the data taken by the digitizer.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>Cannot show information of more than 20000 points. (Number of selected points − 20000) Points will be omitted.</td>
<td>More than 20000 points were selected.</td>
<td>Click the [OK] button to display the [Info-Points] dialog box. Information for the extra points (i.e. the points exceeding − 20000) will not be included.</td>
</tr>
<tr>
<td>Choose more than 2 points.</td>
<td>An attempt was made to extract a line without selecting two or more points.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>Choose more than 3 points.</td>
<td>An attempt was made to extract a face or circle without selecting three or more points.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>Choose more than 4 points.</td>
<td>An attempt was made to extract a sphere without selecting four or more points.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>Create Meshes Fault!</td>
<td>Failed to fill holes. (This message appears if creation of meshes fails with &quot;Fillholes by meshes&quot; or &quot;Replace meshed&quot; selected.)</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>Design value is same as that of others.</td>
<td>The design values of the extracted point are the same as those of the extracted line.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>Extracted line’s vector overlaps</td>
<td>The extracted line’s vector is the same as the other line’s vector.</td>
<td>Click the [OK] button to close message dialog box.</td>
</tr>
<tr>
<td>Extracted point overlaps</td>
<td>The extracted coordinate (X, Y, Z) is the same as the other’s coordinate.</td>
<td>Click the [OK] button to close message dialog box.</td>
</tr>
<tr>
<td>Extraction failure. Please select again.</td>
<td>Fail extraction of Point, Line or Face.</td>
<td>Click the [OK] button to close message dialog box.</td>
</tr>
<tr>
<td>File write error.</td>
<td>A write error occurred, for instance, due to an excessively long file path name.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>File write error: user preferences.</td>
<td>A write error occurred.</td>
<td>Click the [OK] button to close the message dialog box. No preference file will be created even if the [OK] button is clicked. (The settings will be lost if this software is exited.)</td>
</tr>
<tr>
<td>Error Message (Alphabetically)</td>
<td>Cause</td>
<td>Action</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-------</td>
<td>--------</td>
</tr>
<tr>
<td>File write permission error.</td>
<td>An attempt was made to save a file in a directory for which no file write permission was given.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>File write permission error: user preferences.</td>
<td>No write permission was given for the preference file or directory.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>FillHoles Disable.</td>
<td>Failed to fill holes. (Failed to divide holes.)</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>FillHoles Fault! Please select other Algorithm.</td>
<td>Failed to fill holes. (This message appears when replacement fails even if &quot;Replace meshes&quot; is selected.)</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>Identical name entered. Please enter another name.</td>
<td>The [Rename] button was clicked even though the same file name as the original file name had been entered.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>Illegal format file.</td>
<td>An attempt was made to open a file which cannot be read.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>Invalid directory.</td>
<td>An attempt was made to enter a directory name which did not exist.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>Invalid format. (VIVID 700, VI-700)</td>
<td>The memory card was not formatted.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>Memory allocation error.</td>
<td>Failed to reserve sufficient memory to execute a command.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>No holes were found.</td>
<td>No holes were found as a result of a search.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>No more redo. (An alarm will be heard if the shortcut key is used.)</td>
<td>An attempt was made to perform redo more than the specified times.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>No more undo. (An alarm will be heard if the shortcut key is used.)</td>
<td>An attempt was made to perform undo more than the specified times.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>No name entered. Please enter again. (&quot;Element name&quot;)</td>
<td>The [OK] button was clicked even though no element name had been entered.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>No name entered. Please enter again.</td>
<td>The [OK], [Load] or [Rename] button was clicked even though no element name had been entered.</td>
<td>Enter the desired file name, and click the button.</td>
</tr>
<tr>
<td>No memory card. Please insert a card. (VIVID 700, VI-700)</td>
<td>No memory card has been inserted.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>No step angle entered. Please enter again.</td>
<td>The [Scan] button was clicked without entering a rotating angle even though “Other” was selected for “Rotation step”.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>PC Card had reset since last update.</td>
<td>Power was turned Off then turned On or the memory card was replaced.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
</tbody>
</table>

*No preference file will be created even if the [OK] button is clicked. (The settings will be lost if this software is exited.)*

*(The settings will be lost if this software is exited.)*
## Error Messages

<table>
<thead>
<tr>
<th>Error Message (Alphabetically)</th>
<th>Cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>PC Card had updated since last update.</td>
<td>A file(s) was added, deleted or renamed on the digitizer while the [Remote-PC Card] dialog box was open, but the memory card was not updated.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>Please capture chart data again.</td>
<td>Not possible to make calculation for the rotary shaft using the chart’s image even though the [Convert] button was clicked.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>Please capture chart data.</td>
<td>The [Convert] button was clicked even though no image of the chart had been acquired.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>Please capture data.</td>
<td>The [Convert] button was clicked even though no data had been acquired.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>Please capture more than one data.</td>
<td>The [Convert] button was clicked even though two or more shots had not been acquired.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>Please draw line.</td>
<td>The middle mouse button was clicked even though no control points had been set.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>Please match equal to or more than 6 points.</td>
<td>The [OK] or [Preview] button was clicked even though more than six pairs of corresponding points had not been designated.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>Please read element first.</td>
<td>An attempt was made to execute the Build – Move – To X-Y-Z command without first importing an element.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>Please select 2 polygon mesh elements. (An alarm will be heard if the shortcut key is used.)</td>
<td>The command was selected without selecting two polygon mesh elements.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>Please select a file.</td>
<td>The [Rename], [Load], [Copy] or [Delete] button was clicked even though no files had been selected.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>Please select a polygon mesh element. (An alarm will be heard if the shortcut key is used.)</td>
<td>The command was selected even though no elements had been selected or elements other than polygon mesh elements had been selected.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>Please select a sample point on the image.</td>
<td>The [Apply] button was clicked without selecting sample points.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>Please select a single polygon mesh element. (An alarm will be heard if the shortcut key is used.)</td>
<td>The command was selected even though more than one polygon mesh elements had been selected or a polygon mesh element and an element other than polygon mesh type had been selected.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>Please select a single scene file.</td>
<td>The [Open] button was clicked even though more than one scene files had been selected.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>Please select element(s). (An alarm will be heard if the shortcut key is used.)</td>
<td>The command was selected even though no elements had been selected.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>Please select multiple polygon mesh elements. (An alarm will be heard if the shortcut key is used.)</td>
<td>The command was selected even though more than one polygon mesh element had not been selected.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>Please select only polygon mesh element(s). (An alarm will be heard if the shortcut key is used.)</td>
<td>An element(s) other than polygon mesh type element was also selected.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>Error Message (Alphabetically)</td>
<td>Cause</td>
<td>Action</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-------</td>
<td>--------</td>
</tr>
<tr>
<td>Please select only same format files.</td>
<td>The [Open] or [Import] button was clicked even though more than one file of different format had been selected.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>Please select point(s). (An alarm will be heard if the shortcut key is used.)</td>
<td>The command was selected with no points selected.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>Please select points within each selected element. (An alarm will be heard if the shortcut key is used.)</td>
<td>The command was selected even though no points had been selected or points had been selected for only some selected element but not all.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>Please select polygon mesh element(s). (An alarm will be heard if the shortcut key is used.)</td>
<td>The command was selected even though no elements had been selected or elements other than polygon mesh elements had been selected.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>Please select polygon(s). (An alarm will be heard if the shortcut key is used.)</td>
<td>The command was selected even though no polygons had been selected.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>Please select three or more points. (An alarm will be heard if the shortcut key is used.)</td>
<td>The command was selected even though three or more points had not been selected.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>Same element name exists. Please enter another name. (“File name”)</td>
<td>The same element name already exists.</td>
<td>Enter a new element name, and click the [OK] button to open the file.</td>
</tr>
<tr>
<td>Same element name exists. Replace?</td>
<td>An attempt was made to enter an element name that already exists.</td>
<td>To replace the existing element, click the [Replace] button.</td>
</tr>
<tr>
<td>Same file name exists.</td>
<td>An attempt was made to enter a file name that already exists.</td>
<td>To overwrite the file, click the [Overwrite] button.</td>
</tr>
<tr>
<td>SCSI read error.</td>
<td>An error occurred with SCSI connection. A read error from the memory card occurred in VIVID 900/910 (VI-900/910).</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>Select more points. We need more than 500 selected points for registration.</td>
<td>Among selected elements, at least one element that does not have a certain number of selected points exists.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>Selected file “****” may be broken. Continue?</td>
<td>An attempt was made to read a file that had not been saved properly.</td>
<td>To continue to read the file, click the [Continue] button. *If the [Continue] button is clicked, an abnormal stop of the software may occur during reading.</td>
</tr>
<tr>
<td>Something wrong with VIVID.</td>
<td>A SCSI error other than SCSI connection error, SCSI command end error and ready error due to an AF error occurred.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>The element has no image/The elements have no image. (An alarm will be heard if the shortcut key is used.)</td>
<td>The command was selected even though only the polygon mesh elements that were defined without copying images or elements other than polygon mesh elements were selected.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>The element has no image. (An alarm will be heard if the shortcut key is used.)</td>
<td>The selected element did not have any images when the command was selected.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>Error Message (Alphabetically)</td>
<td>Cause</td>
<td>Action</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-------</td>
<td>--------</td>
</tr>
<tr>
<td>The size of this image is different from the size of selected image.</td>
<td>The size of the selected image was different from that of the image you tried to load, due to replacement of textures.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>There are no points. The element will be removed. (&quot;File name&quot;)</td>
<td>No data points were contained.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>This element does not have multiple images.</td>
<td>You attempted to execute the command on an element that has only a single image.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>This Shortcut key about [Command Name] is an invalid combination. It will be reset!</td>
<td>The shortcut key combination you attempted to set is not supported by this command.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>This Shortcut key about [Command Name] is exist! Please set another!</td>
<td>The same shortcut key had already been assigned when you tried to assign it.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>This version of scene file is not supported.</td>
<td>The [Open] button was clicked even though a scene file saved by the Utility Software VI-S1 had been selected.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>Too Small Mesh. We can’t get enough information for registration.</td>
<td>Among selected elements, at least one element that is composed of less than a certain number of constituent points exists.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>Turntable not found.</td>
<td>The rotary stage is not connected to the digitizer or it is not turned ON.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>Unknown PC Card (VIVID 700, VI-700)</td>
<td>The type of memory card is incorrect.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>Value must be 0 &lt; value &lt; 10000.</td>
<td>A value outside the allowable range was entered.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>Value must be –100000 &lt; value &lt; 100000.</td>
<td>A value outside the allowable range was entered and the OK button was clicked.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>VIVID busy.</td>
<td>The SCSI command did not complete.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>VIVID not found.</td>
<td>VIVID (VI) series digitizer is not turned ON, cables are disconnected, or the SCSI device driver setting is not correct.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
<tr>
<td>“Element name” Zero or few polygons found. Skip making LOD.</td>
<td>The selected element has an excessively small number of polygons.</td>
<td>Click the [OK] button to close the message dialog box.</td>
</tr>
</tbody>
</table>
Explanation of Technical Terms

Coordinate System

With this utility software, points located in a three-dimensional space are expressed using coordinate values of three-dimensional right-handed Cartesian coordinates. The center of the light-receiving lens of the digitizer is set as the origin of the coordinates. +Z direction refers to the direction facing the front side along the optical axis, +Y direction refers to the upward direction and +X direction refers to the direction facing the right, when viewed from the back of the light-receiving section.

Window View

This program lets you view elements using three types of views: orthogonal views (Top, Front, Back, Bottom, Left, Right), perspective views, and isometric views.

Vertex

Vertices refer to points in a three-dimensional space. They possess three-dimensional coordinate values, and can be selected or unselected. They can also be edited (i.e. moved and deleted). To edit vertices, they must be selected using the [Select] menu. (For the [Select] menu, refer to page 114.) In addition, vertices can be shown or hidden by using the Window – Property command. (For details of the Window – Property command, refer to page 190.)

Polygon

Polygons refer to areas (surfaces) enclosed by lines (edges) connecting vertices. Only triangular and rectangular polygons are available with this software, and they can be positioned facing toward the front or rear side.
Explanation of Technical Terms

Color Image

When an image is acquired by the VIVID (VI) series digitizer, a range image containing distance data to each point on the surface of the object is acquired as well as a color image taken from the same view angle as the range image. With this software, color images possess information used to correspond picture elements to vertices based on color information. If images are acquired using the Remote command, color images will also be saved automatically. (When saving data on the VIVID 900/910 (VI-900/910), it is possible to select whether or not to save color images.)

Element

Elements refer to data consisting of points (vertices), polygons and color images *1. When data acquired by the VIVID (VI) series digitizer is loaded to this software, it will always be displayed as a polygon mesh element. In addition, use of the Edit – Define command allows you to define a part of an existing element as a new element.

Names of elements loaded to this software and those that are newly defined are displayed in the element list located at the right edge of the screen.

For a description of setting whether elements are to be shown or hidden and selected or unselected, refer to page 17, in the Basic Operation Guide.

*1 Some polygon mesh elements do not have color images. For instance, a polygon mesh element created by the Edit – Define command without “Copy image(s)” selected does not have color images.

Scene

A scene refers to information such as currently opened element, its view information (zoom setting, viewing direction, Shades/Lines display mode), camera *2, point of interest *3 and light *4. When a scene is saved using the File – Save – Scene command, all this information will be saved.

*2 The camera indicates direction in which the image displayed in a “Isometric” or “Perspective” element window is viewed. (The image displayed in “Isometric” or “Perspective” element window is the image of the object viewed from the camera position.) The camera position can be moved using the View – Camera – Settings or View – Orbit command.

*3 The point of interest shows the direction in which the camera views the image. By moving the point of interest using the View – Camera – Settings command, the viewing direction of the camera can be changed.

*4 The light provides shadow for “Shades” element windows, and two kinds of light are available: point light source and environmental light. With the default settings, the point light source is located behind and to the right of the camera. Position of the point light can be moved by the View – Move Light command. In the SHADING display mode, the intensity of the environmental light, color of the light and material of elements (highlight, object’s color) are determined automatically.

Camera Data File

A camera data file contains data (i.e. the data before conversion to element data) acquired by the digitizer. It is possible to set the resolution for the range image, fill holes (i.e., areas where no data exists) with points automatically and merge more than one data acquired at different angles using the optional turntable.

Element File

An element file contains data for a single element.

Scene File

A scene file contains data for a scene.
Dynamic Range Expansion Function

This function expands the measurement range when the VIVID 910 (VI-910) performs scanning. The laser beam of three different intensity levels (high, middle, low) is emitted to the object, and the rays reflected from the object are captured by the CCD. Among the reflected rays, the data within the CCD’s measurement range are used to expand the entire measurement range.
Explanation of Technical Terms